VIEW SCAN WINDOW

INTRODUCTION

This chapter describes:

¢ 2D Screen Function on page 6-1

¢ 2D Screen Function on page 6-1

¢ 3D Screen Function on page 6-10

¢ Show Measurement Site During Sequence Run on page 6-21

¢ Aborting A Scan on page 6-23

2D SCREEN FUNCTION

The View Scan Window appears while a scan is being run. It allows the user to observe
the progress of the scan and to adjust scan parameters in the various screens for
optimum scan results. The scan can be started once the recipe has been chosen and the
sample loaded onto the sample stage. The scan can be started from several places. The
most common two starting points are:

¢ With the required recipe chosen, click on START in the Scan Recipe screen.

¢ From the Scan Recipe screen, click on the XY icon. From the XY screen click on
START.

Click START to begin the scan. The View Scan screen appears. (See Figure 6.1.)

The head lowers bringing the stylus into contact with the sample at the
start-of-scan position. The scan begins, first briefly traveling opposite the scan
direction, then reversing. This allows the mechanical instruments to settle down
and the stage to reach the programmed scan speed before data collection begins.
The View Scan window appears and the scan begins. The video image freezes
during the scan and the Real Time Scan view in the lower right corner displays
the data in real time as it is collected. (See Figure 6.1). When the scan is
finished, the data is automatically displayed in the Analysis window.
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The sample surface and
scan progress is displayed
from the side-view in the
Video Display.

Scan information is

displayed in this area. T

Scan information in the
Sequence View Scan
Window

Figure 6.1 2D Single Scan View Scan Window
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Two columns of information are presented in the lower left quadrant of the 2D scan
screen (Figure 6.1) and three columns in the 2D sequence screen (Figure 6.2).

Figure 6.2 2D Sequence View Scan Window
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2D Scan Information Field

Figure 6.3 2D Scan Window - Scan Information Field

Scan Recipe ecipe: _OFFS0C Scan Location
information column. [ Scan Type: 2D 4 information column.
Scan Length: 1600.000 pm
Scan Speed: a0 ymisec
Sampling Rate: 80 Hz
Scan: ->
2D Recipe Column

The first column in the 2D Scan Information Field is the Recipe column. It contains
the scan recipe name and some of the critical determining recipe parameters.
Table 6.1 presents a brief description of each parameter.

Table 6.1  Scan Screen - Recipe Information Column

Parameter Description

Recipe Gives the name of the recipe being used to create the
scan. If the name is followed by “...” then it is truncated.

Scan Type The type of scan being produced, 2D or 3D.

Scan Length The length of the scan on the X-axis direction.

Scan Speed How fast the stage moves during the data gathering

portion of the scan.

Sampling Rate The number of data points being collected per second
during the scan.

Scan The direction in which the scan is being performed. -> is in
the positive direction, and <- is in the negative direction.

Scan Information Field - 2D Location Column

The second column in the Scan Information field is the Location column. It contains
the coordinates and orientation of the scan starting point. 7able 6.2 presents a brief
description of each parameter.

Table 6.2 View Scan Screen - 2D Location Information Column

Parameter Description
X The X coordinate of the scan origination point
Y The Y coordinate of the scan origination point
T The rotational value of the sample at the scan origination
point.
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Scan Information Field - 2D Sequence Recipe Column

Figure 6.4 2D Scan Window - Scan Information Field
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2D Sequence Column
The first column in the Scan Information field is the Sequence column. It contains the
information regarding the sequence being used in the scan. Table 6.3 presents a brief
description of each parameter.
Table 6.3 View Scan Screen - 2D Location Information Column
Parameter Description
Sequence The Sequence Recipe Name
Step Shows which step of the total number of step the system is
currently performing.
Slot N/A — No handler for P-15.
Lot ID The name of the sample lot. This is assigned by the
operator or the system defaults to Recipe Name. (See
Table 7.7 on page 7-11.)
2D Recipe Column
The second column in the Scan Information Field is the Recipe column. It contains
the scan recipe name and some of the critical determining recipe parameters.
Table 6.1 presents a brief description of each parameter.
Table 6.4  Scan Screen - Recipe Information Column
Parameter Description
Recipe Gives the name of the recipe being used to create the
scan. If the name is followed by “...” then it is truncated.
Scan Type The type of scan being produced, 2D or 3D.
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Table 6.4  Scan Screen - Recipe Information Column

Parameter Description
Scan Length The length of the scan on the X-axis direction.
Scan Speed How fast the stage moves during the data gathering

portion of the scan.

Sampling Rate The number of data points being collected per second
during the scan.

Scan The direction in which the scan is being performed. -> is in
the positive direction, and <- is in the negative direction.

Trace The current trace in the sequence.

2D Location Column

The second column in the Scan Information field is the Location column. It contains
the coordinates and orientation of the scan starting point. 7able 6.2 presents a brief
description of each parameter.

Table 6.5 View Scan Screen - 2D Location Information Column

Parameter Description

X The X coordinate of the scan origination point for the
current scan in the sequence.

Y The Y coordinate of the scan origination point for the
current scan in the sequence.

T The rotational value of the sample at the scan origination
point for the current scan in the sequence.

Video Image

The upper left quadrant of the screen displays a side-view of the scan as it progresses
across the sample surface. A trace arrow in the top-down view, visible with its origin
at the crosshair of image, marks the course of the scan. (See Figure 6.1 on page 6-2.)
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This is the Y axis of the
scan graph. ltis set by
system to capture the
height and depth of sample
surface features.

Real Time Scan Trace Window

This window presents a real time trace of the scan. (See Figure 6.5.) A 2D scan can be
set up for multi-scan averaging which causes the system to scan the same location as
many times as the set parameter requires. Each subsequent scan’s trace appears in a
different color in the window using a four color rotation. At the end of the scan, the
traces are averaged by the system and the result presented in the Analysis screen.

Figure 6.5 Scan screen - real time Trace Window

This is the X axis of
the scan graph. Itis
determined by the
Scan Length setting
in the recipe.

In the Real Time trace window the height/depth of the features relative to the surface
is presented as a trace across the graph. The graph’s Y coordinates are set by the
system and displayed in a scale that is appropriate for displaying scan features. The
X-axis scale is determined by the scan length set in the scan recipe. (See Figure 6.5.)

2D View Scan Screen Tool Bar

The tool bar buttons are provided for convenience. Many of their functions are
duplicated from other screen menu items in the menu bar. 7able 6.6 presents a brief
description of the function of each button.

Use the buttons to customize the appearance of the Real Time view. Note that while
the scan is still Live (not saved), the XY view, Analysis Window, Recipe Editor and
Scan View screen can all be toggled between so parameters can be readjusted to
improve the scan. The first buttons in the following table open the various screens.
All the buttons are located in the tool bar at the top of the View Screen. (See

Figure 6.8 and Table 6.1.)

* NOTE: During the scan, the buttons are grayed out and cannot be
accessed until the scan is complete. Only the STOP icon is active.
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View Scan Window - 2D Screen Function

Table 6.6 2D View Scan Window Tool Bar Buttons

Button Description

XY View Screen Icon — Changes to view the XY View screen.

X

Analysis Screen Icon — Changes screens to view the Analysis
screen.

Recipe Editor Screen Icon — Changes screens to view the Recipe
Editor Screen

HIERE

Manual Scaling — Resizes the trace to fit in the graph. Requires
“"ﬂ operator initiation.

Auto Scaling — Automatically resizes the trace after each scan.

|13

START SCAN - Starts a stopped scan. The scan that was stopped

I»- begins again from the start, the prior partial scan is not retained.
STOP SCAN — Stops a scan that is in process. A stopped scan

a cannot be started again from the place in the scan where it
stopped. The scan begins again from the beginning.
PAUSE SEQUENCE — N/A for single scans.

||
START/RESUME SEQUENCE — N/A for single scans.

>

2D View Scan Screen Menu Bar

The menu bar contains those functions that are related to the activities required in the
View Scan Screen. Some of the functions are duplicated in the tool bar. (See
Figure 6.6.) Each menu is discussed in its own table.

Figure 6.6 2D View Scan Screen Menu Bar

Filz Trace Mode |mage Scan Seg Fan Debug
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Table 6.7 2D View Scan Screen - File Menu

File Menu

Description of Menu ltems

Weeiloscope
#r Wiew
Analyziz
Edit Recipe

Exit Scan

Oscilloscope — Not available with P-series systems.

XY View — Returns to the XY View screen.

If the scan was stopped in the View Scan screen,
and the File/XY View menu item was used to toggle
to the XY view screen, the scan start position can be
adjusted. The user then toggles back to the View
Scan screen from the Actions/View Scan menu item
in the XY View screen, and the scan can be run
again in the new location.

Analysis — Returns to the Analysis screen with the current
data displayed.

+ If the scan is stopped by the user, the user can
toggle to the Analysis screen by using the
File/Analysis menu item.

¢ If the user returns to the View Scan screen from the
Analysis screen to start a stopped scan, when the
scan is complete, the screen does not automatically
return to the Analysis screen. To return to the
Analysis screen, use the File/Analysis menu item.

Edit Recipe — Opens the Recipe screen for the current
scan.
+ If the user stops a scan and wants to edit the scan
recipe, the Recipe Editor can be opened using the
File/Edit Recipe menu item.

Exit Scan — Closes the current screen.

Table 6.8 2D View Scan Screen - Trace Menu

Trace Menu

Description of Menu Items

v Auto Scale
Ay IE

Rescale — Resizes the trace to fit in the graph. Requires
operator initiation.

Auto Scale — Scales the trace as it is being created.

AC/DC - Grayed out - Not available.

Table 6.9 2D View Scan Screen - Mode Menu

Mode Menu

Description of Menu Items

Mode

v Background Subtraction

Background Subtraction — appears active but is not
available for use with the P-15 system.
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View Scan Window - 2D Screen Function

Table 6.10 2D View Scan Screen - Image Menu

Image Menu

Description of Menu ltems

Image

il ey 13 L]

Zoom In — Not available in the P-series systems.

Center Anchor — Not available for single 2D scans.

v Eentendnehon
[Samernsnchor

Corner Anchor — Not available for single 2D scans.

EditSean Farameters...

Edit Scan Parameters... — Use the File/Recipe menu item
for this function.

Table 6.11 2D View Scan Screen - Scan Menu

Scan Menu

Description of Menu ltems

Start — Starts the scan after it has been stopped mid
process. This is the same as the START button in the tool
bar. The grayed out option is the currently active one. In
the illustration, the scan has been started, only stopping
can be performed.

Stop — Stops the scan during a scan without canceling the
procedure. The scan can be started all over again, but not
from the point in the scan where it was halted.

Table 6.12 2D View Scan Screen - Sequence Menu

Sequence Menu

Description of Menu Items

Eesume

Pause — Used in Scan Sequences only.

Resume — Used in Scan Sequences only.
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Table 6.13 2D View Scan Screen - Pan Menu

Pan Menu

Description of Menu ltems

Slow
v hMtedium
Fast

Move Speeds
LLeft

Bt

U

[t

Slow — Small size stage movement increments. The Slow
movement is defined in the Move Speeds dialog box.

Medium — Medium size stage movement increments. The
Medium movement is defined in the Move Speeds dialog
box.

Fast — Large size stage movement increments. The Fast
movement is defined in the Move Speeds dialog box.

Move Speeds... — Opens the Dialog box to define the
stage movement increments.

Left — Not Available in the P-Series systems.

Right — Not Available in the P-Series systems.

Up — Not Available in the P-Series systems.

Down — Not Available in the P-Series systems.

Table 6.14 2D View Scan Screen - Debug Menu

Debug Menu

Description of Menu Items

Siwiteh e 20
Styitch to 3
fiur arn Sauare liaal

Switch to 2D — unavailable for this application

Switch to 3D — unavailable for this application

Turn on Square Tool — unavailable for this application

3D SCREEN FUNCTION

The function of the 3D View Scan screen is similar to that of the 2D screen. Some
additions to the screen are made to facilitate 3D analysis and operator monitoring of
the scan process. Some menu items from the Menu bar are not accessible when

operating 3D sequences.

The View Scan Window for 3D scans appears while a scan is being run. It allows the
user to observe the progress of the scan and to adjust scan parameters in the various
screens for optimum scan results. The scan can be started once the recipe has been
chosen and the sample loaded onto the sample stage. The scan can be started from
several places. The most common two starting points are:

¢ With the required recipe chosen, if the user believes that the scan starting point
is already set to the desired point, click on START in the Scan Recipe screen.

¢ To view the sample and align the starting point of the scan, from the Scan
Recipe screen, click the XY icon. After the necessary adjustments are made to
the start position in the XY View screen, click START.

6-10
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View Scan Window - 3D Screen Function

Click START to begin the scan. The View Scan screen appears. (See Figure 6.7.)

The Video Display window

shows the sample surface ™.
with the scan area

surrounded by a box.

Along with the items found in
the 2D Information filed,
Trace: is added as a strictly
3D element.

Two

The head lowers bringing the stylus into contact with the sample at the
start-of-scan position. The scan begins, first briefly traveling opposite the scan
direction, then reversing. This allows the mechanical instruments to settle down
and the stage to reach the programmed scan speed before data collection begins.
The View Scan window appears, switches to side view optics, and the scan
begins. The video image shows the stylus in contact with the sample surface
during the scan from the side-view perspective. The Real Time Scan graph in
the lower right quadrant displays the data in a real time trace as it is collected.
(See Figure 6.7). After each trace, the data is presented in the 3D Top View
window, with each successive trace being added to the others until all traces are
viewed in the window. When the scan is finished, the system performs
calculations on the data and automatically displays it in the Analysis window.

Figure 6.7 3D View Scan Screen During a Single Scan
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display, view of
composite traces.

Scan =3
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2D trace display, of
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to create 3D

Line 2 1001 Ports

columns of information are presented in the lower left quadrant of the 3D scan

screen (Figure 6.7) and three columns in the 3D sequence screen (Figure 6.8).
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When performing a
sequence, the Sequence

information is added to the

information set. \

The only parameter in this
field that is different from
the 2D field is Trace:

Figure 6.8 3D View Scan Screen During a Scan Sequence
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Figure 6.9 3D Scan Window - Scan Information Field

Recipe: DEF_SEAR.. Location:
Scan Type: aD ¥ 0.00
Scan Length: 100.000 prm Y. 0.00
Scan Speed: 20 umisec T. 0.00

Sampling Rate: 200 Hz

Scan: -2
\@e: 3/10; Spacing 10.000000 prn)
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3D Scan Recipe Column

The first column in the Scan Information Field is the scan Recipe column. It contains
the scan recipe name and some of the critical determining recipe parameters.

Table 6.15 presents a brief description of each parameter. The 3D column adds Trace
to information presented in a 2D parameter set.

Table 6.15 Scan Screen - Recipe Information Column

Parameter Description

Recipe Gives the name of the recipe being used to create the
scan. If the name is followed by “...” then it is truncated.

Scan Type The type of scan being produced, 2D or 3D.

Scan Length The length of the scan in the X direction.

Scan Speed How fast the stage moves during the data gathering

portion of the scan.

Sampling Rate The number of data points being collected per second
during the scan.

Scan The direction in which the scan is being performed. -> is in
the positive direction, and <- is in the negative direction.

Trace Presents: 1) The current scan number out of the total
number of scans to be completed. (2) Spacing between
traces through the scan area in both proportion (showing
how many traces are being made) and size.

3D Location Column

The second column in the Scan Information field is the Location column. It contains
the coordinates and orientation of the scan starting point. 7able 6.16 presents a brief
description of each parameter. This information is identical with that for 2D scans.

Table 6.16 View Scan Screen - 3D Location Information Column

Parameter Description
X The X coordinate of the scan origination point
Y The Y coordinate of the scan origination point
T The rotational value of the sample at the scan origination
point.
0104396-000 AA KLA-Tencor Confidential 6-13
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Scan Information Field - 3D Sequence Recipe Column

Figure 6.10 3D Scan Window - Scan Information Field

Sequence
Information >

Recipe: _COARSE Location: _a— Scan Location
Scan Type: 3D ¥ 0.00 information
Scan Length: 50.00C pm : column.

Sequence:
Step: 1 of 3
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CORS_SE

Scan Recipe Scan Speed: 10 pmisec
information M» gi::]p.lmg Rate: 130 Hz
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3D Sequence Column
The first column in the Scan Information field is the Sequence column. It contains the
information regarding the sequence being used in the scan. Table 6.17 presents a brief
description of each parameter.
Table 6.17 View Scan Screen - 3D Location Information Column
Parameter Description
Sequence The Sequence Recipe Name
Step Shows which step out of the total number of steps the
system is currently performing.
Slot N/A — No handler for P-15.
Lot ID The name of the sample lot. This is assigned by the
operator or the system defaults to Recipe Name. (See
Table 7.7 on page 7-11.)
3D Recipe Column
The second column in the Scan Information Field is the Recipe column. It contains
the scan recipe name and some of the critical determining recipe parameters.
Table 6.18 presents a brief description of each parameter.
Table 6.18 Scan Screen - Recipe Information Column
Parameter Description
Recipe Gives the name of the recipe being used to create the
scan. If the name is followed by “...” then it is truncated.
Scan Type The type of scan being produced, 2D or 3D.
6-14 KLA-Tencor Confidential 0104396-000 AA
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Table 6.18 Scan Screen - Recipe Information Column

Parameter Description
Scan Length The length of the scan on the X-axis direction.
Scan Speed How fast the stage moves during the data gathering

portion of the scan.

Sampling Rate The number of data points being collected per second
during the scan.

Scan The direction in which the scan is being performed. -> is in
the positive direction, and <- is in the negative direction.

Trace For the current 3D scan it presents: 1) The current scan
number out of the total number of scans to be completed.
(2) Spacing between traces through the scan area in both
proportion (showing how many traces are being made)
and size.

3D Location Column

The second column in the Scan Information field is the Location column. It contains
the coordinates and orientation of the scan starting point. 7able 6.19 presents a brief
description of each parameter.

Table 6.19 View Scan Screen - 2D Location Information Column

Parameter Description

X The X coordinate of the scan origination point for the
current scan in the sequence.

Y The Y coordinate of the scan origination point for the
current scan in the sequence.

T The rotational value of the sample at the scan origination
point for the current scan in the sequence.

3D View Scan Screen Tool Bar

The tool bar buttons are provided for convenience. Many of their functions are
duplicated from other screen menu items in the menu bar. 7able 6.20 presents a brief
description of the function of each button.

In 3D sequences most of the buttons are not active. Note that while the scan is still
under way and when a sequence scan is paused, the XY view, Analysis Window,
Recipe Editor and Scan View screen icons are all disabled. All the buttons are located
in the tool bar at the top of the View Screen. (See Figure 6.8 and Table 6.20.)

* NOTE: During the scan, the buttons are grayed out and cannot be
accessed.

0104396-000 AA KLA-Tencor Confidential 6-15
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Table 6.20 3D View Scan Window Tool Bar Buttons

Button

Description

XY View Screen Icon — Disabled for this process.

Analysis Screen Icon — Disabled for this process.

Recipe Editor Screen Icon — Disabled for this process.

Manual Scaling — Resizes the trace to fit in the graph. Requires
operator initiation.

Auto Scaling — Automatically resizes the trace after each scan.

START SCAN —

Sequences: Once the STOP SCAN icon is clicked, the sequence
is terminated and there is no opportunity to use this button. Not
used in sequences.

Single Scans: In a single 3D scan, this initiates the scan from the
View Scan window. If the STOP SCAN icon is clicked, the scan is
terminated an this icon is not used to restart a stopped scan.

STOP SCAN —
Sequences: Stops a scan sequence that is in process and returns
to the Scan Catalog screen.

Single Scans: Stop a scan that is in progress and returns to the
Scan Catalog screen.

PAUSE SEQUENCE - Stops a sequence that is in process. If a
scan is in process when the sequence is paused, that scan is
repeated when the sequence is resumed.

START/RESUME SEQUENCE - Starts a sequence or resumes a
paused sequence. Resuming a sequence starts it from the
beginning of the interrupted scan.

o

PAN AND ZOOM - This icon is not applicable for the P-15 system.
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3D View Scan Screen Menu Bar

The menu bar contains those functions that are related to the activities required in the

View Scan Screen. Some of the functions are duplicated in the tool bar. (See
Figure 6.11.) Each menu is discussed in its own table.

Figure 6.11  View Scan Screen Menu Bar

Filz Trace Mode |mage Scan Seg Fan Debug

Table 6.21 3D View Scan Screen - File Menu

File Menu

Description of Menu ltems

Weeilascope
#r View
Analyziz
Edit Fecipe

Exit Scan

Oscilloscope — Not available with P-series systems.

XY View — Disabled for 3D scans

Analysis — Disabled for 3D scans

Edit Recipe — Disabled for 3D scans

Exit Scan — Disabled for 3D scans

Table 6.22 3D View Scan Screen - Trace Menu

Trace Menu Description of Menu Iltems
Rescale — Resizes the trace to fit in the graph. Requires
— operator initiation.
Rescale
v Auta Scale Auto Scale — Scales the trace as it is being created.
A(E/0E

AC/DC - Disabled.

Table 6.23 3D View Scan Screen - Mode Menu

Mode Menu

Description of Menu ltems

v Background Subtraction

Background Subtraction — appears active but is not
available for use with the P-15 system.

0104396-000 AA
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Table 6.24 3D View Scan Screen - Image Menu

Image Menu

Description of Menu ltems

Image

il ey 13 L]

Zoom In — Not available in P-15 systems.

Center Anchor — Not available in P-15 systems.

v Eentendnehon

[Samernsnchor

Corner Anchor — Not available in P-15 systems.

EditSean Farameters...

Edit Scan Parameters... — Use the File/Edit Recipe menu
items to perform this function.

Table 6.25 3D View Scan Screen - Scan Menu

Scan Menu

Description of Menu ltems

Start —

Sequences: The sequence is terminated when the STOP
button is clicked. There is no opportunity to use this menu
item.

Single Scans: Starts a 3D scan from the View Scan
window. Operates the same as the Start Scan icon.

Stop —

Sequences: Stops the sequence during a scan, canceling
the sequence and returning to the Sequence Catalog
screen.

Single Scans: Stops the scan and returns to the Scan
Catalog screen.

Table 6.26 3D View Scan Screen - Sequence Menu

Sequence Menu

Description of Menu Items

Seg

Eauze

Eesume

Pause — Pauses the scan sequence. The current scan is
abandoned and will be started over when the Resume
icon or menu item is clicked.

Resume — Resumes the sequence again, initiating it at
the beginning of the scan that was interrupted.

6-18
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Table 6.27 3D View Scan Screen - Pan Menu

Pan Menu Description of Menu ltems

Slow — Might appear active but is non functional.
Slaw Medium — Might appear active but is non functional.

v hMtedium . . . .
Fast Fast — Might appear active but is non functional.
Mave Speeds Move Speeds... — Might appear active but is non

functional.

LLeft
Bight Left — Not Available in the P-Series systems.
%p Right — Not Available in the P-Series systems.
Wy

Up — Not Available in the P-Series systems.

Down — Not Available in the P-Series systems.

Table 6.28 3D View Scan Screen - Debug Menu

Debug Menu Description of Menu ltems
Switch to 2D — unavailable for this application
St T 20 Switch to 3D — unavailable for this application
Switch te s
T;m i B T Turn on Square Tool — unavailable for this application

Video Image

The upper left section of the screen displays scan image on the sample surface. (See
Figure 6.8.) Prior to the scan, a scan boundary box surrounds the scan area in the
image.
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Real Time Scan Window

This window presents a real time trace of the scan. (See Figure 6.12.) In the Real
Time trace window the height/depth of the features relative to the surface is presented
as a trace across the graph. The graph’s Yaxis scale is set by the system and displayed
in a scale that is appropriate for the scan features. The X coordinates are determined
by the scan length set in the scan recipe.

Figure 6.12 Scan screen - real time Trace Window

This is the X-axis of
the scan graph. ltis

This is the Y-axis of the
scan graph. Itis set by

system to capture the determined by the
height and depth of sample Scan Length setting
surface features. in the recipe.
In a 3D scan each subsequent scan’s trace is presented in the 3D Top View display.
(See Figure 6.13.) At the end of the scan the system presents the results in the 3D
Analysis screen.
Figure 6.13  Top View Image of the 3D Scan In Progress
nim
80
The height of the scan

image is defined by the
Y distance in the Recipe
Editor for the recipe

the width of the scan
image is defined by the
Xdistance in the Recipe

being used. . .
9 Editor for the recipe
/ being used.
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SHOW MEASUREMENT SITE DURING SEQUENCE RUN

Introduction

During a sequence scan procedure, the user can toggle between a view of the current
scan site (actually, the image contains as much of the scan site as allowed by the
current magnification) on the Video screen and the Die Measurement Site Map. (See
Figure 6.14.) To toggle between the views, use the following procedure:

1. In the Sequence Scan Screen, click View in the menu bar.
2. Choose Toggle Video or Wafer View to toggle between the scan site (Video) and
the wafer die map (Wafer View).

When the Show Measurement Site is enabled, the video screen presents a frozen image
of the scan start position. The Die Measurement Site Map contains the location(s) of
the scan sites or die in which the scans take place.

Figure 6.14  View Menu (Sequence Scan Screen)

Configuration

The Configuration screen provides the user with the option to set the system so the
video display can toggle between the measurement site image and to the video image
of the scan site. This dialog box is entered through the Configuration screen button,
Sequence Execution Options.

Figure 6.15 Sequence Execution Options

Sequence Execution Dptions | x|

Show Measurement Sites Prompt for Lot 1D Before Sequence Execution: I
causes the starting point of

the scan site to be displayed
in the video screen. — e 7

Show Measurement Sites J

Low Mag. Camera (* Higt k&g Eamera €

Prompt for Operator ID Before Sequence Execution: [~ Cancel

Low Mag. Camera is

— Automation
chosen by default to et SlerE r
v?ew the scan site in the Prompt for Caszette ID[EMID] if reader fails r
video Image. Operator input required [zlot map). r
Show Measurement Sites
To activate the Show Measurement Sites option,
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1. From the Configuration Screen, click Sequence Execution Options...

2. Click to put a check in the Show Measurement Sites checkbox. The default for
this feature is that it is disabled.

When this is clicked, the Low Magnification is automatically chosen and cannot
be disabled; it is the default setting. If the Show Measurement Sites is enabled,
the system allows the user to toggle between the display of the measurement
sites on a scan site sample image (like a wafer map), and the actual video view
of the scan site.

3. Click OK to save the settings and close the dialog box.

Camera Settings

The camera setting for the P-15 system is set to low magnification by default. The
view of the scan site is presented in low magnification. The view is limited by the
magnification and might or might not contain the entire scan area.

Wafer Image Display

If the Wafer Map is chosen, all of the sites that are to be scanned are visible on the
wafer image. If the wafer has a die grid and the die is loaded, the wafer map looks like
the die map and the entire die containing the scan site(s) is highlighted in a color. The
die is color coded to represent its scan status. The colors are as follows:

¢ Yellow: Site waiting to be scanned

¢ Dark Green: Site being scanned

¢ Green: Site already scanned.
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If the wafer is not characterized by a die grid, or the die map is not loaded, the scan
sites appear as colored dots at the scan location. The color code is the same as that of
the wafer having a die grid map.

Figure 6.16  Sequence Scan Screen with Die Measurement Site Map

.I'I-.id-ei [Sequence. OFFSET_SEQUENCE_1]
Bl Yuw Iuce Mode |mage foam Seg Ban Debug Heb
Green: Site a2 |2 [T NN N
1
already scanned. |, D

I Dark Green: Site
being scanned.

Yellow: Site not —T
scanned.

Foquince.  OFFSET_SEGUENCE_T

Racips: _OFF150 Location
Step: 203 Scan Type: n X aT5M
Slot:  N/A Scan Length: 200,000 pen ¥ -A419.11

Scan Speed. 10 pmisec T. 4888
Lot I0x OFFSET_SEQUE . Sampling Rate: 50 Hz
Scan >
Fiocor Skt SinE|  Hegh Syiwd )
OFF150 0 1 810430 pm 0.00 pm 635020 ym

_Ciea S [Cone 0
Emgly?

|Sequence Siee: 2. Recos: _OFF150

Scan Site Image Display

As the sequence progresses through each scan site, the image of the current scan site
is displayed in the video screen. This is the view that alternates with the Die
Measurement Site Map (see Figure 6.16) as the View menu options are toggled
between (see Figure 6.14). This image is not live, but is a snap shot of the scan site
start position as it appears before the scan.

ABORTING A SCAN

Click the Stop button at any time to abort the scan. The scan can be started all over
again, but not from where it stopped. All data from the aborted scan is lost. If a
sequence is halted using the Pause button, and the sequence is resumed, the Analysis
screen might not be displayed at the end. Click File/Analysis to open Analysis.
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SEQUENCE RECIPE AND DATA (OPTIONAL)

INTRODUCTION

The Sequence Recipe and Data application is a system option. It must be purchased.
The Pattern Recognition, which can be used with the Sequence option, must also be
purchased. The Sequence application uses sequences that contain multiple scan
recipes combined into one file for automatic sequence scanning. This saves time
when repeatedly scanning the same location(s) on multiple samples. The Sequence
Recipe and Data application consists of two parts:

*

*

Sequence Recipe Editor to load, create, edit, and save Sequence Recipes for
scanning.

Sequence Database to load, collect, manipulate, and save data obtained from
scanning.

Sequences can be created using any combination of 2D and 3D recipes. The Sequence
Recipe contains information that directs the system to precisely position the sample
beneath the measurement head for each measurement in the sequence of scans. Each
measurement location in a sequence is called a site. The information for how to scan
each site is contained in the Scan Recipe that is connected with the site in the
Sequence Recipe. See Chapter 3 for more information on creating and editing Scan
Recipes.

The Sequencing feature provides the following capabilities:

*

*

Combine a 600 sites and Scan recipes

Set reference points for correcting translational and rotational variations
between substrates (deskew)

Re-scan portions of a long scan, using the long scan as a data reference for the
subscans so their measurements correlate with each other

Set Deskew manually or automatically using Pattern Recognition

Set Pattern Recognition options to search locally for a match when a match is
not found in the camera’s field of view at deskew sites, and carry out
user-selected instructions if the search fails

Set pattern recognition to reference sites using site-by-site Pattern Recognition
In Multi Analysis mode, apply different Scan recipes to a single scan

Automatically display, print, export, and save statistics and trace data for all
sites

Teach scan sites and alignment reference points interactively, with or without
theta

Export the data from each wafer immediately following the wafer processing

Choose the number of times the Sequence Recipe is run and allow the data to be
saved for each run
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This chapter describes:

¢ Starting the Sequence Editor Application on page 7-2

¢ Sequence Editor Window Features on page 7-3

¢ Editing the Options Field in the Sequence Editor on page 7-7

¢ Creating a Sequence Recipe on page 7-13

¢ Running a Sequence on page 7-29

¢ Correlation Scans on page 7-29

* Viewing Saved Sequence Data on page 7-31

¢ Using Multi Analysis In Sequence on page 7-32

¢ Jiewing Sequence Data with the Corresponding Trace, Site-by-Site

on page 7-35

¢ Sequencing with Manual Deskew on page 7-36
¢ Deskewing Twice To Align Theta on page 7-38

¢ Sequencing with Pattern Recognition Deskew (Pattern Recognition Option

Only) on page 7-38

¢ Using Groping with Pattern Recognition on page 7-44

¢ Sequencing with Site-by-Site Pattern Recognition on page 7-48

¢ Saving Sequences on page 7-49

¢ Saving the Sequence Data on page 7-50
¢ Sequence Transportability on page 7-51

¢ Handler... Button Options Window For Sequencing on page 7-58

¢ on page 7-63

STARTING THE SEQUENCE EDITOR APPLICATION

1. Inthe Catalog screen, if it is not already active, click the Sequence Recipe

button.

2. Select a Sequence recipe to be edited.
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3. Click the View/Modify button. (It is also possible to double-click on the recipe to
open the Sequence Editor.

The Sequence Editor screen appears. (See Figure 7.1).

Figure 7.1 Sequence Editor Screen

Profiler - [Sequence Editor - IMO70771} | x|

Sequence Edit Sample Yacuum Deskew DieGrid Diagnostics Help

D & |E| & | s

|EL|M
Loc Recipe X ¥ Theta X-0ft Y-Off
Video Calibration 0.39 0.38
B I
1onse | Bdb> Base Angle 0.20
100K Deskew Site 1 61389 62661 0.20
15U MI Deskew Site 2 59334 -42213  0.20
o 1 6N —60971 1915 0.20
ECK EdtResie. | | 5 oy -50915 1892 0.20
s Recipe list 3 6UM 1895 0.20
can Recipe lis| 4 554 0.20
Select Al T 0r20
Autoeity.. | g ggg g g gg
T 8 6UNM 0.20 Sequence
—I- 9 GUM 0.20 ; B
o 10 o e Recipe list
B 11 6UM 0.20
I~ Semi-Automatic Mode 12 @ud 020
Mode: |Pattern Recog. Deskew ¥
Options section IfFait [Procesd Measuement |~
Data... I Handler... I
Sort... | Sort is inactive
[Regular Scan = TeachLoc... TeechPa | EdtXYTheta.. |

Multi Analysis | Test 5= Frey itz | Edtwr et |

|Sample? Clear Status |

Scan Type drop-down menu Site buttons

SEQUENCE EDITOR WINDOW FEATURES

The Sequence Editor window consists of the following elements:

¢ Scan recipe catalog for selecting from available Scan recipes
¢ Options section for setting sequence options
¢ Control buttons for sequence programming

¢ Sequence list, linking sites with Scan recipes

Sequence Editor Menus

The Sequence Editor menu bar provides access to commands through its menus.
Click on the titles in the menu bar to view their menus.
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Sequence Editor Toolbar

The Sequence Editor toolbar contains buttons that provide an alternative way to
access commonly used functions. (See Table 7.1.)

Table 7.1 Sequence Editor window buttons

Button

Description

Creates a new default Sequence recipe.

Opens Sequence recipe editor for the currently chosen recipe in
the sequence.

Saves the current Sequence recipe; if the current Sequence
recipe has never been saved, displays the Save Sequence As
dialog box first.

Prints the selected Sequence recipe.

e EREE

Starts a scan using the current Sequence recipe.

Table 7.2  Sequence List Buttons

Button

Description

Add >>

Adds the selected Scan recipe into the sequence.

Change >>

After highlighting an existing site in the Sequence list,
clicking this button changes the Scan recipe for the site
to whatever is highlighted in the catalog.

Edit Recipe. ..

Displays the Scan Recipe Editor, open to the recipe
selected in the Scan recipe Catalog (the field to the left of
the Edit Recipe... button.)

Select All

This selects all the recipes in the current Sequence
Recipe.

At Werify,

This goes to the XY View screen and locates the current
scan location in the video screen for verification.

1

Delete

Deletes the selected site from the sequence.

7-4

KLA-Tencor Confidential 0104396-000 AA
3/05




KLA-Tencor P-15 User’s Guide

Sequence Recipe and Data (Optional) - Sequence Editor Window Features

Table 7.3  Options Buttons

Button

Description

Displays the Data Saving Options dialog box where
sequence data can be automatically saved, exported, or
printed.

Displays the dialog box for the sort software option.

Displays the Handler dialog box. The P-15 has no
handler so the only option available is Manual Load.

Table 7.4 Site Buttons

Button

Description

Teach Loc...

Goes to the XY view so a measurement site can be
chosen based on a location observed on the screen.

Teach Pat...

Goes to the XY view so a pattern can be taught for
pattern recognition.

m |
e
>
=
—
=
z
=]

Defines a measurement site by allowing the manual
entry of the X, Y, and Theta coordinates.

Multi Analyzis

Defines the measurement site as a multi analysis site
where analysis is performed on data from the last site
with defined coordinates. Basically, uses the same raw
data but with a different scan recipe.

Test

Runs only the highlighted site without running the whole
sequence.

Usge Prey Site

A measurement site can be set up to use the previous
site’s pattern for site-by-site pattern recognition.

|Editx.¥ Dfset.._ |

X and Y offset values can be manually entered from a
pattern rec site to a measurement site.
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Displaying the Sequence Information Dialog Box

The Sequence Information dialog box displays the title, author, date and time of
creation (or modification) of the sequence. It also provides a text box for annotations.

1. In the Sequence Editor, click the Sequence menu to display its menu.
(See Figure 7.2).

Figure 7.2 Sequence Editor — Sequence Menu

ler - [Sequence Editor - IMO70771} | x|

2N Edit Sample Yacuum Deskew DieGrid Diagnostics Help

Step 1 Click on Sequence

/' New Ctil+N
. . Ll BTART.
to display its menu. Open.. CtlD prov]
Save Ctr+S cipe name: IELIM
Save As... -
) . | Loc Recipe X ¥ Theta X-Off Y-Off
Step 2 Click Info... to display Stat Bl = Ce1hation 0.35  0.38
. . Repeat Base Angle 0.20
its dialog box. Deskew Site 1 61389 62661  0.20
Deskew Site 2 59334 -42213 0.20
Print... Crl+P . 1 6UH -60971 1915 0.20
Auto Print Options... ﬂ] 2 6UM -50915 1892 0.20
—E'S = 3 6UM 1895 0.20
2it Sequence Editor 4 1878 0.20
LAl - —
5 0.
Auto Verify... 6 0.
7 0.
8 0.
ﬂ] 9 UM 1772 0.20
~ Options 10 6UM 1758 0.20
2 116U 1732 0.20
I Semi-Automatic Mode 42 G s -2y
Mode: |Pattem Recog. Deskew ¥
IfFail: |Proceed Measurement | ™
Data... I Hander...
Sort... | Sort is inactive
R es = Teach Loc... Teachpan | Edt %Y. Theta... |
Mult Analysis | Test 5= Frey itz | Edt st |
|Sample? Clear Status |

2. From the Sequence Menu, select Info... (See Figure 7.2)

Figure 7.3 Sequence Information Dialog Box

Sequence Information [ x|
Mame: |c:\eagle'\seqrcp'\CElFIS_SEQ
User: |
Step 4 This field, the Modified: |November 21,2000 04:51:21 PM
Comments: text box, can be Comments:
Sequence run on sample, X-calib ;I

used to record messages or
information on the sequence
listed in the dialog box heading.

ak. I Cancel |

The Sequence Information dialog box is displayed. The Name, User, and
Modified fields cannot be edited.
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3. Click in the Comments field, or press TAB<— or TAB— until the Comments text
box is highlighted.

4. Enter the text of the information which needs to be passed from one operator to
the other.

EDITING THE OPTIONS FIELD IN THE SEQUENCE EDITOR

In the Options variable fields, sequence mode (deskew options) and data transfer
options can be defined for the sequence displayed in the editor.

Semi-Automatic

In the Sequence Editor, put a check in the Semi-Automatic check box to enable the
mode. (See Figure 7.4)

For 2D scans, the Semi-Automatic mode causes a sequence to display the trace
data after each scan and pause before proceeding to the next step. Each step can
be verified and, if needed, the scan sites can be adjusted and the scan performed
again before proceeding to the next step.

For 3D scans, the Semi-Automatic mode does not halt the sequence between

steps.
Figure 7.4 Sequence Editor — Mode Menu
Profiler - [Sequence Editor - IMO71348] | x|

Sequence Edit Sample Yacuum Deskew DieGrid Diagnostics Help

D & |E| & | s
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I M Deskew Site 2 39815 0.20
— 1 15UM —41648 0.20
BUK Edthesie.. | | 5 1opy -22148 0.20
3 15UM -2658 0.20
selcta | RIS 0.z
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Click in the Semi-Automatic AuaVeriy.. | | 5 120M et a2
check box to enable the _ Do || B 15 s p-20
mode. 10 15UM 341 0.20
11 150 19841 0.20 i
12 150 39332 0.20
13 15UM 335 0.20
14 15UM 19835 0.20
15 15UN 39332 0.20
16 150N 337 0.20
Click on the Mode 17 150M 19836 0.20
18 150M 39331 0.20
down-arrow to display its 19 150M -41656 0.20
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available modes. Mult Analysis | Test 5= Frey itz | Edt st |
|Sample? Clear Status |
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Set Deskew Mode

Click the Mode drop-down menu (see Figure 7.4), and select the from the following
Sequence modes. (See Table 7.5)

Table 7.5  Mode Drop-down Menu Options

Mode Description

No Deskew The sequence contains no deskew points for
alignment.

Manual Deskew Deskew points are set and must be confirmed
manually by the operator.

Pattern Rec. Deskew Deskew points are set using the Pattern Recognition
option.

Site-by-Site Pattern Scan sites are set relative to a Pattern Recognition

Recognition site and deskew is performed by pattern recognition.

Site-by-Site No Deskew Each site is scanned without deskew.

& CAUTION: It is important that when scanning with Pattern
Recognition, use the same zoom setting for the scan that was used to
capture the pattern. If zoom is used during the procedure, always
zoom completely out before starting the scan. If a particular zoom
setting is required, use the Zoom-lock feature to ensure that the zoom
setting remains unchanged throughout the procedure.
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Set Scan Status Option if 1. Click the If Fail drop-down menu, and select the action to take if the pattern
Pattern Recognition Fails recognition fails to find a site. (See Table 7.6.)

Figure 7.5 Sequence Editor — If Fail Menu

Profiler - [Sequence Editor - IMD71348] B3
Sequence Edit Sample Yacuum Deskew DieGrid Diagnostics Help

D& |E| & | s

Recipe name: IELIM
Loc Recipe X ¥ Theta X-0Oft Y-Off

i ’—I ¥ideo Calibration 0.33 0.38 =
Hlowse | 2ddd> Base Angle 0.20 —

100N Deskew Site 1 42141 43571 0.20

T M Deskew Site 2 39815 -38319 0.20

_— 1 1508 —41648 43070 0.20

EUK Edthesie.. | | 5 1opy -22148 43078 0.20

3 15UH 2658 43084 0.20

Select Al I 4 150 23577 0.20

5 15UH —22149 23582 0.20

AutoVeriy.. I & 15UH 2661 23590 0.20

7 15UH —41654 4104 0.20

T 8 15UH —22153 4110 0.20

—I- 9 15UH —2666 4117 0.20

— 10 15UM 341 43088 0.20
!’ B 11 15UM 19841 43098 0.20 &

V' Semi:Automatic Mode 1§ 123& 393;; ggégf ggg

| 14 15U 19835 23601 0.20

15 1508 39332 23613 0.20

i ) 16 150U 337 4117 0.20

Step 1 Click on the If Fail 17 15UH 19836 4128 0.20

. X 18 15UM 39331 4138 0.20

down-arrow to display its 19 1508 -41656 1105  0.20
Select f th 20 15UM -22155 1111 0.20 =
menu. Selectirom the [Reguiar Scan = TeachLoc... TeachEa | EdtX.Y.Theta... |
available modes. Mult Analysis | Test 1= Frey e | Edibiset |

[Sample? Clear Status |

Table 7.6  If Fail Drop-down Menu

Feature Description

Proceed Measurement Continue with the next site as if the scan had
worked.

Skip, No Measurement Measurement of that wafer is suspended.

Retry Pat. Rec. Manually Allows user to move the site into the field of
view.

Find Site Manually without Pat. | Allows the user to click on the center of the
Rec. pattern being used for pattern recognition and
click OK to continue with scan without pattern
recognition confirmation.

Cancel Sequence Sequence is suspended. User must restart the
sequence.
0104396-000 AA KLA-Tencor Confidential 7-9
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Begin: Set Data Options

Step 2 Click the Data
button to open the Data

Options dlalog box. \ Mode: | Patten Recag. Deskew ¥

2. Click the Data button to choose options for data collection that automatically

execute upon sequence completion.

Figure 7.6 Sequence Editor

Profiler - [Sequence Editor - CORS_SEQ]
Seguence Edit Sample Yacuum Deskew DieGrid Diagnostics Help

D& |E| & | s

Scan Recipe Catalog: Recipe name: I_CUAHEE
Type: Contact 2 3D Loc Recipe X Y Theta X-Off Y-Off
[ I ,WI Video Calibration 1.50 1.50
— Base Angle HOT USED
FIRST Ch Deskew Site 1 —2282 1757 0.00
E Lge”l Deskew Site 2 -3046 2579 0.00
. . 1 _COARSE 0 0 0.00
Edit Recipe... 2 0 0 0.00
3 _COARSE 0 0 0.00
Select All 4 _COARSE 0 0 0.00
5 FIRST 0 0 0.00
Auto Verify... 6 FIRST 0 0 0.00
Delete
~ Options:
I Semi-Automatic Mode
IfFail. |Proceed Measurement ¥
S
Data... Handler... I
Sort... | Sort is inactive
Regular Scan | Teach Loc... Teach Pat. | Edit X, Theta... ]
Mult Analysis | Test e EdT R areE|

The Data Options dialog box appears. (See Figure 7.7.) Once set, the Profiler
automatically either exports, saves, or prints the file data.

& Use Name: ICDHS_SEQ
Path... |

c\eagleseqsummbdb

™ Use Operator ID

Figure 7.7 Data Options
— Save Dptions — Export Dptions
= None & None @& ASCI File
" Statistics only " Statistics Only ¢ Binary File
Trace Data Trace Data
and Statistics and Statistics
" UseLotlD  UseLotID

& Use Name: IEDHS_SEE!

[T and use lot D for statistics name

r— Print Options

[ Enable Auto Print
Print:

Details... I

Cancel |

™ Use Dperator ID /

Step 1 When the
options have been
chosen, click OK.
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3. Choose an option from the Save, Export, and Print options. (See Table 7.7.)

Table 7.7  Save and Export Options

Feature

Description

None

Saves or exports no data.

Statistics

Saves or exports only the statistics for the specified
parameters, the recipe ID, part ID, and sequence ID.

The results for each parameter at each measurement
site are not printed, saved, or exported. Statistics are
calculated for scans taken with the same recipe and
are saved only if two or more scans are taken with
that recipe.

Trace Data

Saves or exports everything, including the recipes
used, the raw data points for each scan, parameter
results, and the statistics.

Use Lot ID

Prompts the operator to enter the Lot ID before
running the sequence, then saves or exports the data
under the Lot ID name.

Use Name

Saves or exports the data under the sequence name
or a user-specified name. The Path button opens a
dialog box for designating the path of the desired file.

Use Operator ID

Prompts the operator to enter their ID before running
the sequence. The data file contains the operator ID
but is still saved under the Lot ID or the Use Name.

The Export Options also contain a choice of export file type. (See Table 7.8.)

Table 7.8  Export Options

Feature

Description

ASCII File

Data is exported in ASCII code.

Binary File

Data is exported in binary code.

The Print Option contain the following feature. (See Table 7.9.)

Table 7.9  Print Option

Feature

Description

Enable Auto Print

Automatically prints data at the end of the sequence.

Click the Details... button to open a standard print
dialog box and set print options.

End: Set Data Options

4. Click OK to set the options.
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Teaching the Base Angle

The

Base Angle is an offset angle relative to the orientation of the sample’s pattern. It

is used to align scans with the wafer geometry. It is to be used primarily for scan
sequences using manual load in conjunction with the No Automatic Load/Unload
handler option in the system. (See No Automatic Load/Unload on page 7-62.) The

Base Angle is fixed for all scans in the sequence. Use the following procedure to
program the Base Angle.

1.

Double-click Base Angle in the sequence list. (See Figure 7.8)

2. A warning is displayed before the Teach Location screen appears. The warning
says that deskew and measurement sites could be invalidated. Click OK to
proceed or Cancel to abort the procedure.

Figure 7.8 Sequence Editor
Profiler - [Sequence Editor - CORS_SEQ]
Seguence Edit Sample Yacuum Deskew DieGrid Diagnostics Help
|| | &| s
Scan Recipe Catalog: FRecipe name: I
Type: Contact @20 C 3D Loc Recipe hid ¥  Theta X-Off Y-Off
i IVED Calibration HDT”"D 1.50 )
S’ Desk Site 1 -2282 1757 0.00
Step 1 Double-click on EDRNNE M beskew Site 2 -3046 2579 0.00
Base Angle to open th T e | “comes 1 o oo
ase Angle 10 open the —STEPHTH 3 _COARSE 0 0 0.00
1 _TIPCTRL 4 _COARSE 0 0 0.00
Teach Location screen. seketal | | 4 COMR ’ O
Auto Verify... I 6 FIRST 0 0 0.00
Delet
Before the Teach _ e _ _
Location screen opens, a R‘*
Warning is d|sp|ayed ™ SemiAutomatic Mode & Teaching base angle may invalidate deskew and measurements sites.
Mode: |Pattern Recog. Deskew ¥
IfFail: |Proceed Measurement | ¥ ﬂ'
Data... I Handler... I
Sort... | Sort is inactive
Regular Scan = Teachilee TeachPat.. | Edixiviheis |
Wi Anass | Test 5= Frey itz | Edtw et |
3. The Teach Location window appears. (See Figure 7.9). Locate a line or other
pattern to use for a reference.
4. Click the clockwise or counterclockwise Rotation buttons in the toolbar until the
crosshair is aligned with the reference feature.
* NOTE: As the range rotates, if necessary, move the stage to keep the
reference feature in the field of view.
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If the theta movement

overshoots the alignment, TSa Cr

click SLOW for smaller move
increments with each click.

If the SLOW movement
increments needs to be adjusted
so the image can be aligned,

click Move in the menu bar and

choose Move Extents. Decrease

the theta increment for SLOW.

CREATING A SEQUE

Begin: Load Sample
Procedure

Figure 7.9 Teach Location Window

1 - [Teach Sequence Base Angle]

Diection Actions Sample Vaguum Stulus_Blob Help

Step 4 Click on the
appropriate rotation (theta)
button to rotate the stage
and align the video image
with the screen crosshair.

5. ALTERNATIVE to steps 3. and 4.: To align the current sample surface with the
screen crosshair, use the principles described in BEGIN Align Sample Procedure
on page 12-18. Use a horizontal feature on the sample surface in place of the
dotted line on the Stylus Alignment Tool described in the procedure.

6. Click OK to return to the Sequence Editor window.
Notice that the Base Angle now has a value instead of the phrase Not Used.

When running a sequence with a non-zero Base Angle, the stage rotates to that
position immediately before deskew (if applicable).

NCE RECIPE

A sequence allows the user to assemble a series of scans that can be performed on a
single scan position or on multiple scan sites on a sample. In a production
environment, the sequence can be set up to run multiple sites on multiple identical
samples. The sequence recipe can be created for many different scenarios. The
following procedure progresses through the creation of a sequence recipe that
includes die grid navigation, a necessary ingredient for scanning multiple dies on a
sample.

This procedure assumes that no wafer is currently present on the measurement
chamber table/chuck.

1. From the Catalog screen, click on the Sequence Recipe button to display scan
recipes in the Information Display Window.

0104396-000 AA
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Step 2 Click on Sample in
the menu bar to display its

T
menu. / 7 7

Step 3 Click on Manual
Load to bring the stage to
the stage door.

Step 1 Click on the
Sequence Recipe buttonto\‘ Sequence
display the Scan Recipe

Catalog screen.

2. To load a sample, click on Sample in the menu bar at the top of the screen to

display its menu. (See Figure 7.10.)

Figure 7.10 Sequence Recipe Catalog Screen

Vacuum Hgst_ Diagnostic  Tasks Help

teed ol I e 0 2 ol

Sequence Recipe Name:
|CORS_sEQ

1 : ; Sequence Created By Creation Date
Scan | TN,

Sequence
Data

3. Choose Manual Load from the Sample menu. The sample stage moves to the

stage door.

4. After the stage stops, open the stage door.

& CAUTION: Wait until the stage has completely stopped moving before

attempting to open the measurement chamber door. If it is open when
the system is in movement, the profiler software does not operate
because the interlock switch stops all the stage and elevator motors.

5. Place the patterned wafer on the stage paying close attention to the orientation of

the wafer. The die grid should be as square with the stage X-Y-axis as possible.
It is best to use a precision locator to place the wafer securely and squarely on
the stage. Otherwise, if the system has to deskew the wafer very much,
measurements and pattern recognition could fail later.

6. Turn the vacuum on using the switch on the upper left door frame.
7. Close the measurement chamber door.
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End: OPTIONAL Manual
Wafer Load Procedure

Step 9 Click on the
Sequence Recipe button to
display the Sequence listin
the display window.

Step 10 To open the
Sequence Editor for a new
recipe, click on the NEW
button at the bottom of the
screen.

\

&

After the door is closed, click on Sample in the menu bar, then on Manual Load.
The stage moves back under the measurement head.

Figure 7.11  Scan Sequence Catalog

Profiler - [Catalog] [x]
FEile Edit Sample Yacuum Host Diagnostic Tasks Help

18] sl (& sl o]

Sequence Recipe Name:

&

Ve

Scan 4
Recipe &

Sequence Path: Created By Creation Date Time

[ypwy-me-dd)

(£ SEQRCP MO7 077 2000-01-23 14:32 oEn

SD“" IKHO71348 200G-01-21 10:33 ao
= REPEAT 2000-01-23 10:37

2000-01-23 11:26

REPEAT2D

Sequence
Recipe

Sequance
Data

(R

View/Modity sTeRT |

Clear Status |

|SEQUENCE RECIPE CATALOG [Sample?

Click on the Sequence Recipe button to change to the Sequence catalog list. (See
Figure 7.11.)

From the Sequence catalog, open a new sequence by clicking on the NEW button
at the bottom of the screen. (See Figure 7.11.)

The Sequence Editor opens, formatted to create a new sequence recipe. (See
Figure 7.12.)
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e

Step 11 Click on Sequence
and then on Save or Save As to
display the dialog box for saving
and naming the sequence.

11.
12.
13.

Figure 7.12  Sequence Editor for NEW Recipe with Pattern Recognition

[ Prafiler - [Sequence Editor - *UNTITLED==]
1§equence \);dil Sample Vacuum Deskew DieGrid Diagnestics Help
D & |E| &| sl

Recipe name: Ic: ‘eagle\SCANRCPintel mask\15UMZED

Loc Recipe X ¥ Theta X-Off Y-Off
[Video Calibration 2.78 2.86
Bovse.._| 2345 | ol angle -0.57
15UM2ED Change > Des ite 1 HOT VALID
— " | [Deskew Site 2 NOT VALID
Edit Recipe... |
SelectAll I
Auto Verify... I
Delete |

~ Options
™ SemiAutomatic Mode

Mode: |Pattem Recog. Deskew ¥
IfFail: |Proceed Measurement ¥

Data... I
Sort... | Sort is inactive
Die Grid Ensbled:mos13 die Reguiar Scan I TeachLos. el |
Wi Anass | Test 5= Frey itz | EdtR et |

Sample [Clcar Status |

Click on Sequence in the menu bar to display its menu. (See Figure 7.12.)
Click on Save or Save As to name and save the sequence.

The Save Recipe dialog box appears. Type in the name of the new sequence and
click on OK to save it.

Linking a Die Grid with a Sequence

When linking a die grid with a sequence, it is better to link it while creating a new
sequence recipe rather than to associate a die grid with an existing recipe that uses the
same recipe sequence. Use the following procedure for linking a recipe as part of the
creation of a new recipe.

1.

To use a die grid, Pattern Recognition Deskew must be in place. To tie the
deskew process to pattern recognition, use the following procedure. In the
Options box located in the lower left corner of the Sequence Editor, click on the
menu arrow next to the Mode field.
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2. Click on Pattern Recog. Deskew... (See Figure 7.13.)

Figure 7.13  Options Section in the Sequence Editor

— Options
™ Semi-futomatic Mode

Step 1 Click on the menu

arrow for its menu.
—\
Mode: |Mo Deskew:

T Mo Deskew

Step 2 Choose Pattern IFFail | el Doskew
Recog. Deskew.

< vl

Sart... I Sort is inactive

Begin: Load Die Grid 3. This sequence is being set up to work on a particular wafer with a set die grid
that is to be measured. The sequences must be connected to the Die Grid for
scanning and navigational purposes.

Die Grid Navigation with single scans requires loading the die grid at the
beginning of each scanning session. With sequences, a die grid can be associated
with a sequence, so that it loads and aligns the wafer automatically when
teaching sites for the sequence. The die grid can also be disassociated if the
sequence no longer requires Die Grid Navigation.

For additional information about the use of Die Grid Navigation, see Using Die
Grid Navigation on page 5-19.

* NOTE: Whenever possible, load a die grid before teaching any sites;
because it invalidates all currently taught positions.

Ensure that the wafer on the stage has the same pattern as that of the die grid
being loaded.

Q CAUTION: It is very important that each wafer is placed in the same
orientation that the die grid was taught in. If not, the system cannot
locate the dies. When placing the wafer in the system, it is best to use
a precision locator to place the wafer in the proper orientation.

4. In the menu bar, click on Die Grid to display its menu. (See Figure 7.14.) If Die
Grid is grayed out in the menu bar, the Safe Area might be incorrect. Set the Safe
Area in the Configuration screen to the size of the wafer being used. See Safe
Area Configuration on page 11-21.

Figure 7.14  Die Grid Menu

Die Grid Step 5 Click on Load... to display
Step 4 Click on Die Grid/ fssociate Diss... | the Load Die Grid dialog box
in the menu bar to Lood / overlay on the XY View screen.
display its menu. ._I'gru /Update Sequence...
[Elear
[ Fifiai..
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5. Click on Load... (See Figure 7.14.)

Figure 7.15 Load Die Grid Dialog Box

Load Die Grid EHE

Lookin: |3 diegrid = o =

@ anna.die
Step 6 Double-click on ] e
the name of the die grid Step 7 Click on Open to
to be used. open the die grid.

File name: Iseq_tst.die m

Files of type: |Die Grid files [*.die) j Cancel |

This displays the XY view screen with the Load Die Grid dialog box
overlay. (See Figure 7.15 for dialog box.))

6. Inthe Load Die Grid dialog box, double-click on the name of the die grid to be
used. This displays the die grid name in the File Name display box. (See
Figure 7.15.)

7. Click on Open to load the die grid. (See Figure 7.15.)

The system nulls the stylus and begin to search for the pattern that is displayed
in the sample navigation window. After it successfully locates the test pattern,
the die grid is loaded.

& CAUTION: The die grid must match the die grid pattern on the wafer
that has been loaded. If not, the die grid feature cannot be found and
the die grid does not load.

8. A warning message box appears warning that adding the die grid to the recipe
changes the base angle and can invalidate deskew and measurements sites. Since
this is a new recipe and the site have yet to be determined, click on OK. (See
Figure 7.16.)

Figure 7.16  Sequence Editor

Sequence Editor [ x|
Step 8 Read the ) - : -
warning and click OK l-"j ! Ii::s .dle grid will change the baze angle, which may invalidate deskew and measurements
to close it.

_

Cancel I

End: Load Die Grid 9. In the Sequence Editor, save the Sequence Recipe by clicking on Sequence to
display its menu, then on Save.
Begin: Teach Global 10. This procedure is designed to set up the pattern recognition that allows the
Pattern Recognition Sites system to recognize the current wafer as related to the die grid and to perform a

deskew procedure on to align the wafer with the X- Y-axis.
In the Sequence Recipe Catalog screen, click Deskew Site 1. (See Figure 7.17.)
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11.

Step 10 Click on Deskew Site 1. ~_|

Step 11 Click on Teach Pattern.

After the pattern is taught, repeat
the procedure for Site 2.

12.

Step 15 Use the
click-and-drag process to
draw a box around the
feature to be used for

pattern recognition deskew. \

(The video image is not
visible in this illustration but
would be present on the
actual screen.) The box is
drawn around the feature
that is displayed in the
Current Patt... box.

\ . i

The Teach Pattern button at the bottom of the screen becomes active. (See
Figure 7.17.) Click the button to begin the Teach Pattern procedure for Site #1.

Figure 7.17  Sequence Editor

Profiler - [Sequence Editor - CORS_SEQ] X
Seguence Edit Sample Yacuum Deskew DieGrid Diagnostics Help
0|2 | | & | sl
in Recipe Catalog: Recipe name: I
Type: Com 12D 13D Loc Recipe X Y Theta X-Off Y-Off
e I Video Calibration NOT CALIBRATED
f Base Angle NOT USED
h Des ite 1 —2282 0.00
ﬂl Deskew Site 2 -3046 2579  0.00
. . 1 _COARSE 0 0 0.00
EdtRecie | | 5 “coaree 0 0 0.00
3 _COARSE Multi Analysis
Select Al |
Aoteerify...
Delete
-~ Dption:
™ Semiutomatic Mode
Mode: |Pattem Recog. Deskew 'I
If Fail: |Retry Pat. Rec. Manually 'I
Data... I Hander... |
Sort... I Sort is inactive
IHeguIal Scan = Teachloc... Teach Pat... Edit%,Y.Theta..
MultiAnalysis | Test Wse BreviSite Editky mffsets.
Clear Status |
Clear Status |

The Pattern Rec. Deskew Teach: Site 1 screen is displayed. Click on a die in the
upper left quadrant of the sample navigation grid. the dark (blue on the screen)
rectangle has been chosen in Figure 7.18.

Figure 7.18 Pattern Rec. Deskew Teach: Site 1 Screen

{E& Profiler - [Pattern Rec. Deskew Teach: Site 1] <

View DieGrd Move Direction Actions Sample Yacuum Magnification Stylus Blob  Help
sanlum rst| T[] |4—|—> ) Ol Sy F"i':"sl Zons zgﬂ strl v:—l L“u‘:‘n'llal

Step 12 Click on
a die in the upper—
left quadrant.

The location of the
feature is indicated
in the die navigation
box. —_— O

Step 16 Click OK
when satisfied with
the feature and die

Die size
®

. : 5798.81 pm
location. Vi 373462 ey |
e 0K l Canﬂ:ll

Clear Status |
Pattern Rec. Match Score = 76.0% |Empty? Clear Status |
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End: Teach Global Pattern

Recognition Sites

Begin: Setting Deskew
Options

Step 25 Click on OK
when all settings have

13.

14.

15.

16.
17.

18.

After the die in the upper left quadrant is clicked, the system moves that die into
view in the video window. Click on FOCUS in the tool bar to bring the die into
clear focus.

Use the arrow buttons in the tool bar to move the field of vision to a feature in
that die that is used for centering the die and aligning the wafer. It is best to use
the same feature that is used in the die grid. (See Figure 7.18.)

After locating the feature, use the click and drag procedure, starting from the
upper left corner of the feature, to draw a rectangle around the feature. When the
box is complete, the system centers it in the X-Y-grid and a replica of it is
produced in a box on the screen. The die navigation box, under the die grid
navigation grid, now contains a small blue box indicating the position of the
feature with respect to the die boundaries. (See Figure 7.18.)

When satisfied with the die position and the feature, click on OK.

Repeat Step 10 through Step 16 for Site 2. For a location, choose the lower right
quadrant, at approximately the opposite die position, at an approximate 45°
angle through the center of the die grid from the first die.

Deskew Options set the number of groping Layers, set the maximum and
minimum percentage match for identification of a feature, and offer the ability
to turn on or off Deskew Twice and Image Processing options. (See Using
Groping with Pattern Recognition on page 7-44.)

Click on Deskew in the menu bar and then on Options... to display the dialog
box. (See Figure 7.19.)

Figure 7.19 Deskew Options Dialog Box

Deskew Options Xl Step 24 Click in the
check box to change
Perform Deskew Twice to Align Theta v the current settin g.
— Pattern Rec. Options
Mo. of Groping Retry Layers: |1 [8 Sitesz) 'I - Step 19 Click on t_he
menu arrow and click

Lowest Match Score [0--100%]: on the desired

|4D %
Max. Scaore to Stop Groping [0--100%): |55 § groping layers (sites)
] |

Edge bazed Pattern Rec. \ Step 20 Double-lick

been set and confirmed. \ Save/Apply Video Settings: | | in the variable box

19.

20.

21.

S and enter the
0K | Cancel | percentage.

Set the No. of Groping Retry Layers by clicking on the down-arrow and then
clicking on the desired number of layers and sites. (See Using Groping with
Pattern Recognition on page 7-44 for more information on groping layers.)

Set the Lowest Match Score by double-clicking in the variable box and typing in
the new percentage. (See Figure 7.19.)

Set the Max. Score to Stop Groping by double-clicking in the variable box and
typing in the new percentage. (See Figure 7.19.)
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End: Set Deskew Options
Begin: Set Data Options

End: Set Data Options

22.

23.

24.

27.

28.

To enable Edge Based Pattern Rec., click to put a check in the checkbox. (See
“Edge Based Pattern Rec.” in Table 7.12 on page 7-46.)

To enable Save/Apply Video Settings, click to put a check in the checkbox. (See
“Save/Apply Video Settings” in Table 7.12 on page 7-46.)

If desired, click to put a check in the check box for Perform Deskew Twice to
Align Theta to enable it. (See “Perform Deskew Twice to Align Theta” in Table
7.12 on page 7-46.)

Click on OK when all the parameters have been set.

Data Options are explained in detail beginning in Step 2. on page 7-10, in
Editing the Options Field in the Sequence Editor.

Click on Data... in the Options section in the lower left corner of the Sequence
Editor. This displays the Data Options dialog box.

The Data Options dialog box appears. (See Figure 7.7.) Once set, the Profiler
automatically either exports, saves, or prints the file data.

Figure 7.20 Data Options

Print Options [ x|

— Save Dptions — Export Dptions
= None & None @& ASCI File
" Statistics only " Statistics Only ¢ Binary File
Trace Data Trace Data
and Statistics and Statistics
" UseLotlD  UseLotID

Step 28 When the
options have been
chosen, click OK.

& Use Name: ICDHS_SEQ
Path... |

c\eagleseqsummbdb

& Use Name: IEDHS_SEE!

™ and use lot 1D for statistics name

™ Use Dperator ID /
r— Print Options

[ Enable Auto Print
Print: Cancel |
Details... I

™ Use Operator ID

Set the options according to the scan sequence requirements. (See Step 2 on
page -10 through Step 4 on page -11, in Editing the Options Field in the
Sequence Editor.)

Click on OK when options have be set.
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29. Save the Sequence by clicking on Sequence to display its menu, then on Save.

Figure 7.21  Sequence Editor Set Up for New Recipe

Profiler - [Sequence Editor - **UNTITLED>*]

Sequence Edit Sample Yacuum Deskew DieGrid Diagnostics Help

D & |E| & | s

Scan Recipe Catalog: Recipe name: [FIRST
“2 3 Loc Recipe X ¥  Theta X-Off Y-Off
290k M=50... =t Calib: 1.16 1.15
300x5000 BQS?MZQ rarien -0.38
SRR Deskew Site 1 -41929 55988 -0.38
yanga» I Deskeuw Sit 39250 40020 —0.38
PIEZO_60 SRl 2 SECOND NOT DEFINED
PIEZ0_S0
. SECOND

The Sequence Editor comes up TEST Selectal_| \/

with no recipes listed. Use Step Autoeity.. |

30 to create a sequence of Dokt | When the recipe is added, it

recipes: - Options

1. Highlight a scan recipe.
2. Click on the Add button.

™ SemiAutomatic Mode

Mode: |Pattem Recog. Deskew ¥
If Fail: |Skip, No Measurement ¥

appears in the list with the
scan location parameters
displayed as NOT DEFINED.

3. Repeat Steps 1 and 2 for

Data... I Handler... I
each additional recipe. sot. | Satiiactve
Die Grid Enabled:seq tst.die Regular Scan - Teach Loc... Teach Pat... I EditXY.Theta...
BultiArlysis | Test Use Prev Sitz | Edit oy Offset
Clear Status |

[Empty? Clear Status |

Adding Scan Recipes 30. The Sequence Editor appears with no scan recipes in the Sequence list. Add the

required recipes to the sequence using the following procedure: (See
Figure 7.21.)

a. In the scan recipe list, click on the first recipe to be included in the
sequence. It highlights when selected.

Click on the Add button to add the recipe to the sequence.

o

Repeat this procedure for every scan recipe that is to be added to the
sequence.
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Begin: Teach Scan 31. In the Sequence Editor, click on the first scan recipe in the sequence. It
Location highlights when chosen. (See Figure 7.22.)

Figure 7.22  Sequence Editor - Teach Scan Location

Profiler - [Sequence Editor - **UNTITLED>*]

Sequence Edt Sample Yacuum Deskew DieGrid Diagnostics Help
D|&|B| & | sarr

Scan Recipe Catalog:

Recipe name: [FIRST

Step 31 Click on the first S 2 O3 Loc Recipe X ¥ Theta X-Off Y-Off
e ICK On the Tirst Scan 290MM<50... [Video Calibration 1.16 1.15
P e 300<5000 Base Angle -0.38
Recipe so that it highlights. ~ ———1anaz Deskew Site 1 —41929 55988 -0.38
Change > | Inesrev Site 2 39250 -40020 -0.38
ok TEST —
FIEZ0_60 Ed'“:“3'3""’--1 2 SECOND NOT DEFINED
SECOND
TEST Select All I
Auto Veify...
[arm. | Step 32 When the first
_ Dok | Scan Recipe has been
Lt chosen, click on the Teach
™ Semi:Automatic Mode Loc button to begin the
Mode: |Pattern Recog. Deskew ¥ TeaCh procedure
If Fail: |Skip, No Measurement ¥
Data... I Hander... I /
Sort... | Sort is inactive
Die Grid Enablec:seq tst.die Regular Scan - < Teach Loc... ’ Tieach Pat.. EditXY.Theta...
bl srclysis | Test EEFEVEE ity Ottt
Clear Status |

[Empty? Clear Status |

32. Click on the Teach Loc button at the bottom of the screen.

The XY view screen appears and the system proceeds to null on the sample
surface. It then searches for the feature in the die. When it is found, the scan path
indicator is displayed over the feature. (See Figure 7.23.)

33. The die grid is visible in the sample navigation window with the die navigation
box below it. During a scan sequence, the system uses the Pattern Recognition

Deskew to situate the wafer. It begins with the top left die and moves to the
bottom right die.

Choose a die that is close to the bottom right die. If there is a preset pattern for
checking the dies, choose the die closest to the bottom right die. It becomes a
starting point for the sequence following the Associate Dies procedure.

34. Find the feature in the die that is to be scanned using the first recipe. Click in the
relative position in the die navigation box to move the feature close to the field
of view. Use the arrow buttons to move the feature into view. Click in the
relative position in the die navigation box
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Step 34 The Teach Location
screen displays the sample

surface under low magnification.

Position the scan path across
the chosen feature.

Step 35 Position the scan
path indicator over the
portion of the die that is to be
scanned by the recipe in the
sequence. Use the arrow
buttons to move the field of
vision and locate the scan
location.

Step 36 Click OK when the
scan path indicator is properly
placed.

Figure 7.23  Teach Location for First Recipe Scan

Step 33 Choose a die close to the bottom right die used
for Pattern Recognition Deskew. If there is a set die
checking scheme, choose the one closest to the bottom
right die as a starting point for the sequence.

{8 Profiler - [Pattern Rec. Deskew Teach: Site 1 [Die Grid: mos13] [RecipeName: _HA_COARSE]] \gﬂ

View DieGrd Move Diection Actions Sample Yacuum Magnification Stwlus Blob Help

sonl weo st 1 L [e=]=| O] B[] ina| | (@ \@ |
] i -|v| :-. a0 e T B A | == e N ]

Die Die size

X: 37241.72 um X:  1168.26 m X:  6798.81 m
T =22771.24 pm Y: 10544.86 pm T: 13714.6Z pm

Z: 46365.65 1w diameter

8: -0.38 deg 200 um 0K | Cancel

Clear Status |
_Clear Status |

F’aﬂem Rec. Match Score = 80.2% [Empty?

The die navigation box can be used to position the scan for
the recipe. Click on the place in the die where the scan
feature resides. The video image displays that position.

35. After the feature is centered in the video window, position the scan path
indicator over the feature in the die that is to be scanned using the first recipe in
the sequence. (See Figure 7.23.)

36. When the scan path indicator is correctly positioned, click on OK. (See
Figure 7.23.) The screen changes back to the Sequence Recipe screen.

In the Sequence Recipe screen, there are now coordinates next to the scan recipe
which describe the location of the scan path in the die for that recipe. (See
Figure 7.24.)
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Figure 7.24  Sequence Editor

[ Profiter - [Sequence Editor - VG_SEQ]

Sequence Edif Sample Yacuum Deskew DieGrd Diagnostics Help

™ Semi-Automatic Mode

Mode: |Pattem Recog. Deskew | ¥
If Fail: |Skip, No Measurernent ¥

recipes that it uses. Both
have the scan locations
taught as indicated by the X,

D& |d] &) |
Scan Recipe Catalog: Recipe name: IBLIM
“2 3 Ioc Recipe X Y Theta X-Off Y-Off
290ktaR50... Video Calibration 1.16 1.15
3005000 Base Angle -0.38
e o | [peskev Site 1 -41929 55988  -0.38
FIRET " | |peskew Site 2
JOETEST
PIEZO_B0 Edit Recipe...
PIEZ0_90 —I
SECOND
TEST Select All I
Aufo Verify... I
Delete |
oo This scan sequence has two
~ Options

baa. | Handew. | Y, and Theta coordinates.
Sort... | Sort is inactive
P B [Femsen =] Teach Lo TeachPain | EditXY,Theta...
bl rclysis | Test Use Prev Site | Edit % Bffseto,
Clear Status
[Empty? Clear Status |

37. Repeat Step 31 through Step 36 (Teach Scan Location) for each recipe in the
sequence. Be sure to use the same die as that used to teach the first location.

Associating Dies with a Sequence Using Die Grids

After a die grid has been associated with the scans in a sequence, it is possible to
associate other dies on the same sample with the scans using the die grid. This creates
a longer sequence in which additional scan locations on the sample are scanned

automatically, using validated scan locations.

Use the following procedure to associate dies with the sequence scans using die grids.

1. Ensure that the procedure in Linking a Die Grid with a Sequence on page 7-16

has been completed for the sequence being used.

2. From the Sequence Editor highlight the recipe that is to have additional dies

associated with.

3. Click on Die Grid in the menu bar. (See Figure 7.25.)
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Step 3 Click on Die Grid in the
menu bar to display its menu.

Step 4 Click on Associate
Dies... to begin the process of
choosing new scan sites.

click on Die Grid to
display its menu.

4. Click on Associate Dies... (See Figure 7.25.)

Figure 7.25 Sequence Editor with Die Grid Menu

[ Profiler - [Sequence Editor - VG_SEQ]

Sequence Edit Sample Vacuun D |

Gl Diagnostics Help

EEIIEEE De: |
) Load...
Sean Recipe Catalog: FigaiE name: F Align / Update Sequence...
“ O3 1 Clear X ¥ Theta X-Off Y-Off
Z30MMRED... [__Info... 1.16 1.15
3005002 Base Angle -0.38
e o | [peskev Site 1 -41929 55988  -0.38
A " | |peskew Site 2 39250 0.38
JOETEST = 7
PIEZO 60 Edit Recipe... |
PIEZO_30
SECOND
TEST Select Al I
Auto Verify... I
Delete |
~ Options
™ Semi-Automatic Mode
Mode: |Pattem Receg. Deskew ¥
If Fail: |Skip, No Measurement ¥
Data... I Hander...
Sort... | Sort is inactive
Die Grid Enabled:seq_tst.die Regular Scan eachlios, Tieach Pat.. I EditX,Y.Theta...
i &nalysis Tiest Wse Prev Gite I Edit%r Offset
Clear Status |

[Empty? Clear Status |

This displays XY screen titled “Associate Dies With Sequence Scan Sites,” with

a graphic display of the die grid configuration, visible to the right of the video
display area. (See Figure 7.27.)

If the die grid comes up with the dies already chosen, click on Die Grid in the
menu bar.

Choose Clear. This takes out all the old dies and leaves only the one that was
used for teaching the current recipe locations. It has the number 1 in it.

Figure 7.26  Die Grid Menu

Step 5 Inthe menu bar, ——p» Step 6 Click on Clear
Associate Dies... / to remove the
Load... .
Alige oggonee—] unwanted dies from the
die grid.

7. Each rectangle on the die grid configuration represents a single die. The green

one with the number one (1) in it represents the original scan site designated for
the chosen scan recipe. To add dies, simply click on the desired die where the
additional scan is to be made. Each successive site turns green and contains a
number.

* NOTE: The scans are performed according to the die site numbers.
To reduce sequence timing, choose the scan sites in a circular fashion

for minimum time of travel between scan sites. (See Figure 7.27.)
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Step 9 Click on OK to add
the additional selected sites

to the scan sequence. \

Figure 7.27 XY View with Sequence Scan Sites

8 Profiler - [Aszociate Dies With Sequence Scan Sites]

View DieGrid Move Dieclion Actions Sample Vacuum ion Stz Blob el

o[ vr| 111 [=]2] OIQ| D¥ | h[[@ @

Step 7 The original die being
scanned is the number one die.
Click in each successive
rectangle representing a die that
is to be added to the sequence
using the die number one scan.

Step 8 When all the required
dies have been selected, click
on OK to add the new sites to
the scan sequence.

[m]
Wafer coordinates Die coordinates Die size
X: 40250.31 pm X: 4176.85 pm X: £798.81 pm +
Y: -30011.17 pm i 3304.93 mm 7:  13714.6Z pm
Z2: 46365.65 pm Wafer diameter
8: -0.38 deg 200 mm 0K I Cancel
Clear Status |
Stage move is outside of safe areal |Empty? Clear Status |
* NOTE: Dies can be selected or deselected by clicking or them.
8. After all the required dies have been selected, click on OK to add them to the
sequence. (See Figure 7.27.)
9. The Sequence Editor message box appears with a message saying that the

chosen sites will be added to the sequence, asking whether to proceed with the
additions.

Click on OK to continue or Cancel to abort the addition of the sites to the
sequence.

Figure 7.28 Sequence Editor Message Box

Sequence Editor [ x|

& Mew scan steps will be added to the sequence. Proceed ?
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When OK is clicked, the Sequence Editor is displayed with the additional sites in
the Sequence Recipe.

Notice that each new site has the coordinates of the scan location for that die. In
the illustration Figure 7.29, two sets of new sites have been added, one for
additional dies using the scan named FIRST, and one for dies using the scan
named SECOND.

& CAUTION: The coordinates presented for the scans in the new sites
might not be exactly where they are needed. It is important to verify
each of their locations.

Figure 7.29  Sequence Editor with New Scan Sites

Profiler - [Sequence Editor - **UNTITLED>*]

Step 10 The new scan sites Sequence Edif Sample Yacuum Deskew DieGrid Diagnestics Help
Dle(@] 8w
are presented below the = 8|6 ]
.. . . . Scan Recipe Catalog: Recipe name: |FIRST
original on.es in the recipe |I.S.t. c22 CD Loc Recipe X ¥ Theta X-Off Y-Off
Each has its own scan position 230D, Video Calibration T16 115

S0n¢5000

coordinates listed. Highlight the ANiA2D e By

ANNAZD2 o 1 FIRST 263 16273 —0.45
i — SECND B
entire group of new scan A _ 1
. . . PIEZO -
locations by clicking on the first —

one, then hold down the shift TEST Select Al
key and click on the lastone. ——+—

/ 2&‘&'
sy

.....

Step 11 After all the new / ™ SemiAutomatic Mode

recipes are highlighted, click on Eadey[No Decken =l
- ail: K
the Auto Verify button. e | B

Data... I Hander... I
Sort... | Sort is inactive

Die Grid Enabled:seq_tst.die Regular Scan Teach ot Tieach Fat | EditsoThets
Ut Aralysis Tiest Wse BreviSite I Edits v iffset
Clear Status |

[Sample? Clear Status |

Begin: Auto Verify 10. Highlight the entire group of new scan sites by clicking on the first one, holding
the shift key down and clicking on the last one.

11. Click on the Auto Verify button to begin the process of verifying each scan
location.

12. The XY view screen is now displayed. The system moves the field of vision to
each scan site and displays the site with the scan path positioned as it is during
the actual scan. Adjust each site individually using the following procedures:

a. The feature being scanned should be visible in each site. If not, locate it.

b. Ensure that the scan path indicator is positioned correctly. If it is not, move
the cursor to the exact location where the scan is to begin and click. The
system should adjust the scan position on the screen.

c. When complete, click on OK to verify that location. The next site appears
on the screen automatically.
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End: Auto Verify

d. When the last site is verified, the screen reverts back to the Sequence
Editor. Save the Sequence by clicking on File and Save or Save As.

e. A dialog box appears. Enter the name of the new sequence and click OK to
save it.

Disassociating a Die Grid with a Sequence

1.
2.
3.

Make sure the sequence is displayed in the Sequence Editor
Click on Edit to display its menu.
Select Clear Die Grid.

RUNNING A SEQUENCE

1.
2.

CORRELATION SCANS

Click the Start button, or click the Sequence menu, and select Start.

Perform manual deskew, if applicable. Also, refer to manual deskew section for
explanation of how to do this.

Click the Stop button to stop the sequence before normal termination.

Scans are correlated when a long scan is performed first, then small scans are
performed in the same general location. Correlation scanning combines local area
scans with macroscopic scans so that discrete features can be related to global surface
planarity.

From the scan data of a long scan, distinct features can be located which require a
repeat scan at high resolution, then create a sequence that performs high resolution
sub-scans along the length of the long scan. Data for each sub-scan is based on the
long scan, providing a data reference for correlating the measurements of the
sub-scans.

1.

2.
3.
4

Open an existing Sequence recipe or create a new one in the Sequence Editor.
Select the recipe to use for the long scan (one that traverses the targeted feature).
Click the Scan Type arrow below the sequence to open the list.

Click the Correlation Long Scan button.

A message dialog box appears, warning that the recipe immediately following is
designated a Correlation Sub-scan and if it is set up for multiple analysis, it
resets to single scan. The Sub-scan is the short scan that is tied to the long scan.
It provides the local, small-scale analysis. It is set up in step 7, next page.

* NOTE: Multiple correlation scan sets can be established; each set is
marked by the initial long scan in red lettering and its associated

sub-scans immediately following in blue.

5.

Click OK.

The long scan recipe becomes red; the recipe immediately following becomes
blue, indicating that it is a sub-scan to that long scan. Sub-scans always follow
long scans in sequence.
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6.

The first recipe, the parent

long scan, is in red. —

The subscan recipes, the —]

correlation subscans, are
in blue.

10.
11.

12.

Designate the other sub-scans (usually 100 um or less) as done for the long scan,
using the Scan Type list to select Correlation Sub-scan.

Figure 7.30 shows the Sequence Editor for a correlation scan where the parent
long scan recipe is EXAMPLE, Loc is location 1. The sub-scans are EXAMPLE2,
Loc are location 2, location 3, and location 4.

Figure 7.30 Correlation Scan Sequence

k% Profiler - [ Sequence Editor - EXAMPSEQ]
Sequence Edit Sample Yactuum Deskew DieGrid Diagnostics Help

D& |E| & | s

Scan Recipe Catalog: FRecipe name: I
& 20 C 3D Loc Recipe bid ¥
Video Calibration 1.15
Base Angle NOT USED
1 EXAMPIE —40 1372 0.81

2  EXAMPLE2 -11 1373 0.00
3 EXAMPLE2 38 1375 0.00
4 EXAMPLE2 262 1377 0.00

Theta X-0Off Y-Off

Select Al

Butto ety |
Delete I

EXAMPLEZ

Teach the long scan position.
a. Press the Teach LOC button.

b. Go to the location and click on it. To accept the location, click OK in the
dialog box that appears.

Teach the sub-scan position.
a. Press the Teach LOC button.

b. Go to the location and click on it. To accept the location, click OK in the
dialog box that appears.

The Teach Sub-Scan window appears.
If the current position of the sub-scan is not close enough to the position of the

long scan for both to appear in the video image, a red arrow and the coordinates
of the long scan appears on the video image.

Move the stage in the direction of the arrow to bring the long scan into view.

The long scan is represented in the window by a red scan line; the sub-scan by
blue.

Position the sub-scan on the desired portion of the long scan line.
Click OK.

The Sequence Editor returns to view.

Repeat for all sub-scans.

Viewing the Correlation Scan Data

1.

Run the correlation sequence. Save the recipe and click Start.

The Analysis window appears, showing the results of the first recipe in the
sequence.
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2. Click the File menu, and select Correlation Scan.

The Correlation Scan dialog box appears.

3. Click the long scan

4. Click OK to display the Correlation Scan window.
The Correlation Scan window appears, showing the long scan trace and
thumbnail callouts of each of its sub-scans positioned on the long scan (see
Figure 7.31).

Figure 7.31  Correlation Sub-scan Window

i Cormrelation Scan: stepl

Sub-scan
/ thumbnail

flormal

400 430 499

5. Double-click the thumbnail on the graph to view the sub-scan trace.

The trace appears in its own analysis window. A Statistics window also appears
for the long scan.

6. Click the File menu, and select XXX to view the correlation scan statistics.

Multiple Analysis cannot be used with correlation scans.

VIEWING SAVED SEQUENCE DATA

Viewing Old Sequence Data

1. Go to the Catalog window, and click the Sequence Data button.

The Sequence Data Catalog window appears.

2. Select the data set from the list in the catalog, and click the Review button, or
double-click the desired data set.
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Recovering Sequence Data

In the case of a system crash during a sequence execution, using this recovery tool, it
is possible to go back to the screen that displayed the last data, including unsaved
data.

1. Go to the Sequence Data catalog window.

2. Select a sequence.

3. Click the Recover button.

Calculating Combined Sequence Statistics (Option)

Values from different sequence sets can be combined into one, and used to calculate
the standard deviation, mean, and so forth. The computer accesses stored data from
selected data sets in the Sequence Data catalog and recalculates them.

1. Click the Sequence Data command button in the Catalog screen.

The Sequence Data catalog window appears.

Highlight the data files to be combined.

Press CTRL while clicking to highlight multiple data files.

Click the Combine button.

Enter a name for the new combined data set.

Click OK.

A statistics summary with the new data appears after a short calculation interval.

o0k~

USING MULTI ANALYSIS IN SEQUENCE

Multiple data analyses can be obtained from a single scan by applying the data
analysis settings of additional recipes to its raw data. The process is a modification of
a sequence recipe in which the instrument uses the first scan recipe to scan and
analyze in the usual manner, then takes settings from the subsequent recipes to
reanalyze the first recipe’s scan data.

It is important to note that the raw data for the scan be saved and therefore can be
subjected to numerous different parameter adjustments. Each set of data that is
obtained from applying the new parameters can be save under its own name. This
means that after the scan is run and the results saved, the additional information can
be retrieved at a later date, even calculated on a desktop version of the software if it
has been purchased.

Time can be saved and throughput improved by using multiple analysis for:

¢ Measurements that require more than one cursor setting — such as two different
step heights on a single scan

¢ Measurements with different filter settings

¢ Measurements with different surface parameters enabled in the Scan recipe.

1. Go to the Sequence Recipe catalog window, and select a Sequence recipe.
2. Click the View/Modify button to open the Sequence Editor window.
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Click the New button at the bottom of the screen or click the Sequence menu,
and select New.

A blank sequence list appears.

Set up the scanning recipe to scan with its existing settings:
a. Click the name of the required recipe to be used for the scan.
b. Click Add to add the Scan recipe to the list.

To make changes to an existing Scan recipe.
a. Click its name in the list

b. Click Edit recipe to change any parameters and filter settings. Cursor
positions can only be changed by entering them numerically.

c. Save the recipe.
To teach cursor positions later from the scan trace:

Click Save As to create a new recipe even if no changes were made to the
recipe at this point.

f. Exit the Recipe Editor window to return to the Sequence Editor window.
g. Select the new recipe that was just created.
h. Click Add to add the Scan recipe to the list.

6. Set up the analyzing Scan recipes:

a. Go to the Scan Recipe catalog list, and click a Scan recipe containing the
required analysis settings.

This recipe should have the same scan length, scan speed, sampling rate,
stylus force, contact speed, and range as the scanning recipe.

b. Make changes to the Scan recipe as in Step 5b.
This step can also be performed before compiling the sequence list, using
the Scan recipe to scan the sample and teach the cursor positions.

C. Add the Scan recipe to the sequence list.

d. While the Scan recipe is still highlighted, click the Multi Analysis button.

This instructs the instrument not to scan the sample again but to reanalyze
the data according to the recipe’s data analysis parameters. Note that the
Multi Analysis button is not active (dimmed) for the first recipe in a
sequence.

e. Repeat the process as many times as needed.

7. Click the Sequence menu, and select Save As to save the sequence.

Viewing Multi Analysis Results

1.

Tile the windows to display the Sequence Parameter Summary window and the
Scan Trace simultaneously.

Go to the Sequence Parameter Summary window:
¢ Site 1 shows data analyzed with the first Scan recipe in the sequence list.

¢ Site 2 data corresponds to the second Scan recipe, and so on with each
additional site.

To view each Scan recipe’s data set in both Trace and Summary windows:
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a. Click the arrow in the Recipe drop-down menu on the tool bar.

b. Select the Scan recipe.

VIEWING SEQUENCE DATA

Recipe drop-down menu

Viewing Wafer Summary Data

The Sequence Parameter Data window displays the detailed results of each site
scanned in the sequence.

1. Go to the File menu in the Analysis window, and select Surface Summary.

Figure 7.32  Sequence Parameter Data window

File View Trace Operations Window Help -18] x|
[ExamPLE - &
Lot: EXAMPSEQ Sequence: EXAMPSED
Op: Recipe:  EXAMPLE
Deskew | Sample Stat | Anabze | Avesr | Pl | A3 | Bh | wa |  wp
Cassette Mean 0.01342 pr? 43351 pm 92954 71264 20844 669.4 A
5.D. 0k 0.00 pm 004 0.04 0.04 0.04
tin 0.01342 pr? 439351 pm 92954 71264 20844 669.4 &
Max 0.01342 pr? 49351 pm 92954 71264 20844 669.4 &
Range 04 0.00 pm 0.04 004 0.04 0.04
None Slat 10 Mean Inc 0.01342 pr? 43351 pm 92954 71264 20844 669.4 A
5.D. 0k 0.00 pm 004 0.04 004 0.04
tin 0.01342 pr? 439351 pm 92954 71264 20844 669.4 &
Max 0.01342 pr? 49951 pm 92954 71264 20844 669.4 &
Range 04 0.00 pm 0.04A 004 0.04 0.04
None Slot 10
Inc 0.01342 pr? 49351 pm 92954 71264 20844 669.4 &
Clear Status |

=== rTIeTsal

2. Maximize the Sequence Parameter Data window to view the entire Sequence
Parameter Data screen from the Analysis window.

3. Go to the Sequence Parameter Data window, and click on the Recipe drop-down
menu on the left of the toolbar. (See the Recipe location at the top left of
Figure 7.32.) This drop-down menu displays all Scan recipes that are included
in the sequence.

4. Choose the desired recipe by clicking on it.

Sequence Summary Options

The Sequence Summary Options dialog box specifies the information to be displayed
in the Sequence Parameter Data window. The individual scans in any sequence can be
viewed in the Analysis window by clicking the appropriate site number in the
Sequence Parameter Data window.

1. Open the Analysis window.
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2. Click the Operations menu, and select Summary Display Options to display the

Step 3 Click in the checkbox to

put a check in the option. That
item get displayed in the

summary screen. — P sie i

Step 4 Once all changes have
been made, click OK to activate

the changes.

I

Sequence Summary Options dialog box. (See Figure 7.33.)

Figure 7.33 Sequence Summary Options Dialog Box

Sequence Summary Options [ %]

— Display Selection:

V¥ Cassette Summary [V Deskew Field
¥ Slot Summary ¥ Analyze Field

— Digplay Order

& Cass. summary; Slot summary for all slots; Site list for all slats.

© Cass. summary; Slot summary followed by Site list for sach slot,

Cancel |

3. Choose the items to be displayed in the summary screen. A check in the box

4.

indicates those that are displayed. (See Figure 7.33.)
Click OK to activate changes to the summary display items. (See Figure 7.33.)

Viewing Sequence Data with the Corresponding Trace,
Site-by-Site

The screen can be set up to display a site’s parameter data along with the trace itself.

1.

2.
3.
4

Open both the Analysis and the Sequence Parameter Data windows.
Go to the Windows menu, and select Tile Vertically.

Size the windows by clicking and dragging their frames.

Display the desired trace:

a. Go to the Sequence Parameter Data window, and click the numbered Site
box of the trace desired.

The Analysis window displays the trace for that site.

b. Repeat for other sites, displaying each trace in turn.
Save the workspace:

a. Click the File menu, and select Save Workspace to save this window
orientation.

The dialog box appears.

b. Enter a name for the workspace.
c. Click OK to save.
To review both parameter data and the trace:
a. Click the File menu, and select Load Workspace to retrieve the workspace.
b. Highlight the workspace name in the drop-down menu.
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c. Click OK. The screen reconfigures to the desired trace/data window
orientation.

SEQUENCING WITH MANUAL DESKEW

The reason for programming a sequence is to automate a repetitive series of
measurements on multiple samples. The example contains all of the essential features
of a sequence.

Even with a locator or some sort of fixture, the second and subsequent samples cannot
reliably be placed on the stage in the exact same position, and with the same
alignment, as the first. The new sequence can still be used, but each of the scan sites
must be manually located and retaught before running the sequence.

Deskew enables and defines two points on a sample to be used as reference points
prior to the start of a sequence. These points are then used to mathematically correct
for translational (X, Y) and rotational (theta) error in sample positioning.
1. Create a new sequence.
2. When ready to set up manual deskew, proceed with the following steps.
3. Set the deskew mode to Manual Deskew.
Note that two deskew steps now appear in the sequence list on the right side of
the window.

4. Select the first deskew site by double-clicking anywhere on the Deskew Site 1
line in the sequence list.
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5.

11.

12.

13.

Click the Teach Loc button, or double-click the deskew site. The Manual
Deskew Teach window appears. (See Figure 7.34).

The two deskew points should be in opposite quadrants, with each being at least
half way to the edge of the substrate.

Figure 7.34 Manual Deskew Teach Window

Hode: XY

X B70 .00 pm

¥ 77000 pm

z ~59 75 im

) 0.00 deg

Zoon 0.00
_OK | Cancel|
_Clear Status |

®= = _Clear Status |

Select the first deskew point. Select an obvious point, such as the corner of an
easily and uniquely identifiable rectangle.

Click the chosen position.
The stage moves so that the crosshair are centered on the selected site.

Click OK.

The Sequence Editor window reappears, with the X and Y coordinates of the
selected site entered in the deskew Site 1 step.

Select the second deskew point.

Repeat steps Step 5 through Step 7 for the second deskew site.

Once the deskew sites have been successfully established, proceed to program
the rest of the sequence steps.

Run the sequence.
After each deskew operation, the instrument pauses and requests acceptance of
the deskew site.

If it is out of the field of view, use the arrow buttons to move the stage and
search for the site. Click on the deskew site, moving it to the center of the
crossmarks.

Click OK to accept the deskew site.
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14. Repeat Step 11 through Step 13 for deskew site #2.
The tool then proceeds with the measurement sites.

DESKEWING TWICE TO ALIGN THETA

With a single deskew operation, there is no stage rotation to compensate for the small
rotational error in sample placement. A second deskew can be performed to
compensate for this error by enabling this option in the Pattern Recognition and
Deskew Options dialog box. This allows accurate sample rotations within a sequence.

1. Go to the main Configuration window, and click the Pattern Recognition
Options... button.

The Deskew Options dialog box appears (see Figure 7.35).
Figure 7.35 Deskew Options Dialog Box

Pattern Recognition and Deskew Options [ %] Step 3 Click OK

— Pattern Recognition Options: ‘/ when all choices
are complete.
Mumber of Groping Retry Layers:
LCancel |

tinimum Match Score [%):
tinimum Score to Stop Groping [%):

Edge based Pattem Recognition: Step 2 Click in the

-
Save/hpply Video Settings: checkbox to enable
or disable the
Femw Seten deskew twice option.

i
i
-
.

Perform Deskew Twice to Align Theta:

<l

2. Click the Perform Deskew Twice to Align Theta? check box to enable or disable
the second deskew.

3. Click OK to set the options and close the dialog box.

SEQUENCING WITH PATTERN RECOGNITION DESKEW

(PATTERN RECOGNITION OPTION ONLY)
The Pattern Recognition option minimizes operator intervention in sequence operation
by automating the precise setting of deskew points at the beginning of a sequence.

Pattern Recognition deskew replaces and automates the manual deskew process. The
same considerations of global deskew point placement that apply to manual deskew
apply equally to pattern recognition deskew.

* NOTE: To minimize positioning error, space the deskew points at least
one-half the diameter of the sample. Do not set the deskew points

parallel to the X-axis or Y-axis, but instead use two points on a

diagonal line. If the deskew points are identical, the sequence aborts.
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* NOTE: Although a coordinate transformation is made, there is no
stage rotation to compensate for the small rotational error in sample

placement unless the deskew option is set to perform a second
deskew. See Deskewing Twice To Align Theta on page 7-38 for more

information.
* NOTE: Note also that any rotational error is magnified when
traversing a long distance across a large wafer. This might cause the

deskew site to be outside the field of view when a wafer is loaded.

A pattern recognition deskew site is a unique pattern of wafer features visible within
the instrument’s field of view. The size and shape of the pattern must be uniquely
different from other wafer features visible in the field of view to ensure that the
instrument can locate the sites without ambiguity. (See Table 7.10).

Table 7.10 Pattern Examples

Pattern Example

Description

Good Patterns

*

*

*

Alphanumeric characters

Circular or rectangular pads that appear singly
Crosses

Alignment marks

Other polygon shapes

Bad Patterns

Sections of a repetitive grid

Circular pads or rectangular pads that repeat in or near the
field of view
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When choosing patterns, keep the following points in mind. (See Table 7.11).

Table 7.11  Pattern Search Criteria

Search Criteria

Description

Search time depends
on pattern size.

The larger the pattern, the faster the system can recognize
the pattern. However, larger patterns require more accurate
initial positioning within the camera’s field of view because the
search area is reduced.

Also, Pattern Recognition options can be set so that the
system performs a pattern search if the pattern is not found
within the field of view. See Using Groping with Pattern
Recognition on page 7-44 for information.

When using
rectangular pads, use
the entire rectangle.

If only two corners are used, other rectangles in the field of
view could confuse the pattern recognition system.

The pattern should be | However, uniqueness cannot be sacrificed for simplicity.
unique and as simple

as possible.

Select symmetric They are less sensitive to image rotation. Circular patterns
patterns. are rotationally symmetric and therefore are good patterns.

Similarly, the best polygon patterns have the most sides.

High contrast features
make pattern
recognition matches
easier.

When available, select high contrast features. Noise does not
have as much effect on the pattern recognition match. The
pattern colors are important because the pattern recognition
system reads the black and white image, not the color image.

Avoid patterns with
rough surfaces.

By using edge enhancement, the instrument computer
emphasizes the fine features present on a rough surface.
Because roughness is random, these features add noise to
the system and make the pattern recognition system less
reliable.

* NOTE: It is generally a good idea to avoid fixed dust particles in the
field of view as well. Avoid selecting wafer-specific defects or features

as patterns, or the instrument computer could become confused. This
includes dust particles, partially etched areas near the edge of the
wafer, and so on.

To set up Pattern Recognition deskew:

1. Go to the Sequence Editor window.

2. Select the sequence recipe that is to have Pattern Recog. Deskew.

3. Select Pattern Recog. Deskew from the Mode drop-down menu. (See

Figure 7.36.)
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Figure 7.36  Profiler Sequence Editor Window
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to open the screen.

Clear Status |

4. Double-click the Deskew Site 1 entry near the top of the sequence list or
highlight the Deskew Site 1 entry. (See Figure 7.36.)
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5. Click the Teach Pat button. (See Figure 7.36.)

The Pattern Rec. Deskew Teach window appears and the stylus automatically
nulls on the sample surface.

Figure 7.37  Pattern Rec. Deskew Teach window
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6. Select a pattern to use for pattern recognition.

As a rule of thumb, select something that is simple and easily recognizable, like
an alphanumeric character or an alignment mark. (See Table 7.10 on page 7-39
and Table 7.11 on page 7-40.) Something that looks much like another feature
that is also within the field of view does not work reliably because the wrong
site might be identified.

7. Define a rectangular area that encloses the chosen pattern as follows:

a.

Press and hold the left trackball button at the top left corner of the desired
rectangle.

Move the trackball toward the bottom right corner of the desired rectangle.
A blue box appears that follows the trackball cursor as it moves.
When satisfied with the desired rectangular area, release the trackball
button.
The system processes the image information defined by the rectangle.
If the rectangle was too small or too large, a message dialog box appears
indicating that the rectangle was too small or too large:

i. Click OK.

ii. Teach the pattern again.
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8. The blue box remains on the window with a darker blue dot in the center.

The stage moves until the selected feature is centered in the crosshair
(Figure 7.38 on page 7-43).

Figure 7.38 Pattern Rec. Deskew Teach Window After Teach
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9. Move the stage a small distance.
10. Click Verify to test whether the system can accurately find the taught feature.
A box is drawn around the feature when it is found.

11. Ifrecognition fails, select another pattern and retry.
12. Click OK to accept the new pattern.
13. Repeat Step 2 to Step 9 for Deskew Site 2 to establish the second deskew point.

14. Once the deskew sites have been successfully established, proceed to
programming the rest of the sequence steps.

Due to the number of variables that affect pattern recognition, the computer
might not always be successful in locating a deskew site. The instrument can be
preset to do one of four things in the event of a failure:

¢ Continue scanning

¢ Stop scanning the wafer and proceed to the next scan site

¢ Repeat the pattern recognition

¢ Stop the entire sequence

15. Choose a Pattern Recognition Failure Response from the If Fail drop-down
menu. (See Figure 7.39.)
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Figure 7.39 If Fail Menu in Options Portion of Sequence Recipe Screen
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16. Run the sequence.

USING GROPING WITH PATTERN RECOGNITION

Introduction

Deskew Options can be set so that the system performs a pattern search if the pattern
is not found within the field of view when the sample is positioned at the deskew site.
This search is called groping. Note that these same parameters (in a slightly different
format and with slightly different wording for the Lowest Match Score parameter) are
available in the Pattern Recognition and Deskew Options dialog box in the
Configuration screen. (See Pattern Recognition Options and Deskew on page 11-29.)
The parameters set in the Deskew Options dialog box take precedence over those
from the Pattern Recognition and Deskew Options dialog box.

Access to the Pattern Recognition and Deskew Options dialog box is through the
Configuration screen’s Pattern Recognition Options... button. (See Patfern
Recognition Options and Deskew on page 11-29.) Access to the Deskew Options
dialog box is through the Deskew menu in the Sequence Recipe screen. Notice that,
the parameter, “Minimum Match Score” in the Pattern Recognition dialog box, has
not yet been changed to “Lowest Match Score” as it has in the Deskew Options dialog
box. The values set in the Deskew Options dialog box for each sequence recipe
override those set in the Pattern Recognition Options dialog box.

The three groping parameters are described in 7able 7.12.

Setup Procedure

1. From the Sequence Editor, click Deskew in the menu bar to display its menu.
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2. Click Options... to open the Deskew Options dialog box. (See Figure 7.40).

Figure 7.40 Pattern Recognition and Deskew Options Dialog Box
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3. Click on the Number of Groping Layers menu-arrow to display its menu. (See
Figure 7.40.)

4. Choose the number of layers from the menu. (See Figure 7.40. For information
on the groping layers see Table 7.12.)

5. Set the Lowest Match Score (%) by highlighting the current percentage and
entering the new one. (See Figure 7.40. For information on match scores see
Table 7.12.)

6. Set the Minimum Score to Stop Groping (%) by highlighting the current
percentage and entering the new one. (See Figure 7.40. For information on
match scores see Table 7.12.)
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7. Edit the fields by using the parameters described in Table 7.12.

Table 7.12 Groping Parameters

Parameter

Description

Number of Groping
Retry Layers

This parameter controls how much of the area around the
deskew site is searched for the pattern. Each layer consists of
a square area constructed by evenly surrounding the deskew
site with squares the size of the camera field of view. (See
Figure 7.41).

Figure 7.41 Groping Retry Layers

Groping 1st Retry Layer— 2nd Retry Layer
disabled searches for8 | searches for
searches only more square 24 more square areas
camera field of areas

view

3rd Retry Layer searches for 48 more squares; 4th Retry Layer
searches for 80 more squares. It stops after the 4th try.

Available choices are:
¢ None (the default)
* 1 (8 Sites)
¢ 2 (24 Sites)
¢ 3 (48 Sites)
* 4 (80 Sites)

* NOTE: It takes 10 s to move the stage, null the

stylus, and search one such area; 8 search sites
(1 layer of retry) takes as long as 90 s; and 24
sites (2 layers) takes as long as 250 s, and so
on.

First, the deskew site field of view is searched. If the pattern is
not found, the stage moves to one corner of the next layer
and searches the field of view there. This continues until the
pattern is found or until all search sites have been examined.
If the pattern is still not found, the stage moves to one corner
of the next layer and continues.
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Table 7.12  Groping Parameters (Continued)

Parameter

Description

Lowest Match Score

(Was changed from
Minimum Match
Score, which is still
the term used in the
Configuration
screen version of
this parameter.)

Lowest Match Score is used to compare all the groping
positions in the given groping levels. Once the groping stops
(assuming that the Minimum Score to Stop Groping is not
found) the highest score achieved, among those scores that
qualified for Lowest Match Score acceptance, is chosen as
the search pattern (model). This number must be smaller than
the Minimum Score to Stop Groping. Allowed values range
between 20 to 100%; the default is 65%.

This parameter allows adjustment of the threshold at which
the pattern recognition system concludes that it has found a
candidate for the desired deskew site.

Minimum Score To
Stop Groping

Minimum Score to Stop Groping defines a value at which the
system accepts the image as the model for which it is
searching. Groping stops if this score is reached and the
image corresponding to the score is considered to be the
search pattern (model).

EXPLANATION: If the pattern recognition system is groping
to find the desired pattern, frequently the matching pattern is
found with little ambiguity. If a score equal to or better than
the Minimum Score to Stop Groping occurs, the searching
process stops and the deskew site is placed. Allowed values
range between 20 to 100%; the default is 70%.

If no matches are found that are as good as this setting, the
search continues until all retry layer areas are searched. The
highest score above the Lowest Match Score setting
determines the placement of the deskew site.

Edge Based Pattern
Recognition

The Edge Based Pattern Recognition option is used for low
contrast image recognition on a sample surface or where
there is a large surface light variation. If this option is chosen
(with a check in the check box), the normal image contrast
grayscale processing takes place first, then a series of filters
are applied that further contrast and sharpen edges for a
better pattern recognition.

The image data is stored before these filters are applied so
the data is not effected by this option. It is strictly a tool used
for pattern recognition where contrast is low or where light
varies significantly.

If the option is not chosen, only the image contrast grayscale
processing is performed.

’t NOTE: When this option is enabled, the pattern

recognition process takes longer than if it is not
chosen. The filtering and sharpening procedures
require significant extra time.
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Table 7.12  Groping Parameters (Continued)

Parameter Description
Save/Apply Video The lamp brightness setting is important in pattern
Settings recognition. If the lamp brightness is different from when the

original sequence was established, the pattern recognition
images could be difficult for the system to detect. A check in
the Save/Apply Video Settings checkbox ensures that the
lamp brightness is saved with each deskew site pattern so
future scans have the same image view with the same light
for pattern recognition.

Perform Deskew With a single deskew operation, there is no stage rotation to
Twice to Align Theta | compensate for the small rotational error in sample

placement. By enabling this option in the Pattern Recognition
and Deskew Options dialog box, a second deskew is
performed to compensate for this error. This allows accurate
sample rotations within a sequence.

8.

Click OK to set the options and close the dialog box.

Groping Analysis (Condensed)

1.

The first field of view is searched for the model. If the Minimum Score to Stop
Groping is achieved, the image in the first field is chosen as the search pattern
(model).

If the Minimum Score to Stop Groping is not achieved in the first field of view,
the groping continues. Each position in every allowed groping level produces a
score. If that score is greater than the Lowest Match Score, but less than the
Minimum Score to Stop Groping, its score is saved for comparison with other
scores in case the Minimum Score to Stop Groping is not achieved during the
entire groping session.

If at any time during the groping session the Minimum Score to Stop Groping is
achieved, the image with that score is accepted as the search pattern (model) and
the groping stops. Any residual Lowest Match Score values are discarded.

If the entire groping session produces only scores greater than the Lowest Match
Score but less than the Minimum Score to Stop Groping, then the highest score
among the Lowest Match Score candidates is chosen as the search pattern
(model).

If no scores are obtained above the Lowest Match Score, then the groping
session pattern recognition search failed.

SEQUENCING WITH SITE-BY-SITE PATTERN RECOGNITION

Sometimes it is more effective to position a scan relative to a taught feature instead of
as arbitrary stage coordinates. Site-by-Site Pattern Recognition stores an offset from a
taught pattern for any scan in the sequence. The pattern must first be taught the
“home” feature, then teach the scan. With Site-by-site Pattern Recognition enabled,
the instrument stores the scan position as an offset from the taught feature.
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1. In the Options section of the Sequence Editor, click the drop-down button of the
Mode option. (See Table 7.5 on page 7-8.)

2. Click the Site-by-site Pattern Rec. option. (See Table 7.5 on page 7-8.)

3. Teach Pattern Recognition for the two initial deskew sites. (See Step 10 on page
-18 through Step 16 on page -20.)

4. Insert Scan recipes for the measurement sites. (See STEP 30 ON PAGE -22.)
5. Click the site in the Sequence list to be taught.

6. Click the Teach Pat button, or click the Use Previous Site button to use the
pattern from previous site.

The Pattern Rec. Deskew Teach Window appears.

7. Teach a Pattern Rec. feature near the intended scan location, following the
guidelines in Table 7.10 and Table 7.11.

8. Click OK.

With the site still highlighted, click the Teach Loc button.

10. Teach the location for the actual measurement. This position is recorded as an
offset from the Pattern Rec. site.

11. Click OK.

12. Repeat for all sequence sites.

©

SAVING SEQUENCES

Sequences can be saved on the hard drive or network drive

* NOTE: For SEMI compliance, both scan recipes and sequences
share the same directory. This means that a sequence cannot have
the same name as an existing recipe.

c CAUTION: Do not attempt to save directly to the Jaz drive. Save in
the file first then transfer to the Jaz drive.

1. Click the Sequence menu, and select:
¢ Save to save the current recipe, or

¢ Save As to save the current recipe under a different name.
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2. Type a sequence name in the Name field.

The name can be upper or lower case. If using special characters, only the
following are allowed:

~ tilde ( left parenthesis
! exclamation point ) right parenthesis
@ at sign _ underscore
# number sign - hyphen
$ dollar sign { left brace
% percent sign } right brace
A caret ¢ single quotation mark
& ampersand ' apostrophe
3. Click OK.

SAVING THE SEQUENCE DATA

The Scan and Sequence Data sets can be saved and retrieved for future review and
additional reanalysis using different scan recipe parameters.

If a scan is completed without being interrupted, the Analysis screen automatically
appears after the scan is complete.

1. Click File, and select Save Data. The dialog box appears. (See Figure 7.43.)
Figure 7.42  Analysis Screen with File Menu
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Step 2 Ensure that the
recipe is being stored in the
appropriate folder.

Step 3 Enter the data set
name in the File Name
field.

Step 4 Choose either
Statistics or Trace to save

the related data in the —
@ Statistics o Trace)

named file.

2. Ensure that the data is being saved into the correct folder. (See Figure 7.43.)
3. Type a name (up to 72-alphanumeric characters) in the File Name field.

The name can be upper or lower case. If using special characters, refer to Using
File Name Conventions on page 2-19. (See Figure 7.43.)

Figure 7.43 Save Data Set Dialog Box
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4. Choose either Statistics or Trace. If both require saving, perform the save
function two times, one for each option, giving names to each different data set.

Trace creates a scan data set containing the actual trace data. This can then be
used to display the trace in the Analysis screen for further analysis or
recalculation with new parameters. The system also uses this data to create the
Thumbnail trace for comparison.

Statistics creates a file of the scan data parameters that were set in the scan
recipe used to create the different scans. This data can also be displayed in the
Sequence summary screen and analyzed or recalculated with different scan
parameters.

5. Click Save. Once a data set has been saved, it is added to the Sequence Data
catalog. The Sequence Data catalog window allows for the selection of
individual data sets for reviewing. Unwanted data sets can also be deleted.

SEQUENCE TRANSPORTABILITY

Introduction

This feature is designed to facilitate the use of a sequence recipe on a system that
receives the recipe from another identical system. This is accomplished by using the
center of the wafer as a reference instead of using the stage center. To accomplish this,
the Wafer Center Calibration must be run on the sending and receiving systems,
preferably using the same wafer. Both systems must already have all calibrations
current, including Center of Rotation and Stage Mapping. As a result, there is no need
to reteach locations or die grid models when transporting a sequence recipe to another
system.

0104396-000 AA

3/05

KLA-Tencor Confidential 7-51



Sequence Recipe and Data (Optional) - Sequence Transportability KLA-Tencor P-15 User’s Guide

Another benefit of the Wafer Center Calibration is that, after service or maintenance

where a component was replaced, running the calibration ensures that sequences do
not need to be retaught.

In order for the sequence to perform its intended scans at the intended locations, the
recipes and die grids are exported to the receiving system along with the sequence
recipe. This export function is accomplished using the appropriate export options.

It is important to note that this procedure is recommended for like systems with the
same optics. Systems with different optics might experience difficulty with the
pattern recognition because the models are different sizes. In addition, sites taught on
an x40 system in low magnification might not be accessible in an x20 system.

Sequence Transport Configuration

The user has the option of including models and scan recipes (along with the already
included basic sequence, deskew, and site by site model) when exporting a sequence
to another system. If the user chooses to export the sequence recipe without including

the models and scan recipes, only the basic sequence, deskew, and site by site model
is exported.

Open the Sequence Transport Options... Dialog Box

From the Configuration screen, click on the Recipe Transport Options... button to
open its dialog box. (See Figure 7.44)

Figure 7.44 Recipe Transport Options... Configuration Screen Button
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Export Paths

The Recipe Transport Options dialog box, contains fields for setting the Export and
Upload paths for scan and sequence recipes. The system has default paths that were
established during the software installation. The default paths are displayed in

Figure 7.45.

1. To change back to the default scan and sequence recipes, sequence recipe option
defaults, and data paths (C:\EAGLE\SCANEXP and C:\EAGLE\SEQEXP),

click on the System Defaults button.

Figure 7.45 Recipe Transport Options Dialog Box
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2. If setting a different path, click Browse and locate the desired folder in the
dialog box. Click OK when the folder is chosen to set it active in the Recipe
Transport Options dialog box. (See Figure 7.46.)

Figure 7.46  Browse Directories Dialog Box
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3. If no other changes are to be made in the Recipe Transport Options dialog box,
click OK to accept the changes.
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Sequence Recipe Options

The Sequence Recipe Options portion of the Recipe Transport Options dialog box is
designed to give the user an opportunity to include the models and scan recipes in the
sequence recipe export or upload.

The Export option, when checked, adds the binary models and scan recipes to the
sequence recipe when exporting it. If unchecked, the models and scan recipes are not
included with basic sequence, deskew, and site by site model.

The Upload option, when checked, accepts the models and scan recipes when
uploading the sequence recipe. If unchecked, the models and scan recipes are not
included with basic sequence, deskew, and site by site model.

The If Existing File ficld contains the options necessary when recipes on the system
have the same name as those being imported. (This option is only for imported
recipes. If a host downloads a sequence, all existing files are automatically
overwritten.) The following options are available:

¢ Prompt User: This option produces a dialog box that allows the user to rename
the recipe, overwrite the current recipe having the same name, or set the option
to ensure that no recipes are ever overwritten by user imported files.

¢ Auto rename all: This option automatically renames the scan recipes and diegrid
in the sequence and placed the newly named scan recipes in the designated
folder.

¢ Auto overwrite all: This option automatically overwrites recipes and diegrid with
the same name, replacing them with the imported recipe.

¢ Do not overwrite any: This option does not allow any of the recipes, scan or
sequence, to be overwritten. When an import is attempted, the user is prompted
with a question asking if the existing recipe is to be overwritten with the
imported one. In a sequence the prompt is given for every file, scan recipes and
diegrids.
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Step 1 Put a check in
either or both boxes to
include the models and
scan recipes in their
respective operations.

Step 2 Click on the option in
the drop-down menu to choose
the method of handling
incoming recipes or diegrids
with identical names in the
incoming folder.

—

1. Put a check in the checkbox of either or both Exporting and Uploading. The
checked box means the models and scan recipes, if they exist, are included in the
operation.

Figure 7.47 Recipe Transport Options with “If Existing File” Menu
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2. Click on the option in the drop-down menu to choose how the incoming recipes
and diegrids are to be handled if there are files with the same name already
resident in the selected folders. (See the explanations above regarding the
operation of each option.)

3. Click OK to apply the changes and close the dialog box.

Wafer Center Calibration

The sequence transportability depends on the system using the center of the wafer as a
reference point instead of the center of the stage, as has been done in the past. This
requires that the Calibrate Wafer Center calibration be run. The Calibrate Wafer Center
calibrates the center of the wafer as the (0,0) reference point. After this calibration has
been run, all sequence recipes and the system Safe Area settings use the wafer
coordinates. (See “Calibrate Wafer Center” Calibration.)

The P-15 systems do not use a handler, so this is only effective if the system has a
precision locator for wafer alignment.

Calibration Procedure

Before performing the Calibrate Wafer Center calibration, all system calibrations
must be current, including the Center of Rotation and Stage Mapping calibrations. If
not, perform these calibrations first along with any prerequisites. After these are
acceptably completed, proceed with the following calibration.
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Step 1 Click on Calibrate
Wafer Center... to open
the calibration.

1.

From the Calibration screen, click on Calibrate Wafer Center button.

2

NOTE: The user must be logged in under the proper security level to
access the Calibrate Wafer Center calibration. Without the correct level,
the calibration might be missing from the menu or grayed out.

Figure 7.48 Calibration Screen
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The user is prompted to load a wafer. The user selects the cassette and slot that
the wafer is to be taken from as well as setting the load angle to 45°.

Figure 7.49  Wafer Center Calibration Screen

Mode: XY
0.00 pn
0.00 wn

0.00 ym

o 0K cance]

Clek. 0K E-»‘J Clear Status |

oo

Load a wafer.
Click OK after the wafer is loaded.

The system moves the wafer to until its edge is under the optics. When the stage
stops, the system focuses on a point near the wafer edge.

Align the wafer edge with the screen crosshair as prompted by the system. If the
edge is not in sight, move the stage to the right using the right arrow button in
the toolbar. Align the left wafer edge with the screen crosshairs.

Click OK.

The stage moves to a point near the right wafer edge and the system focuses on
the wafer surface. The user is prompted to align the wafer edge with the screen
crosshairs.

Align the right wafer edge with the screen crosshairs. Use the left-arrow button
in the tool bar to move the wafer edge into alignment with the screen crosshairs.
(In necessary, use the Slow speed for the arrow button movement to accurately
position the edge of the wafer at the screen crosshairs.)

Click OK to accept the position.

Click OK.

The system positions the top of wafer under the optics and focuses. The user is
prompted to position the top edge of the wafer at the screen crosshairs.
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10. Align the top wafer edge with the screen crosshairs. Use the down-arrow button
in the tool bar to move the wafer’s top edge into alignment with the screen
crosshairs. (In necessary, use the Slow speed for the arrow button movement to
accurately position the top edge of the wafer at the screen crosshairs.)

11. Click OK.

The system positions the bottom of wafer under the optics and focuses. The user
is prompted to position the bottom edge of the wafer at the screen crosshairs.

12. Align the bottom wafer edge with the screen crosshairs. Use the up-arrow button
in the tool bar to move the wafer’s bottom edge into alignment with the screen
crosshairs. (In necessary, use the Slow speed for the arrow button movement to
accurately position the bottom edge of the wafer at the screen crosshairs.)

Stage to Wafer Conversion

As aresult of the system converting to the use of the wafer center instead of the stage
center as a reference point, all sequence recipes created before the conversion (i.e.,
before the “Calibrate Wafer Center” calibration) become inaccurate. They must be
converted to the wafer center system in order to perform correctly. The Calibrate
Wafer Center Calibration adds an offset from the stage coordinate to the wafer
coordinates.

The Stage to Wafer calibration should only be performed after the Center of Wafer
calibration is performed and prior to any new recipes being created. If only new
recipes (recipes created after the Calibrate Wafer Center calibration) are to be used,
the conversion is optional.

NOTE: This procedure can only be performed once.

z

Calibration Procedure

1. From Windows Explorer, run
<Drive where Eagle is located>:\eagle\exe\StagetoWafer.exe

2. User is warned to back up recipes before proceeding.
Backup is advised. Use the Pbackup procedure.

3. Click Proceed. All sequence recipes are automatically converted.

HANDLER... BUTTON OPTIONS WINDOW FOR SEQUENCING

The P-15 does not have a handler. Manual Load/Unload is the only active feature in
this dialog box, and is available for use in the P-15 system.
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This option is for an operator who is going to use the same sequence recipe to process
numerous samples in a series. In this mode, at the end of each scan sequence the stage
automatically moves to the manual load position and a dialog box informs the user to
load a sample and click OK when ready. The stage positions the sample to begin the
sequence scans and automatically begins the scan procedure. When the sequence is
complete, process starts again. This procedure continues until the Cancel button is
clicked to stop the sequence.

Accessing the Handler... Button Options Window

1. In the Sequence Recipe Catalog (see Figure 7.50), click the View/Modify button
to display the Sequence Editor. (See Figure 7.51.)

Figure 7.50 Sequence Recipe Catalog Screen

[ Profiler - [Catalog]
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Sequence Recipe Name:
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Scan M IHO71348 2006-01-21 10:33 ao
Data REPEAT 2000-01-23 10:37 ]
REPEAT2D 2000-01-23 11:26 .
Sequence .|
Recipe
Sequance
. Data
Step 1 To display the
Sequence Editor,
click on View/Modify. \\
T

pint | New steRT |

ISEEUENCE RECIPE CATALOG [Sample? Clear Status |
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2. Click on the Handler... button (see Figure 7.51) to display the Handler Options
dialog box. (See Figure 7.52.)

Figure 7.51  Sequence Editor

Profiler - [Sequence Editor - **UNTITLED=*]

Sequence Edit Sample Yacuum Deskew DieGrid Diagnostics Help
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S
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|Sample Clear Status |

Using Handler Options to Set the Sample Selection Procedure

Sequence procedures can be run tow ways for the P-15 system: No Automatic
Load/Unload and Manual Load/Unload. Each is discussed below.

Figure 7.52 Handler Options Dialog Box - Load Options

Click on the No Automatic Handler Options <] -— C|IC'k on OK after all the
Load/Unload radio button to € NoAutomatic Load/Unload € Selected SN [T desired changes have
. € Fandom Selestion: € Operator
set manually loaded single ”P ”; e Upzeicy el been made.
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Step 2 Choose the

Manual Load/Unload \

option for multiple
samples using the
manual load procedure.

Step 4 Click on Sequence

to display the menu,

Manual Load/Unload (Automatic)

This options is used when the operator is going to use a sequence for processing
numerous samples using the same sequence recipe. In this mode, the stage
automatically moves to the manual load position and a dialog box informs the user to
load a sample and click OK when ready. The stage positions the sample to begin the
sequence scans and automatically begins the scan procedure. When the sequence is
complete, the stage again moves to the manual load position and the dialog box
appears. This procedure continues until the Cancel button is clicked to stop the

sequence.

1. In the Sequence Editor click on the Handler... button. This displays the Handler
Options dialog box. (See Figure 7.53.)

Figure 7.53 Handler Options Dialog Box - Manual Load/Unload Option

€ NoAutomatic Load/Unload " Selected Slots: 5
€ Random Selection:  Dperator: .
o Cancel
Nmbes [ a Step 3 Click OK
e when the selection
=== 8 .
17 is complete.
Fieset 16
15
i
—Casselfes————————— i
Lo = il
Urload: lﬁ :
§
5
—/ater Predligner ;
Iode: |Not Aligned vI :
fngles 0 1

2. Select Manual Load/Unload (place a dot in the radio button) to activate the
automatic Manual Load procedure for each sample using the sequence. (See

Figure 7.53.)

3. Click OK after the Manual Load/Unload procedure has been selected. (See

Figure 7.53.)

4. In the Sequence Editor, click Sequence in the menu bar to display its menu.

5. Click on Save to save the changes in the sequence. (See Figure 7.54.)

Figure 7.54 The Sequence Menu

Sequence

. 4

New Chrl+M

Open... Ctrl+0
(DT

Save As... \

Start

Bepeat

Infa...

Print... Ctil+P

Auto Print Options...

Exit Sequence Editor

Step 5 click on Save to save
the Handler Options dialog
box configuration changes.
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6. When the sequence containing the Manual Load/Unload option is started, a

Step 6 Load a sample on the
stage and click OK to continue.

message box appears telling the user to load a sample (substrate) then click OK
to continue or Cancel to stop the sequence. (See Figure 7.55.)

Load a sample onto the stage then click OK to continue. (See Figure 7.55.)

Figure 7.55 Load Substrate Message

ProfilerContainer E3

'-r\?D Load substiate on the stage and then press OK to proceed, Cancel to stop the sequence.

Step 8 Click Cancel after the\‘ -
Cancell

last sample is removed.

Turn on the vacuum using the switch on the top left inner door frame.
After the last sample is processed, the system moves it to stage door.
Open the door and turn off the vacuum.

Remove the sample from the stage and click Cancel. This terminates the
sequence repetition. (See Figure 7.55.)

No Automatic Load/Unload

This options is used when the operator is going to process random samples using a
sequence recipe. In this mode, all load and unload procedures are initiated directly by
the operator.

1.

In the Sequence Editor click on the Handler... button. This displays the Handler
Options dialog box. (See Figure 7.53.)

Figure 7.56  Handler Options Dialog Box - Manual Load/Unload Option

i G R
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Select No Automatic Load/Unload (place a dot in the radio button) to deactivate
the Automatic Manual Load procedure. (See Figure 7.56.)

Click OK after the selection is complete. (See Figure 7.56.)
In the Sequence Editor, click Sequence in the menu bar to display its menu.
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5. Click on Save to save the changes in the sequence. (See Figure 7.54.)

Figure 7.57 The Sequence Menu

Sequence

Step 4 Click on Sequence o S |
to display the menu, (
Play EorS
\ .
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ANALYZING 2D SCAN DATA

INTRODUCTION

The 2D Analysis application displays the trace of the sample and its measurement
data after scanning.

This chapter describes:
¢ Starting the 2D Analysis Application on page 8-1
¢ Leveling the Trace and Setting Up Measurements on page 8-6
¢ Setting the Cursor Positions Using Feature Detection on page 8-24
¢ Setting the Cutoff Filters on page 8-34
¢ Customizing the Graph Display on page 8-16
* Measuring the Radius on Curved Surfaces on page 8-42
¢  Measuring Step Height on Curved Surfaces Using Fit and Level on page 8-47
¢ Saving Scan Data on page 8-47
¢ Reevaluation of Saved 2D Scan Data on page 8-48

STARTING THE 2D ANALYSIS APPLICATION

Introduction

2D analysis is an operation performed on data obtained from a scan. If a 2D scan is
run, immediately after the scan procedure is complete, the Analysis screen
automatically appears. When automatically opened following a scan, the Analysis
screen contains the analysis of the “live” data. The following apply to live data:

¢ It is data which has just been collected from a scan;

¢ It has not been saved and is therefore untitled;

¢ This data can be manipulated by changing the scan parameters in the Scan

Recipe Editor for the recipe used to create the scan.

If the data has been saved, it is no longer “live” as described above. It has the
following properties:

¢ [ts name appears in the Scan or Sequence Data (if it was save to that location).
¢ It must be opened through the Analysis screen in order to view or reanalyze it.

¢ It can be reanalyzed by changing the scan recipe parameters.

Data Analysis Procedure

If the original scan has been saved and the Exit from the scan screen has been
performed, use the following procedure to access the Analysis screen.
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1. From the Catalog screen, click on the Scan Data button (see Figure 8.1) to display
the Scan Data Catalog in the Information Display window.

Figure 8.1 Sequence Recipe Catalog

Profiler - [Catalog]

X
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2. Click the 2D button at the top of the screen to display the 2D Scan Data sets.
(See Figure 8.2.)

Figure 8.2 Scan Data Catalog
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(See Figure 8.3.)
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3. Open the desired data folder by double-clicking on the folder name in the Scan
Data list of folders. (See Figure 8.3.)

4. Click on the Thumbnails button to display small graphs (thumbnails) of all data
sets in the chosen folder. (See Figure 8.4.)

5. To display the Analysis window for a particular data set, use one of the
following procedures:

¢ Double-click on the thumbnail; (See Figure 8.4.)
¢ Click once on the thumbnail and then click on OK. (See Figure 8.5.)
¢ Double-click on the scan data name in the scan data list. (See Figure 8.3.)

¢ Click once on the name of the data set in the list (it highlights when
chosen) then click on the Review button. (See Figure 8.3.)

Figure 8.3 Scan Data Catalog
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When the Thumbnail button —#»

is clicked on, the Thumbnail
dialog box appears
containing thumbnail traces
of all data in the folder.

(See Step 5) To access the
Analysis screen for any one of
the thumbnails, double-click on

the thumbnail. e

Alternative: See Figure 8.5.

Figure 8.4 Thumbnail Display of Data Traces
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Figure 8.5 Thumbnail Display of Data Traces
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2D Analysis Window Features

The Analysis toolbar contains buttons that provide access to commonly used
functions. (See Table 8.1.)

Table 8.1 2D Analysis toolbar

Button Description

Displays the graph view in the original view size.

Activates the zoom capability. To focus on a certain part of the
graph, use the cursor boundaries to define the zoom-in area.

Turns the Auto Scale Function for the zoom capability on and off.

E First click activates the LEVEL cursors.
Second click levels the trace according to cursor settings and

activates the Measurement cursors.

Opens the Surface Parameter Summary window. If the Surface
Parameter Summary window is currently minimized, it appears
maximized upon clicking this button.

This initiates a recalculation of the data using newly chosen
parameters from the recipe used for the scan. This can be
executed on both live data (not yet saved) and saved data that
was collected using the Software version 6.1 or higher.

E B EEEE

Toggles, ON/OFF, the normal trace graph.

Toggles, ON/OFF, the waviness trace graph.

Toggles, ON/OFF, the roughness trace graph.

Activates Fine Cursor Movement mode of measurement and
leveling cursors.

Prints the Analysis graph and the surface parameter summary.

Show/Hide Major Modes for the Histogram.

£EEEEE
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LEVELING THE TRACE AND SETTING UP MEASUREMENTS

Contact with the cursor in
the margin above the
graph body displays the

To facilitate the analysis of trace data, the system uses vertical lines called cursors.
Two types of cursors are used: Leveling and Measurement. Leveling cursors are used
to define the baseline for the trace. Measurement cursors are used to define the region
for measurement. In general, the leveling function should be performed prior to
setting the Measurement cursors.

Figure 8.6 Data Before Leveling, with Leveling Cursors Visible
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Using Cursors

The procedure for using and moving cursors is the same for each function in which
cursors are used. The cursor manipulation is the same for both the Leveling and
Measurement functions.

Moving Cursors

Cursors can be moved using either the track ball or the combination of keyboard
space bar and arrow keys. When the scan initially appears in the Analysis screen, the
left measurement cursor is highlighted.

In the following discussion the screen’s arrow cursor is called the pointer. The word
cursor is used to describe the vertical boundary lines used to manipulate screen data.
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Moving the Cursor with the Trackball:

1. The pointer is moved by rolling the trackball. As the pointer moves toward the
right or left cursor, it interacts with the cursor’s boundary line, taking on the
shape of an arrow with a boundary line at its tip. (See Figure 8.7.) As the pointer
passes the center line between the two cursors it changes direction, pointing
toward the cursor boundary it is closest to. When it changes direction, it is able
to interact with (reposition) the cursor boundary that it is pointing at.

The single arrowheads demonstrate that only the nearest cursor boundary at
which it is pointing, can be moved, thereby expanding or diminishing the cursor
size. (See Figure 8.7.)

Figure 8.7 Screen Cursor Positioning

When the cursor is chosen, the boundary lines are
highlighted and the boundary box

— / appears recessed. —

The arrow direction points to —
the cursor boundary thatis  — e @
being interacted with. The
pointers in these illustrations
can move the boundaries
they are pointing at in either
direction. The trackball
movement, as used in the
click and drag procedure,
determines the direction of
cursor boundary movement.

60.00 F0.00 30.00 40 E0.00 F0.00

The screen opens with the left cursor highlighted. Using the trackball, move the
pointer to the cursor boundary. As the pointer passes the midpoint between the
two cursors it changes direction, pointing at the closest cursor boundary. If that
cursor is not highlighted, click with the left mouse button to activate the cursor.
At any time after the pointer points to the boundary, as long as the cursor
boundary is highlighted, the boundary can be repositioned in either direction by
clicking with the left mouse button and dragging it. The pointer does not have to
be directly next to the cursor boundary, only pointing at it. (In Figure 8.7, the
pointer in the left illustration only moves the right cursor boundary. The pointer
in the right illustration only moves the left cursor boundary.)

2. Ifthe entire cursor is to be moved without changing its size (that is, without
moving only one of its boundaries), the double arrow pointer is used. (See
Figure 8.8.) Use the trackball to position the pointer either in the margin above
the graph, or between the cursor boundaries, causing the double arrow to appear.
(See Figure 8.8.) With the double arrow positioned to move the highlighted
cursor, click and hold the left trackball button while dragging the cursor to its
new location.
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Figure 8.8 Double Cursor - Relocating the Entire Cursor
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Moving the Cursor with the Space Bar and Arrow Keys

The combination space bar and arrow keys can be used to move the cursors to new
locations on the trace. The space bar and arrow keys function independently of the
trackball and the associated pointer used to change the cursor size or relocate it.

1. When the screen opens, the left cursor is highlighted. To select a cursor or to
select another cursor, click the space bar. Each time the space bar is clicked it
toggles once in the progression from left cursor to right cursor to both cursors,
then back to the left cursor.

2. Once the desired cursor is highlighted (or both cursors are highlighted) use the
left or right arrow keys to move the cursors. Notice that the cursor(s) move a
small consistent distance in the direction of the arrow key each time the arrow
key is clicked.

Changing the Cursor Size Using the Space Bar and Arrow Keys

The combination space bar and arrow keys can be used to change the cursor size.
They function independently of the trackball and the associated pointer used to
change the cursor size or relocate it.

Once the desired cursor is highlighted (or both cursors are highlighted) use the
up or down arrow keys to spread or reduce the cursor(s) size. Notice that the
cursor boundaries move outward (up arrow) or inward (down arrow) a small
consistent distance each time the arrow key is clicked.
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General Cursor Use

In the scan pictured in Figure 8.9, the tract is very jagged indicating a high noise
level. When the scan shows evidence of this type of noise, or is very rough, the
measurement cursor boundary lines set a distance over which an average is computed
by the system. The resultant data is then used for the purpose of evening out the trace
data. In rough or noisy scans, set the cursor boundaries further apart than would be the
case in smooth scans. This technique is called the Delta Mode.

Figure 8.9 Delta Mode - Cursor Spread on a Scan Trace

|**| l

1. For rough or noisy scans, the cursor boarders should be expanded to cover a
wider region. To adjust the width of the leveling or measurement cursor:

In this blow up of a scanin
the Analysis screen. The
spread of the cursor
boundaries in this trace is
wide enough to compensate
for the high noise level. —— o I
Notice the spikes and
valleys that depict the noise.

a. Click outside the border of the measurement cursor that is to be expanded
and drag it to the new position. (See Figure 8.7 and step on page 8-7.)

b. (Alternate resizing of cursor) With the cursor highlighted, use the up arrow
key to spread the cursor and the down arrow key to shrink the cursor. Each
click on the arrow key expands or shrinks the cursor a consistent amount.
(See Step under Changing the Cursor Size Using the Space Bar and Arrow
Keys on page 8-8)

The average value of the height within the region is then used for measurement
or leveling.

2. For finer cursor control:
a. Click the Operations menu and select Fine Movement Mode, or click the
FINE button.
b. In the FINE cursor mode, the movement with each arrow key click is
exactly one data point.
c. NOTICE: The FINE cursor mode has no effect on the trackball method of
movement and resizing.
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Using the Leveling Cursors

In order to obtain an accurate analysis, the trace must be given a level frame of
reference. This is accomplished through the leveling procedure. For 2D scan data,
two areas (defined by cursors) on the scan that are at equal heights define a reference
axis for plotting the data and calculating surface parameters.

Acceptable leveling cursor positions can be determined in advance by viewing a
sample in the XY View window prior to finalizing the recipe and beginning the scan.
However, the proper position is not always obvious, and it is possible to accidentally
set them at inappropriate locations. In an extreme case, the left leveling cursor might
end up at the bottom of a large step, and the right leveling cursor on the top.

1.

The LEVEL button is used two
times:

Step 1 The first click activates
the Leveling Cursors.

Step 3 The second click
levels the trace and activates
the Measurement Cursors.

The dashed lines are not in the
actual screen but are used here
to show two planes which can be
used in this trace for setting
leveling cursors.

Click on the LEVEL button in the tool bar. (Alternative: Operations/Level Trace.)
This activates the leveling cursors. They appear at the locations currently
specified in the recipe, with the left cursor selected (highlighted).

Figure 8.10 Analysis Screen with Unleveled Trace and Level Cursors

| Analysis - Scan Data: Untitled X
Eile Edif View Trace Parameters Operations ‘Window Help

@ | Q [#xs eve |stars | cacc[norn way |roven| Fme [ & [ [svr | & | & |

i Scan Data: Untitted
Recipe:

EXAMPLE

Length: 100.00 pm
Speed: 100.00 pm/s
Direction -=
Repeats: 3

Force: 0.2mg

Cursors

Left Right
Meas 10.05 9095
Detta 4975 99.50
Level 4472 9095
Defta 57.28 99.50

== Tormal

==

0.00 10.00 2000 30,00 40 60.00 70.00 50.00

Step 2 Set the cursors so they intersect the trace
in bounded areas that are on the same plain.

Clear Status |
Clear Status |

s, ample

To set the cursors so that the trace is accurately leveled, it is important to find
two areas on the trace that are on the same plain. Set the cursors to the desired
positions. (For help moving cursors, see Using Cursors on page 8-0.)
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3. Click the LEVEL button. (Alternative: Operations/Level Trace.)
The data is leveled and replotted and the measurement cursors appear.

Figure 8.11  Analysis Screen with Leveled Trace and Measurement Cursors

After the LEVEL button is | Analysis - Scan Data: Untitled =
. . File Edt View Trace Parameters Operations ‘Window Helo

clicked on the second time, the [y wever | svars | cavc[worw way |rover| Five [ & [[ii|sn| @ | & |

Measurement Cursors are -

activated and the trace appears Recipe:

EXAMPLE
Length: 100.00 pm

leveled out. \ Speed: 100,00 pmis
Direction -=
Uocnests: 3

As the cursors are moved et
in the Analysis screen, the b A
Cursors limits adjust e
automatically to reflect the Ret 0000

L Height: 4551 &

56.78 95.49 I
new positions. (See R Height: 1.6 A |
St Height: -453.5 A

FIgUI’e 8. 12) ‘;}’:ﬁh 15::333'1 2 —r«lfrmal

0.00 10.00 2000 30.00 4 60.00 70.00 50.00 90.00 100.00
pm)

Clear Status |
|Sample Clear Status |

Using the Measurement Cursors

The measurement cursors are used to define the region or regions of interest for
measurement.

EXAMPLE:

1. In order to determine the difference in height between two regions, those two
regions must each be clearly identified. The measurement cursors are used to
isolate both regions for measurement and subsequent calculation.

2. To determine the area in a peak or valley region, the Measurement Cursors
can be moved (or adjusted if they were partially out of position) to accurately
enclose those regions and the area calculated or recalculated.

The parameters affected by the measurement cursors can be added or taken out of the
recipe so that the new results are displayed in the Surface Parameter Summary
Window (STATS) of the screen after the cursors are moved and the results of the move
recalculated. This procedure can be performed on “live” data or previously saved data
(from scans using software version 6.1 or newer).

The Analysis window initially appears with the measurement cursors set at the
locations specified in the scan recipe.

0104396-000 AA KLA-Tencor Confidential 8-11
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Step 1 Clickon Edit —__g &

Step 2 Click Recipe...
to open the recipe
used to create the

Like the leveling cursors, the measurement cursors can be freely moved to any
location on the trace. In the Scan Data Analysis window the displayed cursor positions
are recalculated whenever the measurement cursors are moved to new locations.

Figure 8.12  Analysis Screen’s Cursors Settings

Cursors . .

Left Right As the cursors are moved in the Analysis
Meas 14.50 34.60 . ;
T < screen, t_he Cursors limits adjust -
Level -0.300 -0.300 automatically to reflect the new positions.
Detta  -0.300 3.600

Parameters in the Surface Parameter Summary window are not recalculated
automatically when the measurement cursors are moved. If new data is required with
the adjustment of the cursors, the recipe used to create the scan can be modified to
present new parameters in the Surface Parameter Summary window or remove
unnecessary ones.

1.
2.

From the Analysis screen, click on Edit to display its menu. (See Figure 8.13.)

Then click Recipe... to open the scan recipe used to create the scan. (See
Figure 8.13.)

Figure 8.13  Accessing the Scan Recipe from the Analysis Screen

X

View Tra\e Parameters Operations Window Help
j' Leve | stars | cacc[woru wav |rouek| Fne | & [

ﬁ 2D Surface Parameter Summary (O] %]

Normal

20.1278 pm Normal Tot Ind Runout
scan. Avg -\ -9350.4 & Hormal Average Height
Areat 3 81.4633 pm? Hormal Area of Peaks
Notice current cursor
positions and parameter
statistics.
Recipe:
_COARSE
Length: 50.00 pm
Speed: 10.00 pm/s |
Direction -= ‘ |
Repeats: 1 0 }
Force: 0.105 mg (|
Cursors Normal } }
Left Right ‘ }
Meas 1.500 41.30 1
Detta  3.300 43.10 1
Level -0.300 -0.300 00 500 10.00 15.00 2 30.00 35.00 40.00 45.00 5000
Defta -0.300 3.600 (um)
Clear Status |
Clear Status |
This displays the scan recipe screen from which parameters can be added or
removed. In Figure 8.14 the General Parameters window of the Recipe screen
has been opened to change the parameter set to be calculated with the next
cursor adjustment. (This procedure can be used with both live and saved data.)
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The General Parameters
button has been chosen

and its contents displayed | B |  Total Ind. Runaut (TIR)

Parameters have been
chosen that reflect the
needs relating to the
pending cursor change.

Step 3 Click on Recipe to ~a Profiler -

display its menu.

Step 4 Choose Analysis
to return to the Analysis
screen.

Figure 8.14  Recipe Screen - General Parameters Window

Profiler - [Recipe Editor - _COARSE]

BRecipe Options Help

N

{Dﬁeneval Parameters \
Scan Parameter
Definition Normal Trace

V¥ Step Height (StpHY)

Feature

Filters IV Average Height [Avg)

\ ™ Slope
General )
Parameters ™ Radius (Rad)

IV Area of Peaks (Area+)

Waviness I™ Area of Valleys [Area)
Bearing Ratio IV Total Area [Area)
Cutting Depth

High Spat Count .
Peak Count I Valey (P4)
seup I Profile Length (ProfL)
Analysis Tools ™ Distance to Edge (Edge)

I™ Step Width [Stpw!t)

Select All 2D
Remove All 2D

/

Clear Status |
Clear Status |

3. When the parameters have been chosen, click on Recipe to display its menu.
(See Figure 8.15.)

4. Choose Analysis to return to the Analysis screen. The system calculated the
parameter values for the chosen parameters using the current cursor settings and
displays them in the Surface Parameter Summary window. (See Figure 8.15.)

Figure 8.15  Exit Recipe Editor to Return to Analysis Screen

[Recipe Editor - _COARSE]
Optior:s

el

—

Frint... Chil+P

D General Parameters—
Exit Recipe Editar

I T I | miomal Trace

After repositioning the cursors, to recalculate the parameters in the Surface
Parameter Summary window, use the following procedure:

5. Set the Measurement Cursor positions. (For help positioning the cursors, see
Using Cursors on page 8-6.)
In the following illustration the cursors have been moved to capture the area
under the two highest features in the scan. Parameters have been chosen that
respond to the new position. (See Figure 8.16.)
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Figure 8.16  Analysis screen with Repositioned Cursors

Step 5 The cursors are Analysis - [Scan Data: 2D_scan] %
moved to a new position. Rl B e e B : LD
isi i e [ e e [ & |1 |
In this illustration they are ==
_COARSE

positioned to find the area
under the two high
features on the graph.

The cursor positions and d
related height, width and
step parameters are
automatically updated as
the cursors are moved.

6.

Step 6 Click CALC to
recalculate the
parameters using the new
cursor positions.

/|[Cursors

Length: 50.00 pm
Speed: 10.00 pmis
Direction -=
Repeats: 1

Force: 0.105 mg 20.0pm

Left Right
Meas 14.50 34.60
Defta 19.70 39.60
Level -0.300 -0.300
Detta  -0.300 3.600

5.0um

10.0um

5.00um
Ref. 0.300

L Height: 7.70tpm
R Heigrt: 7.843um
St Height: 1424.1 &
[Width:  20.00pm
TIR: 20.04pm:

04

-5.00pm

-10.0pm

-15.0pm

Mormal

-20.0pm

-25.0pm
10.00 15.00 200 30.00 35.00 40.00 45.00
(pm)

Clear Status |
Clear Status |

After positioning the measurement cursors, the parameters in the Surface
Parameter Summary window are ready to be updated:

Click the CALC button to perform the recalculation. (See Figure 8.17.)

Figure 8.17 CALC Button in Analysis Screen

'.Analysis [Scan Data: 2D_scan]

Wiew Trace Parameters  Operations Window Help

@ | a | m‘lmmlﬁ _wav_|roush| Fe | & |0

Recipe: )

_COARSE Level ]

Length: 50.00 pm Meas: |
Speed: 10.00 pmiz

The parameters are automatically recalculated and the Surface Parameter
Summary window is updated. In Figure 8.18, the chosen parameters in the Scan
Recipe display their new values in keeping with the new cursor positions. Only
the chosen parameters become part of the data set that is calculated.
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When the recalculation
procedure is performed, only
the parameters chosen in the
scan recipe are visible and
only those are changed.

Step 7 To save data, click
File to display its menu.

Step 8 Choose Save
Data... from the File
menu.

I N

7.

8.

9.

10.

Figure 8.18  Surface Parameter Summary Window

X

File Edit View Trace Parameters Operations Window Help

@ | a Jois [ueve| st | cauc [ o way |rovn|| rne || & | (0]

4§ 2D Surface Parameter Summary [_[O]X]
Height 1424.1 & Hormal

TIR : 20.0440 pm Hormal Tot Ind Runout

Avg : -8915.8 4 Normal Average Height

Area+ : 41 .1951 pm? Normal Area of Peaks

Area : 100.406 pm? Normal Total Area
NFD : 10.0618 pm Normal Peak

I Scan Data: 2D_scan
Recipe:
_COARSE
Length: 50.00 pm
Speed: 10.00 pmis
Direction -=
Repeats: 1

Force: 0.105 mg

Cursors 2 Marmal

Left Right
Meas 14.50 3460
Detta 19.70 3960 E
Level -0.300 -0.300 0.00 5 10.00 15.00 20,00 35.00 40.00
Detta  -0.300 3.500

Clear Status |
Clear Status |

To retain the newly calculated values in a data file and the new cursor positions
in the recipe, the data must be saved. Click File to open its menu. (See

Figure 8.19.)

Choose Save Data... from the File menu to open its dialog box. (See

Figure 8.19.)

Figure 8.19  File Menu in Analysis Screen

Trace Parameters Operations W

{ -/ | | ancl

—  Export Graph... g
Rec

_C  Print... Ctrl+P
;‘3" Frint Preview

PE oo
i Frint Setup...
Ref  Load Workspace...
FE Save Workspace...
cur Eﬂlt
In the Save dialog box, ensure that the proper folder is chosen, enter the name

that the data is to be stored under. (See Figure 8.20.)
Click Save to save the data. (See Figure 8.20.)
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Figure 8.20 Save Scan Data Dialog Box

Save Scan Data | 2] ]
Savein |2 scandata =l gl
@ 2D_scan.dat
Step 9 Enter the file Step 10 After the name
name. is entered click Save to

\ | '/ save the data to the file.

hame: SC X Save D
Save as type: |Scan Data Files [*.dat) :] Cancel |
Help |

CUSTOMIZING THE GRAPH DISPLAY

The View menu offers several options for customizing the graphical display of the
data. The instrument proportions the data to the area available in the window.
However, the data can be sized by setting custom graph limits.

Changing the Z Limits Display
Changing the Z Limits Display allows the user to set the scale on the graph.

1. Click the View menu to display its menu. (See Figure 8.21.)

Figure 8.21  Analysis Screen with View Menu

To set the Z Graph Limits or Z
Units

¢ Step 1 Click View to
display the menu.

Log 10X Axis
Log 10 Z Axis

¢ Step 2 Choose Change speest
+ Step 3 Choose Z Graph S

Limits Cursors  Select Window Function...

Le—
Meas 10 Histogram...
Deta 50 Sean,..
Level 9. ¢
Detta  4¢ Surface Summ...
Ref. 0.000
L Height: -0.0 &
R Height: -0.0 &
St Height: -0.0 & )
Wicth:  440.0pm d Mormal
TIR: 604 A

600 700 900 1000
ength (um)

Sample Clear Status |
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2. Choose Change from the View menu. (See Figure 8.21.)
3. Select Z Graph Limits. (See Figure 8.21.)
The dialog box appears. (See Figure 8.22).

Figure 8.22  Setting Z Graph Limits

Set Z Graph Limits E3 Step 5 Click
o ~ on OK to save
Step 4 To change the limits, Upper Z Lingg: |1 A00.00 A the changes
double-click on the current limit to to the limits

highlight it. Enter the new limit.

~ [600.00 &

4. Highlight the old limit and enter the new limits in the Upper and Lower Z Limit
fields: (See Figure 8.22.)

¢ Higher to reduce the size of the trace;
¢ Lower to increase the size of the trace.
5. Click OK to apply the limits to the displayed data. (See Figure 8.22.)

Changing the Z Units Display

The Profiler plots the data in um, nm, A, or both um and A with a crossover value
that is set by the user.

1. Click the View menu to display its menu. (See Figure 8.23.)

Figure 8.23  Analysis Screen with View Menu

To set the Z Graph Limits or Z [ agpe— K
Units File FI Trace Parameters Operations Window HE\
¢ Step 1 Click View to ﬁ;::ew

display the menu. e
Length: 10 Log 10Z Axis
¢ Step 2 Choose Change Spsect 5C

Direction - w Normal Data
Repeats:© FFT..

¢ Step 3 Choose Z Units Force: 05 pap.

Cursors Select Window Function...

Meas 10 Histogram...
Detta 50 Scan...

© Surface Summary...

Ref:
L Height: -0.0 &
R Height: -0.0 &
St Height: -0.0 &
Wicth:  440.0um Normal
TIR: 604 A

0.000

700 900 1000

Sample Clear Status |

2. Choose Change from the View menu. (See Figure 8.23.)

0104396-000 AA KLA-Tencor Confidential 8-17
3/05



Analyzing 2D Scan Data - Customizing the Graph Display KLA-Tencor P-15 User’s Guide

Step 4 Choose the desired units by
clicking in the appropriate radio button.

For the bottom choice, after clicking in
the radio button, enter a distance at
which it changes between microns

and angstroms.

3. Select Z Units. (See Figure 8.23.)
The Set Z Units dialog box appears (see Figure 8.24).

Figure 8.24  Set Z Units Dialog Box

Step 5 Click on

Set Z Units v th
OKtoa the

€ um anly mode - settingsrig i/he
" nm only mode displayed data.

& anly mode
9 & ymandA mode crossover at: |1 0000.00 &

4. Select the desired Z unit mode. Choose between:
¢ Microns only (um only mode),
¢ Nanometers only (nm only mode),
¢ Angstroms only (A only mode),

¢ Combination mode where the reading could be in angstroms or microns
depending on the trace magnitude (um and A crossover at [variable] A).

In this mode, enter the trace magnitude at which the units change from
microns (um) to angstroms (A) or from A to um. In Figure 8.24, the mode
crosses over at 10000 A.

5. Click OK to apply the settings to the displayed data.

Displaying Data in FFT Mode

The data can be replotted using the Fast Fourier Transform (FFT) in order to expose
patterns of data that indicate regularly spaced features of the same width. By default,
the instrument plots the Scan View data in linear coordinates (“Normal” data).

A choice of window functions is available to apply to the endpoints of the FFT data.
Selecting FFT:

1. Click View to display its menu. (See Figure 8.25.)

2. Select FFT. (See Figure 8.25.)

Figure 8.25 View Menu with FFT Chosen

Change 3 Changa 3
Step 2 To choose Fast v Log 103 s Lag 10 Asis Step 4 To return to the
Fourier Transform, click v Log 10 Z Asis Log 10 Z Axis / normal data presentation,
FFT. A check nextto FFT (,, Nomal Data click on Normal Data. A
indicates that it is chosen. % EFT.. check next to Normal
P50 PSD... Data indicates that it is
Select Window Function. .. Select Window Function... chosen.
Histogram... Histogram...
Scan... Scan...
Surface Summary... Surface Summary...
Sequence st Geaquence (st
Eorrelatian Sear.. Earrelatian Scar..
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The instrument replots the data.

3. Click View to display its menu. (See Figure 8.25.)
4. Select Normal Data to return to the Normal Data mode. (See Figure 8.25.)

The current data mode selection is one with the check next to it.

Displaying Data on Logarithmic Scaling

The display can be set to plot either Normal or FFT data in logarithmic X and Z
coordinates. Logarithmic scaling helps to delineate small features that are dwarfed by
the larger features in a linearly proportioned scan.

1. Inthe Analysis screen, click on View in the Menu Bar. (See Figure 8.25 for an
illustration of the menu.)

Figure 8.26  Analysis Screen with a Normal Trace

Apalusis - Scan Data: 2d_test_3 [ |

Step 1 C“Ck on VIeW tO dISplay —-Nle( View j[race Parameters Operations  Window Help

its menu. See the menu in Figure @ Q [zga e | stars [uors wav |Roush] Frve | & |
[ Scan Data: 2d_test_3

8.25. Choose Normal Trace.

A Normal Trace without logarithmic e o 55

scaling.

EXAMPLE:

With Normal Data chosen,
click on Log 10 Z Axis to
display the Normal data in Z
Axis logarithmic scaling. For

Recipe:

LONGEST

Length: 1500.00 pm
Speed: 100.00 ym/s
Direction -=
Repeats. 1

Force: 0.2 mg

Cursors

1| o8 =t
—1Weas 3246 1130
Defta 3251 1131

Defta 2346 1126 B - en i cn . ann . e
0 150 300 450 B0 900 1200 1350

Ref: 0.000

2. From the view menu, choose either Normal Data or FFT. (See Figure 8.28.)

3. Select Log 10 X or Log 10 Z or both from the menu. A check appears next to the
chosen items.

Figure 8.27  View Menu

Change * | Normal Application. Change 4
Log 103 Axis Step 3 Clickon Log 10 v Log 10 Axis

> v Log 10 H X Axis Log Z Axis. or v Log 102 Axis

TR Nomal Data both to display Fast Normal Data

EFT.. Fourier Transform data

result see Figure 8.28. ESD... in logarithmic scaling. ESD...
Select Window Function... Step 2 Click on Select Window Function...
Histogram. . Normal Data or FFT. In Histogram. .
Scan... . Scan...
= this example, FFT. =
Surface Summary... P Surface Summary...
Sequence Llist.. Sequence Llist..
Eorrelation Scan... Eorrelation Scan...
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A check appears beside the menu selection and the instrument replots the data
for the chosen axis.

Figure 8.28 Normal Trace and Z Axis Logarithmic Scaling

F«'el:ipe:

This is the Normal trace from LONGEST
. . . Length: 1500.00 pm
Figure 8.26 with the Z Axis Speest 100.00 umis
. . . . Dlrecilor! =
logarithmic scaling applied. e,
Cursors
. Left  Right
See Figure 8.27, EXAMPLE, Meas 3246 1130
. . . Detta 3251 1131
for an illustration on setting Level 2341 1125
thIS dIS Ia [l Z=aE s 0 S0 300 450 &0 900 1050 1200
up piay. Ret 0000 )

4. Return to linear plotting by disabling the log 10 selection(s) (See Step 3).

Viewing in Zoom Mode

Selected portions of the trace can be zoomed in on to help isolate features for
measurement, especially when using the Fine measurement mode for small-increment

cursor movement. Feature isolation can be improved with the Scale function, that
allows vertical as well as horizontal scaling.

Zoom Procedure 1. The zoom function operates using the Scale icon and the Zoom icon. (See

Figure 8.29.) Click on the scale icon to choose the desired state of the scale
function.

¢ [f'the Scale function is on, two vertical lines appear on the scan.
¢ Ifthe Scale function is off, a box appears.

¢ The scalc icon toggles the scale function on and off.

2. Click on the Zoom-in icon to activate the zoom function. (See Figure 8.29.)
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Step 2 Click on the
Zoom In icon for a
closer view a

portion of the trace.

Step 3 Click on the
Zoom Outicon to
return to the original
view.

Step 1 Click on the
Scale icon to activate
scaling. If the button
is highlighted, the
zoom function is a
box, if scaling is not
on, zoom is between
Cursors.

3.

@\Eﬂ

Zoom with Scaling ON 4.

W

When the cursors are
positioned around the
portions to be
zoomed, click here.

Step 4 Clickon each cursor ___——1

Click to turn
the scale
function on.

(left and right) and move them

to define the zoom area.

Click on the Zoom-out icon to return to normal display. (See Figure 8.29.)

Figure 8.29 Analysis Screen with the Zoom and Scale Function Buttons

Analysis - Scan Data: 2d_test_3 | x|
i iew Trace Parameters Operations Window Help

@ | Q [zgs veve| stars [norw wav [roucH| e | & |
Pl Scon Data, /f_test_3

Recipe:

Length: 1500/00 pm
Speed: 100/00 pm/s
Direction />
Repeaty/
Force/0.2 mg
Cufsors

Left Right
ideas 3246 1130
Defta 3251 1131
Level 2341 1125
Deta 2346 1126

1050 1200 1350 1500

Ref: 0.000

Emply [Clear Status |

Click and drag the cursors and position them, one on each side of the feature
being zoomed in on. (See Figure 8.30.)

Figure 8.30 Analysis Screen Using Scaling Zoom

Analysis

Eie View Irace Paameters Qperstions Window Helo
@ [ "Q [ors veves | svars [womu wav |woueh| Fe | & |0

ata: 10sec-nomo

Recipe:

NOMOTION
Length: 1000.00 pm
Speed: 100.00 pmis
Direction -=
Repeats: 1
Force: 0.5 mgy

Cursors

Left Right
Meas 0.000 964.0
Detta 54.00 1000
Level 0.000 948.0
Detta 72.00 996.0

Ref: 0.000

400 0 600 800 1000
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Zoom with Scaling OFF

5. Click and drag on a border or corner of the zoom box, to enclose the portion of

the scan to be zoomed in on. (See Figure 8.31.)

Figure 8.31 Analysis Screen Using Boxed Zoom

| Analysis

Eile View Trace Parameters Operations Window Help

@ | &ns | veve | stars [orn way |Roven| Fme | & [l

= Data: 10sec-nomo

@ I Q m I/-Tweg;ggnorq tevel [ ]

o

Step 6 When the box Disable
is positioned around the scale Meas 0000 9540

the portions to be

zoomed, click here. turn it off.

Step 5 Click on a portion of the
box (box border or corner) to
move a border and change the
area of the box.

function to Level 0.000 9480

Length: 1000.00 pm
Speed: 100.00 pmis
Direction -=

Meas:

Cursors
Left Right

Defta  54.00 1000
Defta  72.00 996.0

Ref. 0000
L Height: -0.5 A&
R Height—o0 A

= Fleight: 0.5 &
(|t ass.0m Tarmal
TIR: 2024

900 1000

* NOTE: For finer positioning, go to the Operations menu and select
Fine Movement Mode, or click its button on the toolbar. Press [<] or [>]
to position the vertical lines.

6. Click on the Zoom In icon to zoom into the area defined by the cursors or the

zoom box. (See Figure 8.31.)

7. Perform any measurement or leveling procedure necessary to analyze the

zoomed data.

8. Click the Zoom In button again to deactivate the zoom cursors and reactivate the

measurement cursors. (See Figure 8.31.)

9. To save the new data and the new cursor positions, use the procedure described
in Saving Data From the Zoom Procedure on page 8-23.
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Saving data and cursor
position in Surface
Parameter Summary

Step 1 Click on Operations in
the Menu bar.

Step 2 Choose Recalc With
Zoomed Level Cursors to
recalculate data and save new
cursor positions.

Saving only data in Surface
Parameter Summary

Saving Data From the Zoom Procedure

1. To update the data in the Surface Parameter Summary window and to store
zoomed cursor positions in the recipe, click the Operations menu, and select
Recalc with Zoomed Level Cursors. (See Figure 8.32)

Figure 8.32 Recalculate and Save Zoomed Leveling Cursors

Level Trace

Eancel Leveling

Fine Maovement Mode Step 2 Choose Recalc With

v Zoom

Undao Zoom

Unzoomed Level Cursors to
recalculate data and not save

Recalc With UnZoomed Level Cursors

new cursor positions.

Fecals With Zoomed Level Cursors

2. To update the data in the Surface Parameter Summary window without saving
the zoomed cursor positions, go to the Operations menu and select Recalc With
Unzoomed Cursors. (See Figure 8.32)

3. To return to the original scan view click the Undo Zoom icon = i) I , 0r g0 to

the Operations menu and select Undo Zoom.

Viewing the Trace Information

The left side of the Analysis window displays the basic data taken from the leveling
and measurement cursors. These values are updated instantaneously with the
positioning of the cursors (see Table 8.2).

Table 8.2 Trace Information Parameter
Parameter Description
Meas (um) Displays the X-axis value of the left vertical line of the left and right
measurement cursors.
Delta (um) Displays the X-axis value of the right vertical line of the left and
right measurement cursors.
Level (um) Displays the X-axis value of the left vertical line of the left and right
leveling cursors.
Delta (um) Displays the X-axis value of the right vertical line of the left and
right leveling cursors.
Ref (um) Displays the Feature detection reference point within the trace.
L Height Displays the Average height of the scan region marked by the left
measurement cursor.
R Height Displays the Average height of the scan region marked by the
right measurement cursor.
St Height Displays the Difference between the R Height and the L Height.
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Table 8.2 Trace Information Parameter

Parameter

Description

Width

Displays the Difference between the average X value of the scan
region marked by the right measurement cursor, and the average
X value of the scan region marked by the left measurement
cursor.

TIR

Displays the difference between the highest and the lowest points
on the scan between the central points of the measurement
cursors. Stands for Total Indicator Runout.

SETTING THE CURSOR POSITIONS USING FEATURE DETECTION

Feature Detection

Step 1 To display the Feature
Detection parameters in the
Recipe Editor Information

Feature Detection is used to enable automatic detection of some common classes of
profile features (see Figure 8.34 and Figure 8.35) to facilitate measurement
throughput and consistency. Feature Detection makes it possible to automatically and
reliably set the position of the measurement and leveling cursors relative to the rising
and falling edge of a step-like feature, or the apex or an arc-like feature.

In conjunction with feature detection, both the location of the edge (or the apex of an
arc) and the step width, can be calculated and displayed in the Analysis window.

& CAUTION: It is important to ensure the accuracy of the Video
Calibration and the Scan Position Offset Calibration prior to enabling
Feature Detection.

1. To access the Feature Detection parameters, click on the Feature Detection
button in the Recipe Editor.

Figure 8.33  Feature Detection - Recipe Editor

Profiler - [Recipe Editor - _HA_COARSE]

BRecipe Options Sample Vacuum Help

Dle|la(g|[e 2w e e al#|

Scan Parameter
Definition

Display window, click on the P 4 ez

Feature Detection button.

Cursors

General
Parameters

Roughness
Waviness

Bearing Ratio
Cutting Depth

High Spot Count
Peak Count

Setup
Analysis Tools

i~ Feature Detection
Feature: m
Feature Number: l1—
Stope Thieshold:  [1500
Plateau Threshold : IF
Min. Plateau'width:  [20000

™ Apply Gaussian Noise Filter Before Detection

Filter Cutoff (m}: 0.000 - I
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2. Feature: -This parameter allows the user to choose between six different features
that can be detected during a scan. (See also Quick Reference Table 8.4 on page
8-33))

Figure 8.34 Feature Detection Point Locations on a Step

Example of a Step feature =~ ——— P

A trace of the Step feature
illustrated above. -

DownBase

DownEdge UpEdge

A trace of the reverse Step
feature. —

DownBase / '\ UpBase

Figure 8.35 Feature Detection Point Locations for Convex and Concave

Atrace of the Convex feature. \

/

A trace of the Concave feature.

- Convex is the point at the apex

of the convex trace.

‘\ Concave is the point at the

apex of the concave trace.
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Table 8.3  Feature Detection Descriptions (See Figure 8.34 and Figure 8.35.)

Feature Description

None No feature detection is being used.

UpEdge At the trailing edge of a feature rise, it is the point at which
the trace begins the plateau. (See Figure 8.34.)
NOTE: The point location can be modified using the Distance
to Edge parameter in the General Parameters Window.

UpBase At the trailing edge of a plateau, it is the point at which the
trace begins to turn upward. (See Figure 8.34.)

DownEdge At the trailing edge of a plateau, it is the point at which the
trace begins to turn downward. (See Figure 8.34.)

DownBase At the trailing edge of a feature decline, it is the point at
which the trace begins the plateau. (See Figure 8.34.)

Convex This is the point at the apex of a convex feature. (See
Figure 8.35.)

Concave This is the point at the apex of a concave feature. (See
Figure 8.35.)

Feature Detection allows the
user to choose from six feature
option (convex and concave not
shown). Click on the down-arrow
to display the menu. Click on the
desired feature to choose it.

T

Selecting a feature for detection:

a. Click on the down-arrow next to the variable box to display its menu. (See

Figure 8.36.)

b. Click on the desired feature to select it. In necessary, use the scroll bar to

reveal other features. (See Figure 8.36.)

Figure 8.36 Feature - Feature Detection - Recipe Editor

— Feature Detection

Feature:

Up Base

Feature Mumber: Down Edge

Slope Threshold :

Plateau Threshald :

|1 0.00
Iin. Plateau ‘Width : |1D4IJDD

[~ &pply Gaussian Noise Filter Before Detection

IIJ.DIJD vl

Filter Cutoff [pm]:
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3. Feature Number: - If multiple edges are detected in the scan, Feature Number
provides a way to select a specific edge for detection. (See Figure 8.37 and also
Quick Reference Table 8.4 on page 8-33.)

Changing the Feature Number:

a. Double-click in its variable box to highlight the current number and type in
the new number. (Use only whole numbers. 1 is Default)

Figure 8.37 Detection Variables - Feature Detection - Recipe Editor

— Feature Detection
Feature: UpEdge =

Detection parameters are S

changed by clicking in the
appropriate variable box to
highlight the current number.
Then type in the new number.

Slope Threshold : 10.00

Plateau Threzhold : 10.00

Tk

Min. Plateau Width:  [10.000

[~ Apply Gaussian Noise Filer Before Detection

1

Filter Cutaff [pm): 0.000 -

4. Slope Threshold: - This factor sets the value at which any rise or fall in a trace is
considered to be a slope, not just part of the roughness or noise. This means that
the Slope Threshold defines a point at which the system recognizes a trace line
as following or preceding an edge, convex or concave point. (See also Quick
Reference Table 8.4 on page 8-33.)

Changing the Slope Threshold:
a. Double-click in its variable box to highlight the current number and type in
the new number:

¢ Use values between 0 and 50.000 (these numbers are proportional
and have no units)

¢ Default is 10.000 for a step and 1.000 for an apex point.

b. Ifthe artifact is much larger in comparison to the surrounding roughness of
the surface:

¢ Set the value higher.
c. Ifthe artifact is only a little larger than the surrounding roughness:
¢ Set this value lower.

¢ Set the Minimum Plateau Width (description follows) to avoid any
ambiguity in identifying the correct edge.

* NOTE: For very noisy scans where the system is having difficulty
detecting the feature, decrease the Slope Threshold. A value as low as
5.00 might work well.
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5. Plateau Threshold: - This factor affects the precise horizontal location calculated
for an edge or arc point. This parameter allows for the positional adjustment of
the point to the left or right. (See also Quick Reference Table 8.4 on page 8-33.)

Changing the Plateau Threshold:

Double-click in its variable box to highlight the current number and type in the
new number:

¢ Use values between 0 and 50.000 (these numbers are proportional and
have no units)

¢ Default is 10.000 for a step and 0.000 for an apex point.

* NOTE: When comparing data from scans of identical features, find a
value that works and then use it consistently. Data is changed if
differing Plateau Threshold numbers are used.

HINTS for successfully setting the Plateau Threshold:
If setting the up edge or down edge:

¢ Set this value to about the same value as the Slope Threshold
(from 0 to 50.000 — these numbers are proportional and have no
units).

¢ If the threshold is slightly greater than the Slope Threshold, the
precise location of the edge moves slightly to the left for an UpEdge
or to the right for a DownEdge.

¢ If the threshold slightly smaller than the Slope Threshold, the precise
location of the edge moves slightly to the right for an UpEdge or to
the left for a DownEdge.

If setting the UpBase and DownBase:
+ Adjustments are opposite for UpBase when compared with UpEdge
and for DownBase when compared with DownEdge.
If setting the Concave or Convex arc:
¢ If the default setting is not being used, set this value to a very small

number (from 0 to 1.000 — these numbers are proportional and have
no units).

* NOTE: The Slope Threshold determines whether or not an edge is
detected. The Plateau/Apex Threshold determines only the precise
reported location of a detected edge.

6. Min. Plateau Width: - Minimum Plateau Width defines the minimum horizontal
distance between rising and falling edges (or falling and rising edges). This is
used in feature detection to identify true features. (See also Quick Reference
Table 8.4 on page 8-33.)
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The Minimum Plateau Width can be used to reject such peaks that may
otherwise prevent the system from detecting the correct edge. For step-like
features, the Minimum Plateau Width specifies a plateau as follows:

¢ For ascending features (such as UpEdge, UpBase), the plateau follows the
detected edge.

¢ For descending features (such as DownEdge, DownBase), the plateau
precedes the detected edge.

Changing the Min. Plateau Width:

Double-click in its variable box to highlight the current number and type in the
new number:

¢ Use values between 0.005 and 1000.00 pum (0.0002 to 39.3701 mil.)
¢ Defaultis 10 pum.

* NOTE: This is very dependent on which Feature is chosen for
detection and which Feature Number is used.

HINT to successfully set the Plateau Width:
If setting the UpEdge, DownEdge, UpBase, or DownBase features:

¢ Set this value to be greater than the width of stray peaks, but
somewhat less than the width of the step to be detected (from
0.005-1000.00 mm to 0.0002-39.3701 mil.).

* NOTE: Setting the Plateau Width to wide results in no edge being
found.

The Minimum Plateau Width is not intended for use with Concave or
Convex features. In cases of rough sample surfaces, though, it might be
useful.

¢ For a Convex arc: The Minimum Plateau Width specifies a
minimum width for the feature, and so can be used to reject narrow
roughness peaks in the vicinity of the arc.

¢ For a Concave arc: The Minimum Plateau Width is used to specify a
minimum size for a level section following a detected arc.

* NOTE: The feature detection setup can be evaluated by reviewing

trace data in the analysis window. The parameter “ref” that is listed to
the left of the trace, indicates the position of the detected feature
relative to the start of the scan. If this parameter reads “0” then no
feature is being detected and the feature detection setup must be
altered.
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* NOTE: Itis important to set the thresholds appropriately for the type of

feature being scanning so that the Feature Detection calculation is
reliable. Also note that the profile scan length must include not only the
entire length of the artifact but enough on both sides to set cursors for
reliable data leveling.

7. Apply Gaussian Noise Filter Before Detection - This is only used to filter out
unwanted noise so the feature detection can more easily detect designated
features. (See Figure 8.38.) It does not apply the result to scan data. For use of
the Gaussian Filter with scan data, see Filters on page 3-50.

Figure 8.38 Scan Noise and the Gaussian Noise Filter

A Step scan with noise,

before applying the
Gaussian Noise Filter. \

A Step scan with noise,
after applying the Gaussia

Noise Filter. D\JL

Activating this feature, click in the empty check box to puta v in it. (See
Figure 8.39.) Then set the Filter Cutoff (mm) size.

Figure 8.39 Activating the Gaussian Noise Filter

r~ Feature Detection

Feature: IUp Edge 'l
Feature Number: |1
i i ) Slope Threshold : |1U.DD

To activate the Gaussian Noise

Filter Before Detection feature, Plateau Threshold:  [10.00

click in its check box. A check (v') . '

indicates that it is chosen. \ S D
¥ &pply Gaussian Noise Filter Before Detection
Filter Cutaff (um): B
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8.

Filter Cutoff (mm) - This option is only activated when there is a check in the
Apply Gaussian Noise Filter Before Detection check box. (See Figure 8.39.) The
number to be entered is in microns. This determines the noise level that is
filtered out.

For an in depth discussion on filters, see Fil/ters on page 3-50.
Changing the Filter Cutoff
a. Ensure that a Feature has been chosen.

Click on the down arrow to display its menu.

Click on the desired value.

* NOTE: A Feature must be chosen in order for the Gaussian Filter to

become active. If None is showing in the Feature variable box, The

Gaussian option is grayed out. To activate it, select a feature. (See
Figure 8.40.)

Step 8a. In order for the Apply
Gaussian Noise Filter Before
Detection, a Feature must be
chosen. The filter is not available
unless there is a feature chosen.

Step 8b. After a Feature is chosen, —®- | ¥ &pply Gaussian Maise Filter Befare Detection

put a check (v') in the check box by
clicking in it.

Step 8c. Click on the down arrow to

display its menu. Click on the
desired cutoff filter setting.

9.

¢ The Filter Cutoff range is from 0.25 through 800 um. Only established
variables may be chosen.

Figure 8.40 Filter Cutoff Menu

— Feature Detection

m UpEdge ¥

Feature Mumber: 1
Slope Threshold : 16.00
Plateau Threshald : 10.00

Min. Plateau Width . {10.000

Tk

Filter Cutaff [prm):

Figure 8.41 through Figure 8.43 demonstrate the usefulness of Feature
Detection. Three scans were taken across the same section of the feature,
beginning and ending at different points along the profile. Each time, the cursors
are automatically set in the same place relative to the feature being detected, at
the second UpBase.
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Figure 8.41 Feature Detection - Run 1 with Automatic Cursor Placement
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Figure 8.42 Feature Detection - Run 2 with Automatic Cursor Placement
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Figure 8.43 Feature Detection - Run 3 with Automatic Cursor Placement
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Feature Detection Quick Reference Table

Table 8.4 Feature Detection Variables

Feature

Description

Feature

Identifies the type of feature to be detected, or turns Feature Detection off.

Feature Number

Provides a way to select a particular edge for detection if there are multiple edges detected in
a scan.

Slope Threshold

Sets the value at which an upward slope in the trace is considered to be preceding the edge
or apex; that is, when an upward slope appears that rises significantly above the general
roughness of the surface.

Slope Threshold is very similar to a signal-to-noise ratio. The best values for a given sample
will depend on the relative scales of the artifact being examined and the surrounding surface
roughness, as well as parameters such as scan speed, sampling rate, and so on. For step
heights, 10 is a good typical value.

Plateau Threshold

Affects the precise horizontal location calculated for the edge or arc. Since the edge of a step
is rarely a perfectly defined location, this factor allows for the adjustment of the value to the
left or right, depending on whether the edge is to be the bottom of the step, the top of the step,
or somewhere in between. Generally, the best way to specify the Plateau Threshold is to set
the same value as the Slope Threshold.

Min. Plateau Width
(Hm)

This value specifies the minimum horizontal length between a rising and falling edge, which is
used in the feature detection calculation to determine the correct edge.

This is useful in preventing erroneous feature detection of spikes due to noise, particles,
rough surfaces, etc.
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SETTING THE CUTOFF FILTERS

Setting Cutoff Filters can be accomplished using “live” data or previously saved data.
“Live” data has not yet been saved, and the Analysis window is still open, displaying
the scan data from the current scan (i.e., the Analysis window has not been closed on
the current scan data).

The scan data does not come directly from the sensor, but instead is filtered through
three stages:

¢ an analog hardware filter

¢ adigital decimation filter

¢ digital software filtering

1.

The sensor output is filtered by the analog hardware filter so that it can be
digitized with minimal distortion. The filter also reduces noise by attenuating
higher frequencies. It has a fixed cutoff frequency of 2 kHz.

The signal then passes through an analog-to-digital (A/D) converter. The A/D
converter has a nominal sampling frequency of 31.25 kHz.

Next, the signal passes into the digital decimation filter. This step reduces the
signal sampling rate from the original31.25 kHz down to the sampling rate
selected in the recipe by the user.

The cutoff wavelength depends on the scan speed as described by the following
equation:

Scan Speed
Cutoff frequency of combined filters

Cutoff Wavelength =

For example, with a scan speed of 100 pm/s, and a sampling rate of 200 Hz or
100 Hz, the cutoff wavelength is 5.6 um. With this same scan speed, however, at
a sampling rate of 50 Hz, the cutoff wavelength is 7.1 pm.

The action of a cutoff filter can be illustrated by plotting the percentage of signal
transmission as a function of wavelength (usually plotted as the logarithm of
wavelength). Note that there is always some slope in the transmission curve of a
cutoff filter; that is, the transmission percentage is not exactly zero for all values
on one side of the cutoff value and exactly 100 for all values on the other side of
the cutoff value. The cutoff wavelength of a filter is defined by that wavelength
at which 50% of the signal is passed.
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Figure 8.44 shows the transmission curve of the combined analog and
decimation filters. For every factor of 10 in scan speed, the curve moves to the
right by a factor of 10 in wavelength.

Figure 8.44  Effect of the Analog and Decimation Filters On Signal
Transmission

100%

50%

Signal Transmission

MFCO Log Wavelength (A)

Setting the Short-Wave Filter Cutoff Values

See also the discussion on Short-Wavelength Cutoff Filters
Data can be filtered to provide the following specific results:

¢ Reduce the effect of small surface irregularities or environmental noise;

¢ Remove large-scale waviness and form error so that roughness can be evaluated
unambiguously;

¢ Isolate specific frequency bands, allowing determination of intermediate
components of roughness or waviness.

Long-wave, short-wave, or both filters can be used. Combining the short and long
wave filters forms a band pass filter that cuts off all short wavelengths below the
short-wave cutoff value and all long wavelengths above the long-wave cutoff value.

* NOTE: The software does not allow setting a short-wave cutoff that is
larger than the long-wave cutoff, which would result in a zero-width
band of wavelengths, attenuating all of the data (see Figure 8.45).

Figure 8.45 Defining a Band Pass With The Short-wave & Long-wave Cutoff Filters

———————————— 50%

Signal Transmission
(%)

i I
AAFCO Log Wavelength (A) ALweo
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The short wavelength cutoff or noise filter attenuates data with wavelengths below
the specified cutoff valve. This has the effect of removing noise from the data. This
filter is always active, set either to a specified or a default value.

Select the short-wave cutoff (or long-wave pass) filter.

This cuts off the short-wavelengths in the data; those short-wavelengths below the
filter’s cutoff value. (See Figure 8.46).

Figure 8.46 Effect of the Short-wave Cutoff Filter

Signal Transmission
(%)

MFCO ASWCO  Log Wavelength (M)

1. Go to the Recipe Editor, click Filters/Cursors to open its window. (See
Figure 8.47.)

2. At the Noise Filter (shortwave cutoff) variable field, click the drop-down arrow
to select a value from the range of cutoff filters provided. In this menu, the filter
can also be turned off by clicking the Off option in the menu. The chosen filter
appears in the variable field. (See Figure 8.47.)

Figure 8.47 Recipe Editor — Filters and Cursors Options

Profiler - [Recipe Editor - 13X13]
Recipe Options  Help

02| =& =2[F

Step 1 Click on the ~Fim
Fi Ite r/ Cu rsors button tO d|Sp|ay ScaDneI;:irSomnetel Filter Option: Gaussian Filter ¥
the Filter and Cursor options.
Feature Noise Filter
\ m [Short Wavelength Cutoff):
Filters . .
W Fill
Fursors (Long v svelongth Cucf:
Parameters ~ Cursar /' N

X1

W/ Left Measurement: IU_Uza IV
Step 2 To display the Noise —] HeRDokay Right Measwement[002¢  ooed

Filter menu, click on the High Spl Court Left Levek [ooze Jooxr
down-arrow next tot he — Right Level 2 Tz
iable field. Click to b
variable field. S— I Relative to Feature Detected
choose the filter or click on Anabet Fooks [ FitandLevel
Off at the top of the menu to
turn the filter Off.
[Substr. [Clear Status |
8-36 KLA-Tencor Confidential 0104396-000 AA

3/05



KLA-Tencor P-15 User’s Guide Analyzing 2D Scan Data - Setting the Cutoff Filters

Up to 22 standard settings (including the default) are available depending on the
scan speed. Entering a short-wave cutoff that is longer than the currently
selected long-wave cutoff, or shorter than the value of the analog cutoff is
prevented by the system. For scan speeds greater than 5 pm/s, the shortest
short-wave cutoff selection turns off the short-wave cutoff filter.

If subsequent changes to the scan speed or scan length cause the short-wave
cutoff setting to become invalid, the cutoff is automatically changed to the
nearest available valid value (possibly the default).

The default cutoff depends on the scan speed and sampling rate.

3. From the Filter Option variable menu, select from the following filters:
¢ Gaussian For Windows-based systems; and

¢ RC For comparison to scan data obtained with DOS-based systems, such
as the KLA-Tencor P-2 Long Scan Profiler.

Setting the Long-Wavelength Filter Cutoff Values

Select the long-wave cutoff (or short-wave pass) filter.

This cuts off the higher wavelengths in the data (those above the filter’s cutoff value,
see Figure 8.48).

Figure 8.48 Effect of the Long-wave Cutoff Filter

Signal Transmission
(%)

I’y
MFCo ASWCO  Log Wavelength (A) A weo

1. Go to the recipe window, click Filters/Cursors to open its window. (See Figure
8.49.)
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Step 1 Click on the

Filter/Cursors buttonto ——p»

display the Filter and
Cursor options.

Figure 8.50

Figure 8.49  Waviness Filter (Long Wavelength Cutoff Filter)

Profiler - [Recipe Editor - 13X13]
Recipe Options  Help

02| =& =2[F

Scan Parameter
Definition

Feature

Fiiters
Cursors

-

~ Filter

Filter Option:

Noise Filter
[Short Wavelength Cutoff):

‘Waviness Filter
[Long Wavelength Cutoff):

Gaussian Filter ¥

Step 2 To display the

-&— \\aviness Filter menu, click

off B

Parameters

Roughness
Waviness

Bearing Ratio
Cutting Depth

High Spat Count
Peak Count

3D Cursors

Setup
Analysis Tools

on the down-arrow next to

i~ Cursor

the variable field. Click to

Left Measurement: IU_UZd
Right Measurement: [0.024
Left Level:

Right Level:

[V Fitand Level

ID.024 ID.UZA
ID.UZ& ID.UZA

¥ Relative to Feature Detected

choose the required filter or
click on Off at the top of the
menu to turn the filter Off.

0.024

[Substr. Clear Status |

2. In the Waviness Filter variable field, click the drop-down arrow to select a value
from the range of cutoff filters provided. From this menu, the filter can also be
turned off by clicking Off in the menu. (See Figure 8.49.)

Up to 17 standard filter choices are available depending on the scan speed. A
long-wave cutoff that is shorter than the currently selected short-wave cutoff or
the value of the analog cutoff, is prevented from being entered.

If subsequent changes to the scan speed or scan length cause the long-wave
cutoff setting to become invalid, the cutoff is automatically changed to the

nearest available valid value.

Figure 8.50 shows the effect of different cutoff filter settings on the same set of

scan data.

Signal Transmission Curves And Their Effects On Scan Data

Signal Transmission Curve

Scan Data Effect

Description

c

2

o]

©

E

L

54 ‘/’

2%

H

=

” M g A3
Lzg Wavelength

[

Normal Data

M

e fo]

Only the analog filter acts on the data.
Three wavelengths, labeled A, A,, and A5,

are identified.
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Figure 8.50 Signal Transmission Curves And Their Effects On Scan Data

Signal Transmission Curve ‘ Scan Data Effect Description

B Roughness 1

f The long-wavelength cutoff filter is applied
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o ?u Y a features of the scale of A; higher

Lo Wavelenath wavelengths, including A, and A, are

suppressed.
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A different long-wavelength cutoff value is
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mmm The resulting data trace shows features of
9 [ the scale of A;to A,; higher wavelengths,
Leg Hariangth including A3, are suppressed.

Signd Transmssion
%

Roughness 3
A short-wavelength cutoff filter with a value
just higher than 1, is applied, in addition to

— — the long-wavelength cutoff, to the
; T f\f\JF\—/f AN Roughness 2 curve.
Log Wavelength The resulting data trace shows only
features of the scale of A,; higher

wavelengths, including A3, and lower
wavelengths, including A, are suppressed.

Signal Transmission
(54

5 Waviness 1
é The short-wavelength cutoff filter is applied
£E / with a cutoff value just lower than A;.
2 / /_\ The resulting data trace shows only
i " [ features of the scale of A5; lower
Log Hovelenaln wavelengths, including A, and A,, are
suppressed.
H Waviness 2
£ The short-wavelength cutoff filter is applied
Es’i with a cutoff value just lower than A,
= ""\_/d_f_" '
H fJ \—/"\\ The resulting data trace shows features of
7 n Ny A3 the scale of A, and A3; lower wavelengths,
Log Mavelangin including A;, are suppressed.
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2D GLITCH REMOVAL

Introduction

The 2D glitch removal is designed to remove erroneous data caused by environmental
noise or particulate contamination. The 2D glitch removal process is designed to
work in conjunction with the repurposed measurement cursors. The glitch removal
operates using a median point filter that can be set by user to either 1 x 3, 1 x 5, or

1 x 7 data points. (For more information on median filters, see Median Filter for 2D
and 3D Data on page 3-61.) The filter is reset with each new data set.

This procedure can be used with new unsaved data, saved data, and a 2D slice of a 3D
image.

Procedure

Figure 8.51 Analysis Screen with Operations Menu

Anabysia - Soquence Data Set. REC-D - [Scan Data. Skt 00, Site 81)

Sl Eke Edt Yew Diace Pusmetsin Qpeestiors Window Mol al®]x]

~Clear Statys | Cosvene 0

Emply?

1. Move the left cursor to the next position to the left of the glitch that models the
trace where the glitch occurs. Place the cursor’s left and right borders to include
the data set that is to be used to remove the glitch. (See Figure 8.52.)
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2. Move the right cursor to the next position to the right of the glitch that models
the trace where the glitch occurs. Place the cursor’s left and right borders to
include the data set that is to be used to remove the glitch. (See Figure 8.52.)

Figure 8.52 Analysis Screen with Operations Menu

Set the cursors on data

thatis a model for the glitch

i Anabysia - §eguence Data Set. REC-D - j3uas Data Slot 00, Site 81]
removal. In this case, the o

bottom of the trace.

—Clear Statys | Cosvene 0
Empty?

3. Right-click to display the Right-Click menu. (See Figure 8.53.)
Figure 8.53  Right-Click Menu - Remove Glitches Menu Options

Change »

XY View
Theta View

Log 10X Axis
Log 10 Z Asis

v Normal Data
EFT...
PSD...

Select Window Function...

Histogram...
Scan...
Surface Summary... 3 Paint Filter

7 Point Filter

4. Move the cursor over Remove Glitches Within Cursors to display its menu. (See
Figure 8.53.)
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5. Click on the required filter.(See Figure 8.53.)
The glitch is removed using the chosen filter. (See Figure 8.54.))

Figure 8.54  Analysis Trace Window with Glitch Removed

unabysia - Sequence Data Set. REC-D - [Scan Data Slot B0, Site B1)

Sl Eke Edt Yew Diace Pusmetsin Qpeestiors Window Mol al®]x

~Clear Statys | Cosvene 0

Emply?

MEASURING THE RADIUS ON CURVED SURFACES

The average radius of a circular segment defined by the measurement cursors is
calculated from a data set using the least squares fit method. This method is capable
of high precision, covering a range from 0.5 pm (20 pin.) to 200 mm (7.9 in.),
provided that the sample fits on the stage.

The radius of the measurement stylus is added to the sample radius in the
measurement. The following sample might be:

¢ Acceptable Where the radius of a 2-um stylus added to a 20-mm radius sample
might be considered negligible (0.01%),

¢ Unacceptable Where a 5-pum stylus added to a 1-mm radius is a 0.5% error,
which is generally unacceptable.

This can be avoided if the instrument is calibrated with a high precision
cylindrical standard whose radius is within a factor of 5 of the sample to be
measured. This is the Radius of Curvature calibration. For the highest accuracy,
KLA-Tencor recommends that this calibration is performed by a trained
technician.
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1. Go to the Scan Recipe Editor and click on General Parameters. Step 1 (See
Figure 8.55.)

Figure 8.55 3D General Parameters - Recipe Editor

Step 1 In the Recipe Editor,
click on the General
Parameters button to display
the 2D General Parameters
in the Information Display
Window.

Step 2 Click in the empty
check box next to Radius
so the radius information is
displayed in the Analysis
screen, in the Surface
Parameter Summary
window.

2. Click in the check box next to Radius to enable the radius measurement and
display the results in the Analysis screen. (See Figure 8.55.)

3. If measuring other types of samples with no required radius measurement,
disable the radius measurement by clicking on the check mark (v') in the check
box so that the check box is left empty.

Measuring for Maximum Precision

1. The height of the measured arc should be no more than 77% of the vertical range
of the measurement head.

Measurements can be made up to 90% of the vertical range of the measurement
head in arc height but precision of the scan cannot be certain. (See Figure 8.56).
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2. The size of the included angle should be no more than 90°.

Measurements can be made up to 110° in included angle with a small loss of
precision. (See Figure 8.56).

These limits depend on the type of measurement head being used.
Figure 8.56 Arc Segment Dimensions

— L -

oo

R

Included angle up to 90°

3. To measure another portion of the radius, physically rotate the sample about the
radial axis.

Precise measurement is also restricted to arc segments that are symmetric to the
radial axis of the measured artifact.

4. To measure using a given radius R, optimum arc height H (Figure 8.56), and the
optimum scan length L, use the following formula:

L =2J2RH-H?

Scan length and scan speed are dependent on the radius of the sample, the arc
height allowed by the measurement head, and its vertical range.

* NOTE: Scans taken at the lowest possible horizontal resolution for the
optimal scan length generally yield the most repeatable and precise
radius measurements.

Measuring for the Lowest Horizontal Resolution
Various combinations of scan speed and sampling rate can be experimented with.

1. Set the sampling rate to 200 Hz.

2. Set the scan speed to get a scan time that is as close as possible to 25 seconds
without exceeding it.

3. Ifthe longest scan time possible under these restrictions is 12 seconds or less:
a. Set the sampling rate to 100 Hz.

b. Set the scan speed so that the scan time is as close as possible to 50
seconds without exceeding it.
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4. If'the arc height H is less than 40% to 45% of the range available for the
measurement head, the recommended profile type is the center bias profile type

.
5. Set the stylus force high enough for the stylus to reach the lowest points of the
scan.

The stylus force needed depends on the arc height A and on the profile type
(peak, valley, or center bias).

a. If, during radius measurement, the trace flattens out and no data out of
range message appears, try a higher stylus force setting.

Measuring with a 1-c Repeatability (precision) of 0.002% of
the Radius

1. Do not set both leveling cursors to zero.
2. Preset the position of the measurement cursors.
Ensure that the following parameters are properly set. (See Table 8.5).

Table 8.5  Scan Recipe Parameters

Recipe Field Setting

Scan Length See changing X Scan Size.

Scan Speed See changing Scan Speed

Sample Rate 200 Hz is optimum. See Sampling Rate.

Surface Parameters Use the General Parameters window in the Recipe
Editor to enable Radius and Distance to Edge.

Stylus Force See Applied Force.
Profile Type See Profile Type.
Vertical Range See Range/Resolution.

3. To measure a convex radii:
a. Go to the Scan Recipe Editor.

b. Click on the General Parameters button
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c. Ensure that there is a check (v') in both the Distance to Edge and Radius
check boxes. (See Figure 8.57.)

Figure 8.57 General Parameters - Recipe Editor

Step 3b. In the Recipe
Editor, click on the General
Parameters button to display
the 2D General Parameters
in the Information Display

Window. o
Step 3c. Click in the empty

check box next to Radius and
Distance to Edge so that
information will be displayed in
the Analysis screen, in the
Surface Parameter Summary
window.

L]
u
u
]
Vv
L]
]
L]
L]
Vv

i

d. From the Recipe Editor click on the Feature Detection button to display the
Feature Detection options in the Information Display Window. The display
is shown in Figure 8.58.

Figure 8.58 Feature Detection - Recipe Editor

Step 3e. Click on the

down-arrow next to the
Step 3f. Scroll down to the Feature variable box.
bottom of the menu. Click on
Convex from the drop-down

menu.

e. Click on the down-arrow next to the Feature variable box. The menu is
displayed.
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f. Scroll down to the bottom of the menu. Click on Convex.
The cursors automatically adjust.
4. To measure with 0.002% repeatability, adjust the measurement cursors in the

Analysis window until the height values for the cursors are equal within 0.5 pm
(20 pin.) for radii larger than 2.5 mm (0.1 in.).

MEASURING STEP HEIGHT ON CURVED SURFACES USING FIT AND LEVEL

Step height can be measured on curved surfaces such as lenses or glass optical fibers,
or in a bow in a profile that has been leveled in the normal manner. This capability is
enabled or disabled in the Scan recipe.

f NOTE: The Profiler application can remove a simple convex or
concave curve from the data, but not more complex curves like waves.

1. From the Recipe Editor click on the Filters/Cursors button. This displays the
Filters and Cursors options in the Information Display Window.

Figure 8.59 Cursor Options - Filters/Cursors - Recipe Editor

r— Cursors
1 w2
Left Measurement: |1IJ_DDD |5[].EIDEI
Right Measurement: [450.000 f430.000
Left Level: [10.000 f50.000
Right Level: |450.000 |450.000
Step 2 Click on the empty
check box next to Fit and \ [~ Relative to Feature Detested
Level to enable it. [+ Fit and Level

2. Inthe Cursors portion of the display, check the Fit and Level check box. (See
Figure 8.59.)

3. Save the changes.

SAVING SCAN DATA

Scan data can be saved for reviewing at a later time. This is especially important
because the data that is saved can be reanalyzed at a later date using different scan
parameters.

1. Click on File in the Menu Bar to display the File menu.
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Step 4 From the drop-down
menu, click on the desired drive
and directory.

Step 5 Double-click on the folder —»~ | capture

in which the data is to be saved.

2. Select Save Data.

The Save Scan Data dialog box appears. (See Figure 8.60).

Figure 8.60 Save Scan Data Dialog Box

Save Scan Data

Save in; | 4 scandata .

— — Step 3 Click on
1 Alpha Test the menu arrow
[_J Apps Test

to reveal the
available drives
and directories.

Step 6 Enter the name bein i y
P g _ﬂ"ﬁf IgDDd data Save - Step 7 Click

given to the new data set.

Save as type: [Scan Data Files [ dat) [ Cancel Save to save the
data to the file.

Pl

Help

Click on the menu arrow next to Save In to reveal the available drives and
directories. (See Figure 8.60)

Select the drive and directory from the drop-down menu. (See Figure 8.60)

Double-click on the folder that the data is to be stored in. A list of all current
data files appear. (See Figure 8.60)

Enter a name for the data set in the File name variable box. (See Figure 8.60)
Click Save to save the data in the new file. (See Figure 8.60)

Once a data set has been saved, it is added to the Scan Data catalog. The Scan
Data catalog window allows selection of individual data sets for reviewing.
Unwanted data sets can be deleted.

REEVALUATION OF SAVED 2D ScAN DATA

The version 6.2 software provides a the user with an opportunity to review scan data
that was saved and to change parameters in the scan recipe for recalculation of the
data. This is possible because the system saves the raw scan data from the scans.

The recipe determines which parameters are calculated in the Analysis screen’s
Statistics window after the scan. Once the data is saved, it can be revisited in the
Catalog screen. The general procedure is as follows.

1.

N o~

Access the Catalog screen.

Choose either the Scan Data or Sequence Data windows.

From the Scan Data window, navigate to the data set that is to be recalculated.
From the Sequence Data window, choose a sequence.

Double-click the scan data set. This opens the Analysis screen for the data set.
In the analysis screen, click on Edit to display its menu.

Choose Recipe. This opens the Recipe that was used to create the original scan.
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8.

Step 9 Click on the Analysis —

icon in the tool bar to return
to the Analysis screen.

10.

11.

12.

13.
14.
15.
16.
17.

Change the parameters that require addition or removal. This is accomplished by
opening each parameter window and choosing the new parameter to be included
in the analysis statistics or removing parameters no longer required.

The following parameters can be edited:
Feature Detection
Filters and Cursors
General Parameters
Roughness and Waviness
Bearing Ratio/Cutting Depth
Automatic Histogram Leveling

The Scan Parameter Definition cannot be edited.

After all changes have been made, click on the Analysis icon in the tool bar to
return to the Analysis screen.

Figure 8.61 Scan Recipe Tool Bar for Analysis Editing

The Analysis screen returns with the statistics in place in the 2D Surface
Parameter Summary window. There is no need to recalculate this information
because the system automatically does that when it regenerates the Analysis
screen.

If there are any manipulations to the image that are being done, click in the 2D
Data portion (the window with the 2D image) of the Analysis screen to make it
active.

Adjustments that effect the parameters are cursor placement or leveling. Change
these if required.

In the Analysis screen click the CALC button \ﬂl to perform a recalculation
of the statistics for the new cursor or leveling.

To save the data, click on File to display its menu.

Choose Save Data... to open its dialog box.

Navigate to the correct folder in which the data is to be stored.

Name the file.

Click on Save to save the data in the folder.
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ANALYZING 3D SCAN DATA

INTRODUCTION

The 3D scan data analysis displays the 3D scan image and trace information after a

scan is completed. A 3D scan is an image built by taking a series of 2D scans,
arranged in a raster pattern, to form a picture of the sample surface at the scan
location. With 3D analysis, complete surface analysis can be performed.

This chapter describes:

*

*

*

Starting the 3D Analysis Application on page 9-2

3D Analysis Screen Features on page 9-3

Line-by-Line Leveling on page 9-33

Customizing the Scan Image on page 9-40

Changing the View Angle on page 9-41

Customizing the View on page 9-42

Using Image Arithmetic to Compare Data on page 9-43
Saving Scan Data on page 9-45

on page 9-50
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STARTING THE 3D ANALYSIS APPLICATION

1. Click the Scan Data or Sequence Data command button to display the data
information in the Catalog window. (See Figure 9.1.)

Figure 9.1 Scan Catalog Screen with Scan Data Active.

Profiler - [Catalog] [x]

FEile Edit Sample Yacuum Host Diagnostic Tasks Help

& | sma| & @ | @] @ | 2030 )

Scan Data Name:

Scan [BOTTOM-1
Recipe
Scan Data Path:

Scan Data

Recipe ID Length Y Size Creation Date

Step 1 Click on the Scan um) um} {owyy-mm-dd)
Data button to display the > = SCANDATA ) =l
L. [t Eontseaiisst T o o T
Scan Data list in the wiatop-.. | 2042098 . S0 26 1999-10-23
. . ) right—1 20X205AH . 50 13 1999-10-23
information window. top-1 20X20SAM... 50 48 1999-10-23

Step 2 Click on the 3D
button to display the 3D list
in the information window.

Step 3 Click to choose

the required data folder.
Drive:
Hc -
Thumbnails | BReview
2. Click the 3D button. (See Figure 9.1.)
Figure 9.2 Scan Catalog Screen with Scan Data Active.
Profiler - [Catalog] [x]
File Edit Sample Yacuum Host Diagnostic Tasks Help
éﬁ|ﬂm|é¢}éf® x| @ zn|3D @
Scan Data Name:
BOTTOM-1 4
Rse'-;:?;e I &
Scan Data Path: ScanD. Recipe ID Length ' Si Creation D.
can Data Patl can Data ecipe en’ﬁl ize leatl.nn .ate F@
Scan (= SCAN DATA & ot to: 2 50 g 999-10-23 ¢Th
- ?ﬂ left-1 L |
mid-top—... 20X20SAM... S0 26 1999-10-23 .
right-1 20K20SAM. .. 50 48 1999-10-23
P top-1 20X20SAM... 50 48 1999-10-23
ZZquence .
Step 4 To open a data Hecie
set, highlight one required
data set. Sequente
Step 5 To open the
chosen data set, click on \

Review.
= -
Thumbnails I
|SCAN DATA CATALOG [Sample Clear Status |
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3. In the Scan Data Path column, click the folder name. (See Figure 9.1.)
4. In the Scan Data list, click on a data set to be analyzed. (See Figure 9.2.)

5. With the data set highlighted, click the Review button. The Analysis window
appears. (See Figure 9.3.)

Figure 9.3 3D Analysis Screen with 3D Object Displayed

Analysis - [3D Data: spo_10_29_99] [X] Additional
Menu Bar — —|Fic Edt View Parameters Operations Data Took Mindow (I =18 x|

Ao f]miefo]e]ol (alalo]oly [M]v]n] Command

Buttons

Toolbar Length: 10.000 pm
Speed: § mis
Direction ->
Buttons # of Traces: 21
Force: 0.05 mg
Zoom: 100 %

Position

Trace o
Right 6.2 pm

Information Top  70um

Bottom 2.0 pm

Height -3015.3 A

Image — |
Display

000 100 200 300 400 500 600 700 200 900  10.00

|SEQUENCE RECPECATAOG . |Emw? [ ClearStaws |
3D ANALYSIS SCREEN FEATURES

Analysis Screen — Image Orientation

The image in the Analysis Image Display area can be rotated to orient it for analysis
and viewing. Four options exist for rotation of the object. All four are presented, with
the Recommended procedure coming first.

Recommended Image Option 1 — Automatic Image Rotation. Use the Image Rotation buttons in the tool
Rotation Procedure  bar. (See Figure 9.4) These are Automatic Image Rotation buttons, described in
Table 9.1.

Figure 9.4 Analysis Tool Bar Image Rotation Buttons

@|a|wa|sms| @ | 2| S| o]z |lalale w1 ]| »]
\/\/\/

Automatic Image Rotation Buttons Manual Image Rotation Buttons
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Table 9.1

Automatic Image Rotation Buttons

Button

Description of Action

[

Rotates the image to the left on its horizontal plane. Each click moves
the image a small distance. (Identical to the left arrow key.)

2

Rotates the image to the right on its horizontal plane. Each click moves
the image a small distance. (Identical to the right arrow key.)

e

Rotates the image in a backward roll. Each click moves the image a
small distance. (Identical to the up arrow key.)

5

Rotates the image in a forward roll. Each click moves the image a
small distance. (Identical to the down arrow key.)

Option 2 — Manual Handle Drag. There are also Manual Image Rotation buttons,
described in 7able 9.2.

Table 9.2

Manual Image Rotation Buttons

Button

Description of Action

&

©

Rotates the image on its horizontal plane using four handles that are
manipulated by click-and-drag method. (See Figure 9.5.)

5

)

Rotates the image on its horizontal plane using a single handle that is
manipulated by the click-and-drag method. (See Figure 9.5.)

1. Click on the button representing the plane in which the required rotation is to
take place. The image appears to have handles attached to it. (See
Figure 9.5)

9-4
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Click on the button
representing the required
plane of rotation.

With the particular angular
rotation button clicked, click
on one of the four handles
and hold the mouse button
down while dragging the
image in the chosen
rotation plane. Release the
button to terminate the
rotation.

2. Click on one of the handles (see Figure 9.5) and, while holding down the mouse
button, drag the image to rotate it to a different orientation in the chosen plane.
Release the mouse button to set the image in its new orientation.

Figure 9.5 Manual Image Rotation Handles

| Analysis - [3D Data: spo_10_29_99] [X]
| File Edit View Parameters Operations Data Tools Window Help =& x|

levave | m 1 a1 o o o 1 -~ 1 ( )
2o el a oot o ([0 o |l (M ]
Recipe: ) S—

10X10

Length: 10.000 pm

Speed: § pmis

Direction ->

# of Traces: 21

Force: 0.05 mg

| Zoom: 100 %

SEQUENCE RECIPE CATALOG Empty? [Clear Status |

Option 3 — Arrow Keys. Use the arrow keys on the keyboard. The movement
provided by each key is described in Table 9.3.

Table 9.3  Image Rotation Using the Arrow Keys

Button Description of Action

¢ Rotates the image to the left on its horizontal plane. Each click moves
the image a small distance. (Identical to the left rotation button.)

Rotates the image to the right on its horizontal plane. Each click moves

> the image a small distance. (Identical to the right rotation button.)
Rotates the image in a backward roll. Each click moves the image a
+ small distance. (Identical to the up rotation button.)
Rotates the image in a forward roll. Each click moves the image a
* small distance. (Identical to the down rotation button.)
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3/05

KLA-Tencor Confidential 9-5



Analyzing 3D Scan Data - 3D Analysis Screen Features KLA-Tencor P-15 User’s Guide

Option 4 — Rotate Image Menu. Use the Rotate Image menu rotation options. The
rotation provided by each menu item is identical to that provided by the representative
arrow key (cited next to each option) as described in 7able 9.3, and the related Image
Rotation button described in 7able 9.1.

Figure 9.6 Image Rotation Using the Rotate Image Menu

STEP 1 Click on View to el ,
display the View menu. Select Yiew 3 STEP 3 Click on the desired
Rotate Irrage Right Right Amrow / rotation. The rotation takes

_ : Left  Left dmmow place immediately, moving
STEP 2 Click on Rotate ;mmg‘VSf” ' El Up  UpArow same distance that each
Image to reveal the Rotate oom Qut View S\ Down DownAnow -

= Manual Image Rotation

Image menu. Histagram... D

Highlgh.. button moves the image.

Eurrent Slice...
Surface Summary...
Sequence st

Correlation Sear.,

Table 9.4  Rotate Image Menu Options (From View Menu)

Menu ltem Description of Action

Rotates the image to the left on its horizontal plane.

Left  Left Arrow R . . .
This action only move the image one increment each
time. The menu must be opened again for each move.
Right Right Arrow Ro'tates.the image to the right on its hprizontal plane.
This action only move the image one increment each
time. The menu must be opened again for each move.
Up  Uphuow Rotates the image in a backward roll. This action only

move the image one increment each time. The menu
must be opened again for each move.

Rotates the image in a forward roll. This action only
move the image one increment each time. The menu
must be opened again for each move.

Down Down Arraw

Use the Mouse Tool in the Right-Click menu.

1. Right-click to display the Right-Click menu. (See Figure 9.7.)
Click on Mouse Tools to display its menu. (See Figure 9.7.)
Choose Rotate Image from the Mouse Tools menu. (See Figure 9.7.)

oD

Choose the required rotation from the menu. This menu is the same as the
Rotate Image menu from in the View drop-down menu in the Menu Bar. (See
Figure 9.6 and Table 9.4.)

Each click moves one increment only. The entire menu process must be
completed for each single movement.

9-6 KLA-Tencor Confidential 0104396-000 AA
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Step 1 Right-click the
mouse button to open the
Right-Click menu.

Step 2 Click on Mouse
Tools to display its menu.

Figure 9.7  Right-Click Menu — Mouse Tools

Enable Analysis Tools

Rotate Image

»

»

Zoam | ool 2

/ Crozs Section Toal »
Leveling Tools 3

Highlight...

L -~ s
View Lument Jlce...

Change Light Botation
Change Light Rize
Change Light Distance

Hemove (Eltches

Move Highlight Planes

Recalc |

Graphics Buttons and Their Function)

Figure 9.8 Analysis Tool Bar Graphics Buttons

Step 3 Click on Rotate
Image to display its menu.

@la|waljsms| & | S| S |6 |2 [R][QA| [ | |8 [w | w]

Automatic and Manual Image Rotation Buttons

The Automatic and Manual Image Rotation buttons are displayed in Figure 9.4. They
are discussed beginning in Analysis Screen — Image Orientation on page 9-3 and
explained in Table 9.1 through Table 9.4.

In general, the automatic rotation buttons move the image in the depicted direction by
one increment of movement each time they are clicked on. The manual rotation
buttons place handles on the image to allow it to be moved in the indicated direction.

Zoom Features

The Zoom features are designed to facilitate zooming in on a portion of the 3D
graphic for closer inspection. The zoom can be accomplished through the use of

several zoom tools.

¢ The View menu contains zoom features.

¢ The tool bar contains zoom features shaped like magnifying glasses.

¢ The Right-Click menu contains zoom tools.

The following explanation demonstrates the use of the zoom tools in the most
efficient manner. Other combinations of zoom tool usage exist, but this combination

should be the simplest.

1. Inthe Analysis screen, click on the Tool Activation icon LI at the top of
the tool bar on the right side of the screen. This activates (enables) the side tool
bar tools. (See Figure 9.9.) When the side tool bar is activated, the graphic
image is changed to top view.
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Figure 9.9  Analysis Screen - Tool Activation

[ x]
=181 x|

‘| Analysis - [3D Data: center-1]
| File Edit View Parameters Operations Data Tools Window Help

alajeajms|&lo|s|a]|elajalo|e s [M[s]w]

Recipe:
203205 AP L.
Length: 40.998 pm AT
Speed: 2 pmis
Direction -> \
# of Traces: 9 5
Force: 0.05 mg .
Zoom: 100 %
. Vs
Step 1Clickonthe — |
Lk . . ®
Tool Activation
button to activate i
—— thetool. Active tools
are red and black. o
27 Th
G oh
Tools after activation.
SEQUENCE DATA CATALOG Sample Clear Status |

2. Place the cursor over the graphic display and right-click to display the tool

menu. (See Figure 9.10.)

Figure 9.10 Analysis Screen - Enable Zoom
‘I Analysis - [3D Data: center-1] [X]
| File Edit View Parameters Operations Data Tools Window Help 1= x|

Tool

(@lQILEVEL'SIATSI@'dlbl&l{’flglglgIQ}I})I\II(\|%I

Recipe:

Mouse Tools
Zoo ol

Cross Section Tool
Leveling Tools

205208 AMPL.... >
Length: 49 998 pm

Speed: 2 pmis

Direction -> &

# of Traces: 9 5 — N\ |
Force: 0.05 mg Enable Analpsis Tools \
| Zoom: 100 % Select View —

Notice that the 3D image is
changed to the top view when
the tools are enabled.

BRecalc

000 500 1000 1500 2000 2500 30 4000 4500 50.00

¥ (pm)

Sample? [Clear Status |

N

With the tools enabled, and
the tool menu open

Step 3 Move the cursor to
Zoom Tool which displays
its menu.

Step 4 Move the cursor
over Enable Zoom Tool
and click. A check appears
next to Enable Zoom Tool.
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3. In the tool menu, move the cursor over Zoom Tool to display its menu. (See
Figure 9.10.)

4. Click on Enable Zoom Tool to activate the zoom process. (See Figure 9.10.)
Figure 9.11  Analysis Screen - Zoom Active
| File EditNYiew Parameters Operations Data Tools Window Help =181x]
a(laufsm@lolc|elrlalalolols (5[ [»]
i 4,868y |
et &
R 2
Step 5 When zoom is active, : <
the Zoom In magnifying glass N :n:m o n
icon is enabled. It zooms in on o e 3500 =
. . Bottomn 0.0 pm
whatever is outlined by the ’ X
Zoom box. LD
When zoom is active, a Zoom
box is displayed at the bottom
. — e
left corner of the 3D graphic
dISplay' 30.00 3500 4000 4500 50.00
Sample? [Clear Status |
5. When the zoom process is activated, the Zoom In magnification glass is
activated and the Zoom box is deployed at the bottom left of the 3D graphic
display. (See Figure 9.11.)
Figure 9.12  Analysis Screen with Zoom Box
| File Edit View Parameters Operations Data Tools Window Help =18 x|
2lafmms|&|oc[a|r][a[a]o o[ [M]%]s]
ZR;;;'I’:S:MFL
Length: 40.998 pm
Speed: 2 pmis
Direction ->
) Foree-.02:mg
Zoom box relocated to the intended  [zeom: 10 % Enable Anabsic Toos
Zoom area. Eige  Postion e

Mouse Tools
Left 0.0 pm
Right 22.1 pm 9
Top  48.0pm L 5.00 i Cross Section Tool
. Bottom 18.0 pm Leveling Tools »
Step 6 Click hold and drag the Highlight..
upper right corner to the top right Flemave Gitches

corner of the intended zoom area. : Recalc

fiew Curent Slice

Step 6 Click hold and drag the
lower left corner of the Zoom box_—
to the lower left corner of the
intended zoom area.

000 500 1000 1500 2000 2500 3000 3500 4000 4500 50.00
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6. A good way to position the Zoom box is, click and hold on the top right handle
(boxed corner) of the Zoom box and position it where the top right corner of the
intended zoom area. Repeat the process with the bottom left corner, placing it at
the bottom left corner of the intended zoom area. (See the intended zoom area in

Step 7 Click on the Zoom Iniicon to
zoom into the boxed area.

Zoom box relocated to the intended
Zoom area.

—==

Figure 9.12.)

Figure 9.13  Analysis Screen — Using the Zoom In Icon

| Analysis - [3D Data: center-1] [X]
| File Edit View Parameters Operations Data Tools Window Help 1= x|

afl a Jefsms| & 2| o ||z [a]ale (o [% (s [%[~]
[Reg

APL...
: 49,998 pm

Speed: 2 umis

Direction ->

# of Traces: §

Force: 0.05 mg

Zoom: 100 % Enable Analysis Tools

Edge  Position Select View

Mouse Tools

i3 - B Zoom Tool

Right 221 pm e

Cross Section Tool

Top  43.0m
Bottom 18.0 pm

Leveling Tools Ui 3&,\

urrent Slice

e [Elitches

ALTERNATIVE to the
Zoom icon - Move
cursor to Zoom Tools
to display its menu,
then click on Zoom.

500 3000 3500 4000 4500  50.00

X (um)

Sample? [Clear Status |

7. When the Zoom box is positioned as the boundary of the intended zoom area,

Working with a Zoomed
Image

click on the Zoom In icon | Q l in the tool bar. (See Figure 9.13.)

The 3D graphic image changes, displaying only the bounded area within the
Zoom box. (See Figure 9.14.)

ALTERNATIVE procedure for activating the zoom to display the area within
the Zoom box:

a. Right-click to display the Right-Click menu. (See Figure 9.13.)
b. Click on Zoom Tools. (See Figure 9.13.)

c. Choose Zoom. (See Figure 9.13.)

While in the view containing the zoomed image, all the procedures contained in
the right side tool bar can be executed on the image. The Level, Slice, Height,
Step Height, and Glitch Removal, all function the same way with a zoomed
image that they do with a standard top view image.

While in the view containing the zoomed image, it is not possible to zoom in
further. To zoom in closer, return to the original image and repeat the zoom
procedure using a smaller area within the Zoom Box for the zoom image.

When the Zoom In procedure is complete, the Zoom Out icon is activated to
allow the User to return to the pre-zoom image. (See Figure 9.14.)
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Figure 9.14  Analysis Screen — Zoomed In Area

| Analysis - [3D Data: center-1]

| File Edit View Parameters Operations Data Tools Window Help
@|afprfms|&|olo|elr|alalolols[d]w]n]
Recipe:

20120 AMPL.
Length: 49.998 pm

Step 8 When the Zoom In Deesion
. # of Traces: 9
procedure is complete, the [0
Zoom Out icon is activated to

allow the user to return to the
pre-zoom image. The Zoom

In icon is deactivated.

Sample? [Clear Status |

8. To return to the pre-zoom image, click on the Zoom Out icon. The image
returns to the prior display. (See Figure 9.14.)

ALTERNATIVE: (See Figure 9.15.)
a. Right-click on the graphic display area to display its menu.
b. Move the cursor to Zoom Tools, to display its menu.
c. Choose Unzoom and click. The image returns to the prior display.

Figure 9.15  Analysis Screen — Unzoom Using Right-Click Menu

Analyis - 130 Dta: conte [ Step 8b. Move the cursor to Zoom Tools to
display its menu.

Step 8c. Click on UnZoom.
N " Enable Analysis Tools

i: Tecls Select View
pa— _ Mouse Toolks

7 ,_ Enable Zoom Tool
Cinas Section Tonl Z
|| Levelg Tooks -

Cross Section Tool
Leveling Tools 3

Highlight

Step 8a. Right-click to display
the Right-Click menu.
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Table 9.5

Analysis Screen Toolbar Button Functions

Analysis Toolbar Buttons

Button

Description of Action

Q]

Zoom In on the area bounded using a zoom box to form the boundary. This is for use with the Zoom
Box. This icon is used as a trigger to execute zoom of the data according to the parameters set using
the Zoom Box.

Procedure: (See procedure as described beginning with STEP 1. on page 9-7.) The following is an
abbreviated version of the procedure.

1. Click on the Hammer I in the Analysis Tool box to enable the Analysis Tools.

2. Right-click to display its menu.

3. Move the cursor to the Zoom Tools.

4. Click on Zoom in the Zoom Tools menu.

5. Adjust the size and position of the zoom box so it forms the boundary of the area to be zoomed.
6. Click on the Zoom In icon | Q | to zoom to the area bounded by the zoom box (or click on

Zoom in the Tools menu - as illustrated below).

/ Enable Tools [Top View] |

. Disable Tools
1. Click on Tools to

i . Analysis Tools »
display its menu. ¥l el »

Zoom Tool

Cross Sectiors Tool

2. Click on Zoom e,

Tools 3. Click on Enable 4. Click on Zoom
Zoom Tool to enable
the Zoom In icon.

o

Zoom Out tool. This returns the image to its pre zoom magnification. This tool works with the Zoom In
tool described above. It is for use after zooming in on a bounded area. (See STEP 8. on page 9-11.)

LEVEL |

LEVEL icon. This is for use with the three point leveling tool. It is used as a trigger to execute
leveling of the data according to the three vertex positions set using the Leveling Tool.

Procedure:

1. Click on the Hammer » l in the Analysis Tool box (on the right side of the image), The

Analysis Tools are enabled.

2. Click on the Leveling Tool ", I The LEVEL icon LE’FELl is enabled.

3. Use the click-and-drag procedure (click on the center of each vertex) to position them. (For more
information on the procedure, see Activate Leveling Tool on page 9-15.)

4. Click on the LEVEL icon LE'-IELl to complete the leveling procedure.
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Table 9.5  Analysis Toolbar Buttons (Continued)
Button Description of Action
STATS Statistics information box. This displays the statistics information box on the screen, usually beneath

the analysis image. The positioning can be manipulated.

Print. This causes the system to print the analysis information.

Positive Magnification. This causes the entire image to be magnified by one increment each time it is
clicked on. The image continues to grow in size, having its outside edges cropped as its size increases
past the image area of the screen.

Negative Magnification. This causes the entire image to be reduced in magnification by one
increment each time it is clicked on.

The following three buttons activate the Ray Trace Mode and allow the user to illuminate the surface with a light source from
different angles. The Spotlight effect has been used in the following graphics to illustrate the lights distance and direction. The
spotlight was activated for the illustration and, if on, can be tumned off for complete lighting of the surface, while maintaining
directional integrity of the lighting process.

2

NOTE: For the three following buttons it is important to remember that the light can be moved over
and over, through a series of different locations and angles. Each time a different light button is
chosen, the light moves differently depending on its beginning position and angle. The following
descriptions are designed to give general guidelines for moving the lights. Light angles, beginning,
and ending positions vary depending on the position and angle that the light is in when the next button
is clicked.

Change light rotation... This shines a light on the image from the beginning location and angle of the
light. User can rotate the light source in a horizontal plane, parallel to the image surface.

The light projection swings from left to right in the illustration above.

0104396-000 AA KLA-Tencor Confidential 9-13
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Table 9.5  Analysis Toolbar Buttons (Continued)

Button Description of Action

Change light rise... From the starting location and angle, the light moves in an arc over the image
g | surface (like a sunrise/sunset).

The light swings from centered above toward a lower left side angle.

Change light distance... From the starting position and angle of the light, the light moves closer or
b | further from the image at the current angle.

The light moves from high left to a lower position near image center.

Move highlight planes... This moves each highlighted plane for visibility. Up to 10 planes can be
N | identified for viewing.

Analysis Screen Side Toolbar Buttons

These buttons, located at the right of the image, are active in the Top View only
(looking directly down on the image surface). (See Table 9.6).

Analysis Screen Side Toolbar Button Functions

Table 9.6  Analysis Side Toolbar Buttons

Button Description of Action

Enable Analysis Tools (Top View). This button enables the remaining tools in this tool bar. It moves
> | the image to the Top View because all the tools require this view.

Disable analysis Tools. This button disables active tools. This includes the tools in this tool bar as well

9 | as those in the top tool bar.
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Table 9.6

Analysis Side Toolbar Buttons (Continued)

Button

Description of Action

N

Activate Leveling Tool. This button activates the leveling tool that places three interactive boxes on
the image surface for leveling the image. Each box represents a corner of the leveling triangle.

Procedure:

1. Click-and-drag the center of the boxes (labeled vertexes in the data column at the left) to
locations on the image surface that are to be used as leveling points. The information in the
square is averaged to form a height for leveling that point in the triangle.

2. If desired, use the handles at the corners of the squares to resize the squares so the surface
bounded by each vertex creates the average desired height for that point.

* NOTE: It is very important that the area covered by each box is on the same

plane. In addition, the contents of all three boxes must also be on the same
plane, or the image is not properly leveled and the image itself could become
distorted. Boxes 1 and 2 in the illustration below are too large to properly level
the image.

3. Click the LEVEL button LE'-fEl-l on the top tool bar to level the image.

130 Data: pregeid]

Sbie £ Yo Pasmsien Qomolors Qla Lok Window =21zl Each leveling box must be

sl Slololslolalalo ey placed in an area containing
data that is on one plane. All
three boxes must be on the
same plane for the leveling to
be accurate.

Boxes 1 and 2 contain
data on more than one
plane and will produce
inaccurate leveling.

Each box has its location
statistics displayed in the data
column, to the left of the
image.

Activate Height Tool. This button activates the tool that places a box on the image surface. The box

L7 Th borders an area containing data that is averaged to give a single average height of the contents of the
box. Using the center of the box, it can be moved using the click-and-drag procedure. The handles at
the corners of the box can be used to change the area of the box. The data is automatically calculated
as the box is moved, or as its area is changed by moving its borders.
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Table 9.6

Analysis Side Toolbar Buttons (Continued)

Button

Description of Action

]

Activate Slicing Tool. This button activates the tool that allows the user to slice the image down from
the top surface to the foundation of the image and display a 2D image of the cross section at the slice.
This tool provides three options (see also Table 9.74) for the slice: horizontal, vertical, and diagonal.
(Diagonal can be adjusted to any angle.) All three options can be adjusted to any length. (See Table
9.9, in the Current Slice section.)
Procedure:
a. When this tool is clicked, a slice line is displayed on the 3D image in the chosen
orientation.
Click and hold while dragging the slice line to the desired location on the image.

Adjust the length of the slice by using the click-and-drag procedure with one of the handles
at the end of the slice line.

d. Right-click to display the Right-click menu. (See below.)

Enable Analysis Tools
. . Select Yiew »
In the View menu, click on Mouse Tools ,
View Current Slice to Zoom Taol »
Cross Section Toot >
Leveling Tools »

display the 2D image at
the slice indicated in the \
3D image.

Recalc

e. Click on View Current Slice (shown above) to view the current slice trace. To display both
the 2D image along with the 3D image (as illustrated below), click on Window, then choose
Cascade. (See Creating and Saving 2D Slice Data from a 3D Scan on page 9-46 for
information on creating a slice and saving current slice data.)

Bl View lice Paselers Opeisbons Widow A

@ | a [ogs e | s [ noo wa (moves| eme | & [

i Scan Data 10zec noma

i b L P K

Activate Step Height Tool. This button activates the tool that places two boxes on the image surface.
Using using the click-and-drag procedure with the center of each box, it can be moved to a new
location on the image surface. It can then be resized using the corner handles. The software
determines the difference between the average height in one box and the average height in the other
box. This difference is automatically calculated as the boxes are moved or resized.
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Table 9.6  Analysis Side Toolbar Buttons (Continued)

Button Description of Action

Activate 3D Glitch Removal Tool.
,Jﬂml This button activates the 3D glitch removal option. The tool is used in the following manner:

1. Activate the glitch removal button by clicking on it. A box is displayed at the bottom right of the
top view of the 3D image.

2. Drag the box over an area that presents the identical but correct formation of the area that
contains the glitch. Resize the box to capture only those attributes and only the size that is to be

corrected in removing the glitch. (See left side illustration below. Note that it is important to
gather enough data points for the system to make the analysis and remove the glitch.)

3. Right-click to display the right-click menu.

BT = )
smicadl @l o jelalojalalaioly jaf=]

Place and resize glitch
-| removal box in a position
modeling desired data.

menu choose
filter option.

4. Move cursor to Remove Glitches Within Cursors and choose the median filter to be used; 3 x 3,
5x5,o0r7x 7. (See right side illustration above.) (For more information on median filters, see
also Median Filter for 2D and 3D Data on page 3-61.)

5. Move the box over the glitch area, placing it in the same relative position that the initial box was
placed. (See left side illustration below.)

T U e e s o Jen b e adltin
el @]l -jalaldie]s |vis]

Move the glitch
removal box over
he glitch area.

- Inright-click menu, choose
Remove Glitches.

6. Right-click to display the right-click menu. (See right side illustration above.)

7. Move the cursor to Remove Glitches and click.(See right side illustration above.) The glitch is
removed using the chosen filter and the data gathered in the first box.
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Analysis Menu Bar

Most of the functions available in the two Analysis Tool Bars and the Right-click
menu, are also available using the Menu Bar at the top of the screen. In addition, there
are numerous other menu items that facilitate functions necessary for the processing
of 3D scan data.

Figure 9.16  Analysis Screen Menu Bar

File Edit Wiew Parameters Operations Data Tools  Window

File Menu
Table 9.7  File Menu Operations
Menu ltem Description of Action
Saves the current data to a file. This option displays the Save Dialog box with its
SaveDala.. associated options.
Fo—— Exports the current data. This option displays the Export dialog box with its associated
FROR SIER options.
Prints the current data. This option displays the Print dialog box with its associated
Print._ Ctd+P opti
ptions.
i i This option displays a thumbnail presentation of the material that is to be printed so it
Frint Preyiew can be reviewed.
Pint Setsp This option displays the Print Setup dialog box with its printer/print setup options.
9-18 KLA-Tencor Confidential 0104396-000 AA
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Table 9.7  File Menu Operations (Continued)

Menu Item

Description of Action

Load Warkspace...

This option allows the user to choose a specifically designed work space from a
drop-down menu in the Select Work Space dialog box.

Select Work Space E

‘Work Space Mame  [il]FAN|R} -
ak I Cancel |

Save Workspace...

This option presents a dialog box that allows the user to establish a named work
space.

Save Work Space [ x|

Enter WWorkspace Hame IDEFAULT
ak I Cancel |

Exit

This option Exits from the Analysis screen.

Edit Menu

Table 9.8  Edit Menu Option

Menu ltem

Description of Action

This option places the image and data information on the clipboard.

0104396-000 AA
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View Menu

Table 9.9  View Menu Options

Menu ltem Description of Action
e > This option displays another menu presenting options effecting the image perspective,
- view position, lighting and color.
Light F'rl:lpertie
Dizplay Color...
: This option displays another menu offering options to view the image from different
Select Yiew » |

Top
Ohbligue
FEront
Back

Left Side
Right Side

perspectives. See Table 9.11 for more detail on each view.

Top View Oblique View

Front View Back View

Left View Right View
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Table 9.9  View Menu Options (Continued)

Menu ltem Description of Action

This option displays another menu presenting options, each of which rotate the image
Rotate Image 3 |

by one increment each time they are chosen. (See Table 9.4 for a complete
explanation of the movement of each option.)

* NOTE: This is the most inefficient way of image rotation since each
time an option is used, the menu disappears and must be accessed

again for another single movement rotation. The rotation buttons in the

tool bar or the arrow keys on the keyboard are much more efficient.

Right Right Arrow
Left  Left Arrow
Up Up Arrow

Down Down Arrow

This option causes the magnification of the entire image by one increment of

o0 ey A magnification each time it is clicked on.

This option causes the reduction in size of the entire image by one increment of

Zoom QutView  F12 magpnification each time it is clicked on.

- This option opens the Analysis screen where it presents a graphical representation of
hlistosmanes the histogram of the data in the chosen data file.
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3/05



Analyzing 3D Scan Data - 3D Analysis Screen Features

KLA-Tencor P-15 User’s Guide

Table 9.9  View Menu Options (Continued)

Menu Item

Description of Action

Highlight...

This option displays the Highlight dialog box with its highlight options for chosen
planes in the analysis image.

—Data Range
Max Height: 4749.51

Cancel
Min Height: -727.13 4'

— Highlight Plane Specification

IHighIightHange1 'I ™ Highlight Plane On

Plane Height: |u.un A

Set Highlight Plane Color |

— Height Mode Highlight Sub-Range
™ Allow a sub range to use up full color range

Max Sub-Fange limit)0.00 A
Mir Sub-Flange limit:|0.00 A

Press here to use highlight planes 1 and 2 as limits |

Current Slice. ..

This options presents the trace of the Current Slice as an Analysis Screen graph.

2D image of the
slice.

3D image with a
horizontal slice
displayed.

Surface Summary...

[ Xof f set =12 &0 um Ravleveled Feat Find XOf fset
Yoflset 0.50 um Ravlieveled Feat . Fimd TOlf{set
i-Infcrmation-» Some calculated box paramsters lose their sigmificance il the bom |
contains lass than 10 traces or 10 datla points par trace
i Ignore this button
Sequence et
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Table 9.9  View Menu Options (Continued)

Menu ltem Description of Action

3 — Ignore this button
[Earelation Sean... |

Change Menu From the View Menu

Table 9.10 Change Menu Option From the View Menu

Menu ltem Description of Action
View Propetiss This option displays the Set Viewing Parameters dialog box with its options and
settings.
Set Viewing Parameters [ |
— Wiew ;
Rise Angle: (30 deg
Rotation Angle: [20 deq ﬂ
Data Height Mag: IDQU
Closeﬂ J ﬂ Far
" Raytrace mode % Height gradient mode
™ Wiew Using Perspective
IV Use smooth shading
Light Praperes... | This option displays the Light Properties dialog box with its options and settings.
Set Lighting Parameters [ |

r— Light Source
-UK
[Light 1 | W {fm enight saircs
Cancel |
Rise Angle: IU deg
Rotation Angle: ID deqg
Distance from Center: I"f2 pm
Close ﬂ J ﬂ Far

[ Show as Spotlight

Select Light Colar |Fiange: |3ﬂ deg
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Table 9.10 Change Menu Option From the View Menu (Continued)

Menu ltem Description of Action
This option displays the Light Properties dialog box with its options and settings. The
d color is applied to the primary image on the Analysis screen.
Color ﬂm
Basic colors:
J 15
iy e |
EFT AT N
ETEEEENN
ERNEEEEEN
EEEENT ]
LCustom colors:
) |
Hue:[160)  Fed:[255
I_I_I_I_I_I_I_I_ §al:|U_ green:lﬁ
| Defite Custarn Colors 55 I Colorl3glid Lum: lm Blue: lﬁ
0K | Cancel | Add to Custom Colors |

Select View Menu From the View Menu

Table 9.11 Change Menu Option From the View Menu

Menu ltem Description of Action

Restore Original View returns the image view to the first view that it is presented in
when the Analysis screen opens.

Restore Original View

Top | Top turns the image surface flat, giving the user a top down view of the image. This is
- the same view that is presented when the side tool bar is activated.
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Table 9.11  Change Menu Option From the View Menu (Continued)

Menu ltem Description of Action
Obligue | Oblique turns the image so that it is rotated to the left and down from the Original View,
giving more view of the top surface.
Front | Front is rotated a short distance in the counter-clockwise direction from the Original
- View.
Back | Back rotates the image so that the surface is in the same basic orientation as the
= Original View, only with the front to the rear and rear of image to the front.
0104396-000 AA KLA-Tencor Confidential 9-25
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Table 9.11  Change Menu Option From the View Menu (Continued)

Menu ltem Description of Action

Left Side ! Left Side rotates the image so that the surface is in the same basic orientation as the
- Original View, only with the front to the right, the rear of image to the left and the left
side to the front of the display.

Right Side I Right Side rotates the image so that the surface is in the same basic orientation as the

Original View, only with the front to the left, the rear of image to the right and the right
side to the front of the display.

Parameters Menu

The Parameters Menu is designed to display the checked parameters in the analysis
data. This information is included and saved in the Surface Summary record. To
include the menu parameter in the Surface Summary, click next to it so that a check
appears. (See Figure 9.17.)

Figure 9.17 Parameters Menu from the Analysis Screen Menu Bar

v General Parameters

v Roughness Parameters
v Waviness Parameters
v Hybrid parameters

v &l Barameters

The General, Roughness, Waviness and Hybrid parameters are sets of parameters
found in the Recipe Editor for the recipe being used to create the 3D scan that is being
analyzed. For details on each parameter set, see Chapter 3. To cause these parameters
to be displayed in the Surface Summary information, use the following procedure:
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Step 1 Choose the required
3D folder from which the recipe
list can be viewed.

Step 2 Double-click on the
recipe or click on it and then on
View/Modify.

From the 3D Recipe Path, choose a folder containing the 3D recipe, or from the
Scan Sequence Recipe list choose a sequence. (See Figure 9.18.)

Double-click on the recipe to open the Recipe Editor for that recipe, or click on
View/Modify at the bottom of the screen.

Figure 9.18 Catalog Screen — Scan Recipes

Profiler - [Catalog] [x]
File Edit Sample Yacuum Host Diagnostic Tasks Help

& |sw| ® (@[ 2 & 2

&

General Parameters

Step 3 Click on General
Parameters to display the
parameter set in the
Information Display Window.

Scan Recipe Name:

Scan [10<10MM &
Recipe &
Recipe Path: Recipe Name Length Speed Creation Date Time

" ( fum) mis)  Gyyymmed) B
10X 10HH 1000 9 08:47
Scan | \~LY1 TIM 13 10 1998-09-23 19- ;Pgl
Uty 25H13BOX 13 10 1998-12-08 14:03 !
2SH13K13 13 10 1998-12-08 13:59
3D_100UM 100 5 1998-07-29 15:40
3D_S00UM 500 5 1998-07-29 15:40
3D-20X20 20 20 1998-08-05 08:45 .
3ISN13BOX 13 10 1998-12-08 14:01
5;""‘!"‘“ 4SH13BOX 13 10 1998-12-08 14:03
s 5SN13BOK 13 10 1998-12-08 14:02
e 6SH13BOK 13 10 1998-12-08 14:04
7SN13BOX 13 10 1998-12-08 14:02
8SHM13BOX 13 10 1998-12-08 14:04
Sequence, A 9SN13BOX 13 10 1998-12-08 14:02
Data, AM_PLUG 2 0.50 1998-12-03 14:01
| e viewModiy | ) steRT | e view |
|SCAN RECIPE CATALOG [Sample Clear Status |

Click on the General Parameters button (see Figure 9.17.) to display the General
Parameters information in the Information Display Window.

Figure 9.19 3D Recipe Editor

Profiler - [Recipe Editor - FIRST} X
BRecipe Optiors Sample Vacuum Help

DB e &z mwi@ e 2|
[~ 2D General Parameters

3D General Parameters —————————————
Scan Parameter
Definition Normal Trace g%"ale Boxed

[T I Totallnd. Runout (TIR3D)

Feature

Detection I~ Total Ind. Runaout (TIR) I~ I SlopeX
Filters I Average Height [Avg) I~ I SlopeY
I~ Slope u ™ Peak 3D (Sp)
Paamatns > ™ Radus (Rad) T T Valky 3D (9
I Area of Peaks |Area+)

Wainess ™ Area of Valleys (Area-)
Beqvirg Ratio ™ Total Area [Area)
Cutting Depth I Peak (Pp)
Hioh Spol Court I Valley (Py) Only the 3D
o I Profile Length (ProfL) parameters are

Analpsis Tools I™ Distance to Edge (Edge)

I™ Step Width [Stpw't)

used and available
for display in the

Select 412D | \ Ty |J Analysis Screen.

3D Cursors

Remove All 2D | Remove All 3D |
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4. Ensure that the required parameters for the scan are chosen. (Figure 9.19.)

Roughness/Waviness 5. Click on Roughness/Waviness button to display the Roughness/Waviness
Parameters options in the information display window. (See Figure 9.20.)

Figure 9.20 3D Recipe Editor with Roughness/Waviness Options

Profiler - [Recipe Editor - CENTER3D]

BRecipe Options Sample Vacuum Help

Dl (P& @@ o &S| @] & |

Scan Parameter | 12D Roughness Parameters — 2D Waviness Pavameters*[ 3D Roughness Paramelers*\
Definition §| Full
Step 5 Click on the I~ Average [Ra] I~ Average (Wa) Gesle  Boxed
. R ™ Maximum Ra (MaxFia) I~ RMS (waq) " I RMS Deviation (Sq)
Roughness,wa\”ness ﬂ I™ RMS (Ra) ¥ Peak (wp) u I~ Aithmetic Mean Deviation (Sa]
button to display the e [ Pesk (Ar) ™ Valey () ™ [ Skewness(Ssk)
RoughneSs/Waviness e ™ Valley (Rv) [~ Peak/Valley (W) u I IKutess|(5ka)
. \ X X General I~ Peak/Valley (Rt) I~ \Waviness Height [Wh) [~ I RMS Slope (Sdeltag)
options in the information Wgmiiicacian N F IR 3 e
display window. — Rougness > I Height pt (R32) M| ¥ Densiy of Summits (Sds)
\. Beering Frot ™ Roughness Height (Rh) u I Interfacial Area Ratio (Sdr)
_ Cufting Depth | ™ Mean Peak Height (Ripm) Y5 | T Tt aeres: rn (5]
High Spot Count I” RMS Slope [Da) [T I Testure Diection
s I~ RAMS Wavelength (Ll r e Putacom Len (52
|3 Cusors | ™ 5td Dev. Height (5D) \K I | Arthmetic Mean Sumit Euwaﬁ/
Setup + .
_tnabssTedk || The only parameters available ( _ sewn | )

in 3D scans are those in the 3D _A Remove All 3D |

‘ Roughness Parameters box.

[Substr. Clear Status |

Step 6 Click on Select All 3D to
choose all the available parameters
for inclusion in the Analysis data.

6. Click in each empty check box next to the parameters that are to be displayed in
the Surface Summary box after the scan. This activates the procedure so that the
information is available for data analysis. (See Figure 9.20.)

To choose all of the available parameters, click on the Select All 3D button at the
bottom of the column.

Hybrid Parameters 7. This is the set of parameters contained in Bearing Ratio, Cutting Depth, High
Spot Count, and Peak Count. Click on the Bearing Ratio/Cutting Depth button.
(See Figure 9.21.)
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Step 7 Click on Bearing
Ratio Cutting Depth to

display its window. \

Step 8 The 3D parameters
that can be chosen are
presented in the 3D
parameter fields.

/

Figure 9.21

Bearing Ratio/Cutting Depth in Recipe Editor

Profiler - [Recipe Editor - 13X13]
Recipe Options  Help

02| =& =2[F

Scan Parameter
Definition

i

Feature
Detection
Fiiters
Cursors

General
Parameters

Ri oughness

Peak Count

W

Setup
Analysis Tools

It
*&

Bearing Ratio
itting Depth

i~ 2D Bearing Ratio [tp)
Depth Units

0
N —
0 3

Scale

I
v
v

ﬂ Bearing Ratio [Shi]i\
Ful St

Boxed

v
~
~

Units.
—
—
—

i~ 2D Cutting Depth [CutDp)——
Ratio

v [1.00
V' [Too
v

CA

~
I
v

3D Material Yolumn [¥m)

Z';"ah Boxed  Height

v
v
v

Units

—
—
—

-~/

[Substr.

Clear Status |

8. Make the required adjustments to the 3D parameter settings. (See Figure 9.21.)

z

NOTE: The High Spot Count/Peak Count parameters are only for 2D
analysis and do not show up in 3D analysis.

9. In the 3D Analysis screen, click on View in the menu bar to display its menu.

10.

From the View menu, click on Parameters Menu.

11. Click next to each parameter that is to be displayed in the Surface Summary box.
The checkmark ensures that the information prescribed in the Recipe Editor and
collected during the scan, is displayed in the Surface Summary box. (See
Figure 9.17.)

Operations Menu in the Analysis Screen Menu Bar

Table 9.12

Operations Menu Options (From Menu Bar)

Menu ltem

Description of Action

This option activates the Leveling procedure by
activating the tool bar to the right of the image,
orientating the image to the Top View, and placing the
leveling cursors on the image surface. (See Table 9.5,
Level tool.)
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Table 9.12 Operations Menu Options (From Menu Bar) (Continued)

Menu ltem

Description of Action

Lancel lleveling

This button is activated when the Leveling procedure is
activated. If the Leveling procedure is begun and the
user wishes to cancel it prior to completion, this button
can be clicked to abort the procedure.

Line Level...

This option displays the Line Leveling dialog box for
use in leveling the image. There are two sets of lines
that work just like setting cursors. There is a left and
right side of the “line” that will be used for leveling. It is
very important that the bounded area in both “lines” is
all in the same plane. For this reason, the example
shown below would not be a good candidate for this
type of leveling since no vertical line could be drawn on
a single plane.

Lue | w

Image Anithmetic...

This displays the Image Arithmetic dialog box which
allows the user to compare the current image with
other images using various mathematical operators.

L |
Cy |
IS
| S|
|
20 a0 B0
Select b secord mage (inagel)
[ |
Procoserg Famds | lmageT - bnaged |/1
Ciperaper 1 [ Sowe Factor.
* Subbsckon = Dasson —

™ Addiion  Muligheation

Recalc

This option allow the user to recalculate the current
data using new parameters.
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Table 9.12 Operations Menu Options (From Menu Bar) (Continued)

Menu ltem

Description of Action

Sumnmany Displayiiptions..

Data Menu from the Analysis Screen Menu Bar

Table 9.13 Data Menu Options (From Menu Bar)

Menu ltem

Description of Action

Data [nverted

This option inverts the data and changes the screen
image to reflect the inverted data.

Granularity |

This option allows the user to choose how many of the
collected data points will be used. It opens a dialog box
that with the necessary settings.

This feature sets the gain of the image.

The computer records more data points than are
possible to plot on-screen, so it uses a subset of the
points taken to build the image. In general, the smaller
the subset, the coarser the image and the faster it can
be displayed and rotated.

To control the image granularity from coarse to fine, set
the parameters for the data subset, using the Data
Granularity dialog box.

Data Granularity [ %]

— Fotation Data Set Screen Display Limit

I aximum Mumber of X data points: |5U
ISU

Cancel

I axirurn number of %' data points:

— Low Resolution Data Set Screen Display Limit

Mawimum Mumber of % data points: |100

M aximum Mumber of Y data points: {100

— High Resolution Data Set Screen Display Limit

Maximum Mumber of % data paints: |2UD
Maximum Number of Y data paints: |2UD

High Resalution

This option is for display purposes only. If checked (like
Low Resolution in the following field), the image will be
presented in a higher resolution. This slows generation
time when the image is rotated or magnified but offers
greater detail.

v Low Resolution |

This option is for display purposes only. If checked, as
in the illustration, the image will be presented in a lower
resolution. This enhances generation time when the
image is rotated or magnified.
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Tools Menu from the Analysis Screen Menu Bar

Table 9.14 Tools Menu Options (From Menu Bar)

Menu ltem

Description of Action

Enable Tools [Top View)

This options enables the Side Tool Bar Buttons. (See
Table 9.6.)

Dizable Tools

This options disables the Side Tool Bar Buttons.

Analyzis Tools

This option displays the Analysis Tools menu.

Leveling
Slice
Height

Step Height

v Enable Zoom Tool

This option changes the image to Top View, places the
zoom box at the bottom left corner of the image, and

activates the Zoom In (magnification) icon ] Q | in
the top tool bar. (See Table 9.5, Zoom In.)

Zoom

Once the Zoom In boundary box is set on the area to
be zoomed in on, this option completes the zoom
procedure to magnify the surface bounded by the box.

UnZoom

This button restores the pre zoom image.

Mouse Tools

This option displays the Mouse Tools menu.

These tools are all duplications of tools on the top tool
bar. For Rotate Image and Change Rise Angle, see
Table 9.2. For three Change Light... options, see

Table 9.5, look for the same titles. For the Move
Highlight Planes, see Table 9.5, look for the same title.

RBotate Image
Change Rise Angle

Change Light Rotation
Change Light Rize
Change Light Distance

Move Highlight Flanes

Lock ta Horizontal Cross-Sections

This option is used with the Slicing Tool. (See

Table 9.6, in the Activate Slicing Tool section.) When
this option is chosen, the slicing tool will automatically
go to the horizontal position and only operate in that
position for the slicing procedure.
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Table 9.14 Tools Menu Options (From Menu Bar) (Continued)

Menu ltem Description of Action

| This option is used with the Slicing Tool. (See

Table 9.6, in the Activate Slicing Tool section.) When
this option is chosen, the slicing tool will automatically
go to the vertical position and only operate in that
position for the slicing procedure.

v Lock to Wertical Cross-Sections

This option is used with the Slicing Tool. (See

Table 9.6, in the Activate Slicing Tool section.) When
this option is chosen, the slicing tool automatically set
the slicing line at a diagonal across the image. This line
can be changed to any angle or length.

Unlock Croszs-Sections

LINE-BY-LINE LEVELING

Introduction

Line-by-Line Leveling is designed to provide a tool for leveling 3D images where
planes at the same “Z” level can be detected running from top to bottom (along the
Y-axis) of the 3D image. This process is used to remove errors caused by scan drift.
This is accomplished by the system which averages the points between the cursor
borders to come up with a single value. The 3D image is leveled using the trace line
along the x-axis and the averaged value for the leveling cursor.

Each cursor is color coded with a right and left side and progressively higher headers
that help the user to set them in their proper order. All four lines can be used for
leveling. The left line (shorter cursor border) of each color set is the left cursor border.
This keeps the lines identifiable so they are not placed out of order. It is important that
the lines be kept in order.

Activating Line Leveling

Opening the 3D Cursor Parameters Window

Line-by-Line Leveling is activated in the Recipe Editor. It is used only in 3D images
and is only accessible through a 3D recipe.
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1. From any top level screen, open the Catalog Screen by clicking on its icon. (See

Figure 9.22.)

Figure 9.22 Program Level Icons

Step 1 From any
top level screen
click on the Catalog

Screenicon. —— g

2. From the Catalog Screen choose the Scan Recipe button to display the scan
recipe names in the list field portion of the screen.

Figure 9.23  Catalog Screen with Scan Recipe Chosen

& |swm| ®|®| a|&] 203

[ SeanRectn Trse o Recps e
| Sean [Cortat 5] [t et
Recipe
Pecips Pt Fecos Hame Lengh ¥ e Speed ModfedDate  Time
/' = by ] Lvry mem )
. Scan _ 302000 :g 200 ."'n Fﬁ%-gi-?? Tg 3:
Step 2 Click on the Scan Daia O
} . TOAENS 100N in See & 3001-06-14 1028
Recipe button to display IDSERE- 2000 20 w000 10 2001-06-14 10.25
the scan recipes in the list g I i % B & 300170618 1438
Heocpe
field.
Sequence
Data
9-34 KLA-Tencor Confidential 0104396-000 AA

3/05



KLA-Tencor P-15 User’s Guide Analyzing 3D Scan Data - Line-by-Line Leveling

3. Ensure that the 3D icon is active so the 3D Scan Recipes are displayed in the lit
field. (See Figure 9.24.)

Figure 9.24 3D Scan Catalog Screen

Step 3 Choose the 3D icon.

I Protie - (Catoos) _
Do [ ol Yooum ligu Qiaosic [ahs Lip

Glom @] a6 0 &
SeanBecpe Type Scan Fecge Name.
s | EETEE— 0, L Soee s o %l
_/ DEERE 10UM 10 ; 1-06-14 10-26
Step 4 Double-cickona ~ ———— He el 8§  d. B BOCED mE
recipe to open its recipe editor. Rosos I §|
b v
ALTERNATIVE:
Click to highlight
the recipe, then
click View/Modify.
4 4
| Hew | st | Wi |
[scmreoPe cataos Sanchn _Cloar Status |

4. Select the 3D recipe to be edited by double-clicking on the recipe name. This
opens the recipe editor. (See Figure 9.24.)
(ALTERNATIVE: Click to highlight the recipe, then click on View/Modify at the
bottom of the screen. See Figure 9.24.)
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5. In the Recipe Editor, click on 3D Cursors to display the 3D Cursor parameters.
This displays the four sets of 3D cursor parameters that are available for
defining in the recipe:

¢ 3D Leveling Cursor

¢ 3D Line by Line Leveling Cursor
¢ 3D Measuring Cursor

¢ 3D Step Height Cursor

Figure 9.25 Recipe Editor - 3D Cursors Window

The 3D Line by Line
Leveling parameters.

Step 5 Click on 3D
Cursors to display the
3D Cursor parameters.

Enabling 3D Line-by-Line Parameters

The 3D Line-by-Line Leveling option is enabled by putting a check in the Enable
Automated Line by Line Leveling checkbox. After the option is enabled, the user can
choose between two leveling options, or manually set the cursors in the Analysis
screen after the scan.
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Step 5 Click in the
empty checkbox to
enable 3D Line-by-Line
Leveling.

Enable the 3D Line-by-Line Leveling by clicking in the empty Enable Automated Line
by Line Leveling checkbox to put a check in it. (See Figure 9.26.)

Figure 9.26 3D Line by Line Leveling Cursor Parameters

3D Line by Line Leveling Cursor [pm]
™ Enable Automated Line by Line Leveling
(& Use DefaultLine Fositions [|0% 507 501007 |

€ Wse Defined Line Positions (]
Line 1 Line 2 Line 3 Line 4

After the Line-by-Line Leveling is enabled, the two leveling options are also active so
one or the other can be enabled. Clicking in the empty radio button toggles between
the options.

Use Default Line Position [0% 50% 50% 100%]

This option can be used best when scanning a sample with uniform texture typical of
film roughness scans. This function operates best when there are known flat regions
throughout the Y axis direction. This preset option automatically levels the scan by
placing the left cursor’s left border at the origin of the scan, the left cursor’s right
border at the mid point of the scan, the right cursor’s left border also at the midpoint
of the scan, and the right cursor’s right border at the end point of the scan.

Use Defined Line Positions
The Defined Line Positions can be set in two ways:

¢ The operator chooses Use Defined Line Positions as the leveling tool. The
operator manually enters (sets) the positions of the cursors in microns. These
settings are between 0 um and the number of microns in the scan length, as
defined in the recipe.

¢ The operator can enable line-by-line leveling and choose Use Defined Line
Positions as the leveling tool. The operator then either runs the scan to obtain the
data, or opens saved data that used the same recipe. The Line-by-Line procedure
is used to level the data and the data is saved. Once saved, the positions of the
newly placed cursor lines is displayed in the recipe.

Manual Entry of Line Position in Line Field
1. Follow the instruction in Opening the 3D Cursor Parameters Window
on page 9-33.

2. Inthe 3D Cursor Parameters window, ensure that Enable Automated Line by Line
Leveling is enabled. (See Figure 9.27.)
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3. Click on the empty radio button next to Use Defined Line Positions to enable it.
(See Figure 9.27.)

Figure 9.27 3D Line by Line Leveling Cursor Field

Either:

Manually enter positions in
¥ Enable Automated Line by Line Leveling
Step 3 Choose Use each field.

- A s " Usze Default Line Positions [ 0% 50% 50% 100% ]
Defined Line Positions pa— OR

T o] Fond] Manually postn the !lne
0 o0 a0 cursors on the image in

Analysis screen.

— 3D Line by Line Leveling Cursor [pm]

Once Use Defined Line Positions is enabled, the four Line fields become active.
4. If the positions for the line spacing is known, enter the respective positions in
each of the fields. Remember the following when entering the position:
¢ The units are microns (um).

¢ The range is [0 um to (Length of scan) um] (length as defined in the scan
recipe being used).

¢ 0 <Line 1 position < Line 2 position < Line 3 position < Line 4 position <
Scan Length

¢ Ifthe cursor line entries fall outside the scan limits, the system
automatically adjusts the cursors according to the sequential priority in the
above bullet.

Manually Position Line Cursors on Image to Enter Line Position

1. Run the scan using the recipe that is modified as illustrated in Figure 9.27.
2. From the Analysis screen choose Operations in the Menu Bar.
3. Select Line Leveling from the Operations menu.

The graphic display of the data appear midscreen in the top view with the four
line cursors in place at opposite borders of the image.
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4. Click and drag each line to its required position. All four line cursors must be on
the same plane for the data to be properly leveled. (See Figure 9.28.)

Figure 9.28 Line Leveling Top View Analysis Screen

Step 4 Click and drag lines If necessary, view the same image
to the required positions. from a different perspective so
nm

positioning cursors is easier.

5

Notice that all the cursor
lines are set to level on the

- plane. Immw
0
0 20 40 60

80 100pm

Exit I

5. Itis not necessary to save the data for the new cursor position to be recorded in

the recipe.
6. To observe the recipe, click Edit in the Menu Bar to display its menu.
7. Select Recipe from the Edit menu to return to the Recipe Editor.
8. In the Recipe Editor, click on the 3D Cursors button at the bottom of the

parameter window icon column. (See Figure 9.29.)

Figure 9.29 Recipe Editor with 3D Cursors Window Displayed
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9. To preserve the current 3D Line by Line Leveling Cursors positions, save the
recipe.

CUSTOMIZING THE SCAN IMAGE

Setting the Image Proportions

1. Go to the View menu, and select Change.
The View Properties dialog box appears.

2. Type a number that gives an appropriate value for the image height in Data
Height Mag. (See Table 9.10 on page 9-23, View Properties.)

Since the number depends on the relative heights of the features in the image,
select a higher value to obtain a taller image, a smaller value to reduce it. Click
OK.

Setting the Shading Mode

1. Inthe View menu, click on Change...
2. In the Change... menu, click on View Properties.

The Set Viewing Parameters dialog box appears.

Figure 9.30 Set Viewing Parameters Dialog Box

Set Yiewing Parameters [ x|
—Yiew
. I— Cancel
Shading mode options. Chose Flotaion Angle: |10 )
the one that best fits the B Il].2|]
requirements by clicking in its Close 4] _ 2 Far
empty radio button. —> ((" Faytrace mode €% Height gradient mode)

™ Wiew Using Perspective
¥ Usze smooth shading
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3. Select one of the following shading modes to customize the 3D data images to
better represent the sample type:

*

By Height to emphasize high features, click on the radio button next to
Height gradient mode. (See Figure 9.30.)

By Light to enhance smooth surfaces, click on the radio button next to Ray
trace mode. (See Figure 9.30.)

The results will appear in the Analysis screen, showing the three-dimensional,
color representation of the data points collected in one of three selectable
formats. (See Table 9.15.)

Table 9.15 3D Analysis graphs

Graph Description

By Height
Good for viewing rough features.

The higher the feature, the lighter the
color.

RIC]

By Light

Good for viewing smooth features since
contours are more obvious.

Features appear as if illuminated by a light
source.

Changing the View Angle

1. The image can be viewed from various angles by doing one of the following:

*

Press the arrow keys on the keyboard. (See Analysis Screen — Image
Orientation on page 9-3.)

Go to the View menu, click on Change...

Click on one of the seven views listed: (See Table 9.11 on page 9-24.)

Restore Original View Top
Oblique Front
Back Left Side
Right Side

Click the Rotation buttons at the bottom of the 3D view window to quickly
examine the image from any angle. (See Table 9.1 on page 9-4 and
Table 9.2 on page 9-4.)
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CUSTOMIZING THE VIEW

Changing the Image Colors

1.
2.
3.

4.

Go to the View menu, and select Change...
Click on Display Color.
Select a color from the palette or create a custom color.

Saving the scan file also saves custom colors. (See Table 9.10 on page 9-23.)

Click OK to close the dialog box and apply the choice.

Changing the Scan Height Colors

Images can be color-coded and displayed in the Height Gradient Mode format to
better delineate height features. The Highlight feature allows the user to define a
highlight plane to bring out certain features of the image.

1.

o0k

Go to the View menu, and select Highlight.

A dialog box appears with the minimum and maximum heights obtained in the
scan.

Go to the Plane Height entry field, and type the desired height.

Click Set Headlight Plane Color.

Select a color from the palette or create a custom color.

Click OK.

If desired, repeat to define additional planes.

Removing Banding with Line Leveling

Line leveling can be used to remove banding caused by environmental signal drift
with each successive trace in a 3D scan baseline. Line leveling calculates corrections
by comparing line segments line-by-line rather than by averaging areas. Line leveling
should generally be used when calculating 3D roughness, area, volume, and other
parameters.

1.
2.

Click on Operations in the Analysis screen menu bar.

Click on Line Level...
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3. Go to the Operations menu, and select Line Level.

The dialog box appears (see Figure 9.31).

Figure 9.31 Line Leveling Dialog Box After Cursors Positioned

Line Leveling

Step 4 The cursors in._
this illustration must be N\>
placed close together to
ensure that they are
covering the same plane.

Step 5 After the cursors
are set, click Apply to
preview the results.

ElE BB EEEERN
EERERERREERERDR

N 40 60 80pm

Exit |

I

4. Click and drag the lines of each pair of boundary cursors to define segments of
the scan lines on the same plane.

Do not include features, only flat areas (see Figure 9.31 for placement of
cursors). Notice that in the image, the lines must be vary close together in order
to keep from including unwanted features.

The instrument compares the bounded segments and calculates an average
baseline for the scan.
5. Click the Apply button to preview the results. The Undo button become active.

6. Click the Exit button to return to the scan data window and view the results on
the scan image.

7. If the new leveling is to be retained, it must be saved. If the screen is closed
without saving, the changes are lost.

USING IMAGE ARITHMETIC TO COMPARE DATA

Two 3D scans can be compared with similar surfaces or the same site to evaluate
noise and roughness. Both scans must use the same recipe:

+ Recipe

¢ X-size and Y-size

1. Open the data file that is to be use in the calculations. This is Image 1.
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2. Go to the Operations menu, and select Image Arithmetic.

The dialog box appears (see Figure 9.32)

Figure 9.32 Image Arithmetic Dialog Box

Image Arithmetic

pm

80

Whde |
LCloze |

Step 3 Enter the name of
the second image or click
the Browse... button to
search for the image.

0

0 20 40 60 80pm

Select the second image [ImageZ):
I Browse... |

Processing Formula: [ Image] - Image2 ] /1

Operator 1 Operator 2 Scale Factor:
% Subtraction & Division |1
 addition  Multiplication

3. Type in the name of the second image or Browse for the second image.
The second image must have used the same recipe as the first image, and it must
be the same size.

4. Press ENTER, or click the Display button.
The second image appears in the display area in the dialog box.

5. Go to the Operator panels, and click one of the buttons for:
¢ Subtraction or addition
¢ Division or multiplication
The Processing Formula above the panels displays the selection.

¢ Scale Factor sets the value for Operator 2.

+ [fdivision or subtraction are not being performed on the data, go to the
Scale Factor field, and enter 1.

o

Click the Apply button to perform the operations.
7. To revise the operations and recalculate, click the Undo button.

®

When the results are satisfactory, click the Close button.

A Save message dialog box appears.

9. Click OK to save the resulting image.
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SAVING SCAN DATA

Scan data can be saved for reviewing at a later time. This is especially important
because the data that is saved, using software version 6.1 or newer, can be reanalyzed
at a later date using different scan parameters.

In addition to saving the 3D data, current slice data can be save. This procedure is
covered at the end of this section.
Saving 3D Scan Data
1. Click on File in the Menu Bar to display the File menu.
Figure 9.33 3D analysis Screen with File Menu

‘| Analysis - [3D Data: Untitled]

Step 1 ClickonFile __— —pp

X

B Edit View Parameters Operations Data Tooks Window Help =18 x|
H H ; StartScan N o
to display its menu. I el g ||| alelalalo o s S]] %]
1 Vat
g:: Print. - Ctrl+P ®
of Print. rl+f _—
Step 2 Choose Save i Preven N
Data... from the o PSP | €
Load'Workspace... —
menu. Save Workspace... T
Ext
Clear Status |
Clear Status |
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Step 4 From the drop-down
menu, click on the desired drive
and directory.

Step 5 If folders are present,
double-click on the folder in which
the data is to be saved.

Step 6 Enter the name being
given to the new data set.

Step 1 Click on the
hammer icon to
activate the tool bar
function.

w! 3 scandata

e

2. Select Save Data...
The Save Scan Data dialog box appears. (See Figure 9.34).

Figure 9.34 Save Scan Data Dialog Box

Save Scan Data

- Step 3 Click on
the down-arrow to
reveal the
available drives
and directories if

@ Init_sch. 3dd
@ scan_3.3dd

—p @ scan_4.3dd

needed.
File hamey |scan_5 Save *\ Step 7 Click
Save as lype: IScan Data Files [*.3dd] j Cancel | Save to save the
data to the file.

Help |

3. Click on the menu arrow next to Save In to reveal the available drives and
directories. (See Figure 9.34)

4. Select the drive and directory from the drop-down menu. (See Figure 9.34)

5. Double-click on the folder that the data is to be stored in. A list of all current
data files appear. (See Figure 9.34)

6. Enter a name for the data set in the File name variable box. (See Figure 9.34)

7. Click Save to save the data in the new file. (See Figure 9.34)

Once a data set has been saved, it is added to the Scan Data catalog. The Scan
Data catalog window allows selection of individual data sets for reviewing.
Unwanted data sets can be deleted.

Creating and Saving 2D Slice Data from a 3D Scan

1. From the Analysis Screen, click on the hammer tool to activate the tool bar.

Figure 9.35 Analysis Screen - Analysis Tool Bar

)

)
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-
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3
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2.
Step 2 Click on the slice
tool to activate it. —
3.

In the activated tool bar, click on the slice tool to activate the slice tool.

Figure 9.36 3D Analysis Tool Bar with Slice Tool Activated

G AEE

Bz an

o]

Choose the desired slice direction. Click on Tools to display its menu. (See
Figure 9.37.)

Figure 9.37 Analysis Screen with View

‘| Analysis - [3D Data: Untitled]
Tl File Edit View Parameters (peiationfJmi:

[x |x

=
=3
a
=)
=
=
o

=& x

Step 3 Clickon Tools to —— [ @ [ e | sms[earc| & | E;:?;TT:::;”OPVEWJ h [ @ [® [ [ [% [ »]

Step 4 Clickon Cross —

Section Tool to display
its menu.

Step 5 Choose the desires
slice direction. Unlock
Cross-Section is chosen,
making any direction slice
possible.

4.

5.
6.

—

Analysis Tools
Length: 80.000 pm

Speed: 50 ymis

Direction -

0.00 1000 2000 3000 4000 5000 6000 70.00

Clear Status |
Clear Status |

Click on Cross Section Tool from the Tools menu to display its menu. (See
Figure 9.37.)

Choose the desired cross section tool for the slice direction. (See Figure 9.37.)
For the Horizontal and Vertical tools, click and drag the slice line to the desired
location on the 3D image to display the 2D trace of the scan at that location. For
the Unlock Cross-Section tool, click and drag the slice line end points to the
desired location on the border of the image as seen in Figure 9.38.
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Figure 9.38 Analysis Screen with Slice Tool Active

. [ Analysis - [3D Data: Untitled] X
Step 6 TOp Create the SIIC91 | File Edit View Parameters Operations Data Tools Window Help _I_I- =) 1‘
click and drag the endpoints of Wﬂ“ﬂ_ﬂml glolsalzlalalalw|ss]™

the unlocked slice tool or the N »
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horizontal slice tools. A
[Cv

“7Ih

frat

» S

[ 10.00 20.00 30.00 40.00 50.00 60.00 70.00 80.00
Clear Status |
Clear Status |

When the slice line has been placed, click View in the menu bar to display its
menu. (See Figure 9.39.)

Choose Current Slice... to display the 2D slice trace. (See Figure 9.39.)

Figure 9.39 Analysis Screen with Both 2D and 3D Images

X
Step 7 Wlth the S|IC€ A Jarameters Operations Data Tools Window Help 1= x|
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;:;;‘l‘[:?“l“ Botate Image b PaN
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the menu. — =&
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The current slice is
displayed as a 2D image
in the Analysis Screen.

The 3D image is displayed
in the top down mode, with
the slice tool across the
image as placed to create
the 2D slice.

If the Window option is set to Tile Horizontal then the image is displayed as
illustrated in Figure 9.40. The 2D slice trace is displayed above the 3D image.
The 3D image is shown with the slice tool placed across the image at the place

where the 2D image is generated.

Figure 9.40 Analysis Screen with Both 2D and 3D Images

Eile Edif View Trace Parameters Operations ‘Window Help
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9. To save the 2D trace data from the 3D scan, click in the 2D trace portion of the

Step 10 To save the 2D trace e
data, click File to display its

menu EXpon El:
Print... Ctrl+P 3
Print Preview
Print Setup...

Step 11 Choose Save
Data... to open the

Step 9 Click in the 2D trace / Pt

portion of the Analysis screen
to activate it.

Analysis screen to activate it.

Figure 9.41  Analysis Window with File Menu
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Step 13 From the Save in:
drop-down menu, click on the
desired drive and directory.

Step 14 If folders are present,
double-click on the folder in which
the data is to be saved.

10.
1.

W7 |l8] 2d_slice_3d_Scan2.dat

To save the 2D slice data click File to display is menu. (See Figure 9.41.)

Choose Save Data... to display is dialog box. (See Figure 9.41.) This displays the
Save Scan Data dialog box. It should be set up to save 2D data as shown by the
data type “Scan Data Files (*.dat)” in the Save as type: field. (See

Figure 9.42.)

Figure 9.42 Save Scan Data Dialog Box

Save Scan Data

. l’_' d t .
Save it | ‘3 scandata Step 12 Click on
@ 20_scan.dat the Save in:

@ 20_scan_2 dat down-arrow to

reveal the
available drives
and directories if
needed.

@ 2D_slice_seql.dat

File name: |2D_slicr;_seq2 Save |
Step 15 Enter the name being m: | 5can Data Files [+ dat} [~ | Cancet | Step 16 Click

given to the new data set.

12.

13.
14.

15.
16.

Hel Save to save the
(=]
—l‘ a data to the file.

Click on the down-arrow next to Save In to reveal the available drives and
directories. (See Figure 9.42)

Select the drive and directory from the drop-down menu. (See Figure 9.42)
Double-click on the folder that the data is to be stored in. A list of all current
data files appear. (See Figure 9.42)

Enter a name for the data set in the File name variable box. (See Figure 9.42)
Click Save to save the data in the new file. (See Figure 9.42)

Once a data set has been saved, it is added to the Scan Data catalog. The Scan
Data catalog window allows selection of individual data sets for reviewing. 2D
slice data saved from a 3D scan can be reevaluated in the Analysis screen by
changing the recipe parameters and performing a recalculation of the
information. Unwanted data sets can be deleted.
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SYSTEM SECURITY

INTRODUCTION

The Profiler system security is designed to provide users with membership in various
groups for access to the Profiler functions for which they are responsible. Each group
access is provided by an interface between the Windows software and the Profiler
Software. Each group is defined and named in the Windows software. Windows
defines three user groups: Administrator, Power Users, and Users. The Profiler
software defines 16 additional groups. The additional groups are as follows:

P_Configuration P_Calibration P_AdvCalibration
P_EditScanRecipe P_TranScanRecipe {+EditScanData
P_TranScanData P_EditSeqRecipe P_TranSeqRecipe
P_EditSeqData P_TranSeqData P_Stress
P_Diagnostics P_VirtualArtifacts P_StageMapping
P_GemSecs

Each of these groups provide access to system functions that are necessary for the job
actions associated with the security level. There can be as many people assigned to
each level as is necessary.

This chapter includes discussions on:

¢ Windows Defined Groups on page 10-2

¢ Profiler Defined Groups on page 10-2

¢ Opening the User Manager on page 10-4
¢ User Manager on page 10-6

¢ C(Creating a New User on page 10-6

¢ Results of Limited Access on page 10-11

¢ Adding a User to a Users Group on page 10-9
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Windows Defined Groups
The Windows defined groups have functions as follows:

¢ Administrator and Power Users: A user who is a member of either of these
predefined groups has all of the Profiler privileges. That is, he is allowed to use
any and all Profiler software features and can create, delete, or modify any
Profiler system or data files.

¢ User: A user who is a member of predefined Users group has the basic set of
Profiler privileges:

View a scan or sequence recipe

Run a scan or sequence recipe

Save the data in a new data file, including thumbnail files
View data, including thumbnail files

Perform the Applied Force calibration procedure because it is a daily
operation that requires relatively few Profiler skills

Profiler Defined Groups
The Profiler defined groups have privileges as follows:

¢ P_Configuration: This group allows a user to select the Configuration button
in the program level screens and to perform any configuration procedures. The
only exception is that in System Configuration, only Administrators and Power
Users are allowed access to Registry Maintenance.

+ P_Calibration: This group allows a user to perform any of the calibration
procedures except Center of Rotation (Administrators and Power Users only),
Linearity, Pulse ratio, Tilt/Level, Virtual Artifacts, and Stage Mapping. These
other calibrations are included in other groups.

¢ P_AdvCalibration: This group allows a user to access these calibration
procedures: Linearity, Pulse Ratio, and Tilt/Level.

+ P_EditScanRecipe: This group allows a user to modify an existing scan recipe
and save it. The edit can be done explicitly in the recipe editor or implicitly by
using a function that automatically changes the recipe, such as the CALC
function in the Analysis window in a live scan or in review mode.

¢ P_TranScanRecipe: This group allows a user to import a new scan recipe but
not to overwrite an existing one, unless the user is also a member of
P_EditScanRecipe. The user can also export a scan recipe to an external file.
The Profiler imposes no restrictions on the user privileges of the external file.

+ P_EditScanData: This group allows a user to modify existing scan data and
save it. The user can also overwrite existing scan data with different data or
delete scan data.

* NOTE: If the user is not also a member of P_EditScanRecipe, then

the user cannot implicitly modify a scan recipe in the Analysis window
in either a live scan or review mode. Examples of this are the CALC
and RECALC button which are disabled.
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¢ P _TranScanData: This group allows a user to import new scan data but not to
overwrite existing data, unless the user is also a member of P_EditScanData.
The user can also export scan data to an external file. The Profiler imposes no
restrictions on the user privileges of the external file.

¢ P_EditSeqRecipe: This group allows a user to modify an existing sequence
recipe and save it. The edit can be done either directly in the recipe editor or
implicitly by using a function that automatically changes the recipe. The user
can also overwrite an existing sequence recipe with a different recipe or delete a
sequence recipe.

+ P_TranSeqRecipe: This group allows a user to import a new sequence recipe
but not to overwrite an existing one, unless the user is also a member of
P_EditSeqRecipe. The user can also export a sequence recipe to an external file.
The Profiler imposes no restrictions on the user privileges of the external file.

+ P_EditSeqData: This group allows a user to modify existing sequence data and
save it. The user can also overwrite existing sequence data with different data or
delete sequence data.

* NOTE: If the user is not also a member of P_EditSeqRecipe, then the

user can not implicitly modify a sequence recipe in the Analysis
window. Examples of this are the CALC and RECALC button functions
which are disabled.

*

P_TranSeqData: This group allows a user to import new sequence data but not
to overwrite existing data, unless the user is also a member of P_EditSeqData.
The user can also export sequence data to an external file. The Profiler imposes
no restrictions on the user privileges of the external file.

¢ P_Stress: The group allows a user to access the Stress application. The user can
create, delete, or modify stress recipes. The user can also create, delete, or
modify stress scan data. This group can be restricted to users who have stress
characterization responsibilities.

+ P_Diagnostics: This group allows a user to access the Diagnostics application.
This group can be restricted to users who have machine troubleshooting
responsibilities.

¢ P_VirtualArtifacts: This group allows a user to generate virtual artifacts. This
group can be restricted to user who have this responsibility.

+ P_StageMapping: This group allows a user to perform the Stage Mapping
calibration. Only users with special training should be members of this group.

¢ P_GemSecs: This group allows a user to change the host/equipment
GEM/SECS settings. Only users with special training should be members of the
group.
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MANAGING THE SYSTEM SECURITY

Opening the User Manager

During the logon procedure the user must enter a combination of logon ID and
password. This logon is necessary for the Windows software to complete the system
initiation. The logon ID establishes which group(s) the user has access to. The
password completes the access to group functions. When opening the User Manager
screen, where the security system resides, the logon will have already determined
what groups the user has access to. Only those with Administrator or Power User
access can perform any of the functions in the User Manager screen.

1. Click on the START button at the bottom left of the screen. This displays the
Windows menu. (See Figure 10.4.)
2. Click on the Programs option to display its menu. (See Figure 10.1.)
Figure 10.1  Windows Screen START Menu
Step 1 Click on START Step 2 Move the cursor
at the bottom left corner = over Programs to access
of the screen to open this S i " Documents ¥ the Program menu.
menu. = :
:_‘2 @ Settings >
S Find »
1 ©
v
: p=r
] .
= .
z m Shut Down...
3. Move the cursor over Administrative Tools (Common) to display its menu. (See
Figure 10.2 and Figure 10.4)
Figure 10.2  Programs Menu
Accessories L4
L_@ Startup »
ﬁ Command Frompt
_m Windows MT Explorer
r_E_l.‘ Adminiztrative Tools [Common] Step 3 Move cursor over
(=) McAfee ViusSean HT ¥ Administrative Tools to
(=) MGANT PowerDesk » display its menu.
(=) Profiler »
L_Q Startup 4
@ CaptureEze97
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Step 1 Click on
START

R

4. Move the cursor over User Manager (see Figure 10.3 and Figure 10.4) to display

the User Manager screen. (See Figure 10.5.)

Figure 10.3 Administrative Tools Menu

Backup
é Disk Administrator
Ewent Wiewer

Step 4 Move cursor over
User Manager to display
) <®—— the User Manager screen.

Windows MT Diagnostics

Figure 10.4 Windows Screen with Path to User Manager Screen

Step 2 Cursor
over Programs

Step 3 Cursor over
Administrative Tools

[ Accsssories

Startt
4 E c:.;.::,.d Prompt Step 4 Cursor over

» @ ‘Windows NT Explorer User Manager

(5 McAfee ViusScan NT » 3% Disk Administrator
(5 MGANT PowerDesk » (3] EventViewer

(3 Prafiler 4 E Performance Monitor
(8 Startup » & Remote Access Admin
g CaptureEzed7 ¥

Windows NTV

3, windows NT Diagnostics
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User Manager

The User Manager is the security system interface for Windows. The P-15 Profiler
uses the Windows security system. All assignment of users to user groups and
creation of user passwords is set in this screen.

Figure 10.5 User Manager

1 User Manager
User Policies Options Help
Description

computerfdomain

Fegagy Fleming

List of user names. \

Builtin account for guest access to the computer/domain

mantest Manufacturing Test
operator

Bob Shaw first shift operator
€ Process Eng2 Mike Smith The process engineer
€ User2 Sam Davis 2nd shift operatar
Groups Description
£ P_EditScanData =

gR P_EditScanRecipe
gR P_EditSeqData

gR P_EditSeqRecipe
g® P_GemSecs

£ P_StageMapping
£ P_Stress

i P_TranScanData

i@ P_TranScanRecipe
@ P_TranSeqData

P P_TranSeqRecipe
£ P_VirtualArifacts

€ Power Users J tembers can share directories and printers

List of User Groups \

Supports file replication in & domain I
Ordinary users =

Creating a New User

For the P-15 system users, a User Group is a secured access group with specific
system privileges.

To create a new user, use the following procedure:

1. Click on User to display its menu. (See Figure 10.6.)

10-6 KLA-Tencor Confidential 0104396-000 AA
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2. Click on New User to open the New User dialog box. (See Figure 10.6.)

Figure 10.6 User Manager

i User Manager

Step 1 Tocreatea ———» [l Eolcies Golons_Heo

. . Full Name Description
new user, CIle on cal Group... Built-in account for administering the computer/domain
User. EZ';; Ez Built-in account for guest access to the computer/domain
Rename...
Eroperties,. Enter
Step 2 Click on Lo i
New User...
Groups Description
® Administrators Members can fully administer the computet/domain =
€ Backup Operators tMembers can bypass file security to back up files
£ Guests Users granted guest access to the computer/domain
£ P_AdvCalibration
@ P_Calibration
(@ P_Configuration
# P_Diagnostics
g P_EditScanData
g P_EditScanRecipe
® P_EditSeqData —
® P_EditSeqRecipe
® P_GemSecs P_GemSecs
® P_StageMapping
@ P_Stress
Clear Status |
[Empty? Clear Status |
BEGIN: Setting a 3. Enter the User Name in the first field. This is the name that the user enters into
Password the User ID field during the logon process. (See Figure 10.7.)

4. Enter the Full Name in the second field. This is the actual identity of the user.
(See Figure 10.7.)

5. Enter the Description in the third field. This describes the duties of the user. (See
Figure 10.7.)

6. Enter the Password in the fourth field. This is the password that the user enters
in the Password field at logon. (See Figure 10.7.)

7. Enter the Confirm Password in the fifth field. This is the Password that was
entered in the fourth field, now entered a second time to verify that the first
entry was correct (verification is difficult since the password is not displayed). If
the two entries are different correction can be made. (See Figure 10.7.)

Q CAUTION: It is extremely important that the Administrator password
be protected. If the passwords are changed and lost or forgotten, itis a
very expensive and time consuming process to establish new access
to the system. To avoid potential system downtime, the original
Administrator password should be kept in a secure place by the
administrator and not changed.
0104396-000 AA KLA-Tencor Confidential 10-7
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Step 3 Enter the user name.
This is the logon name.

Step 4 Enter the user name.

Figure 10.7 New User Dialog Box - Variables

Usemame: IProcessEng 2

This is the identity of the person.

Step 5 Enter the user name.
This is what the person does in
the system.

Step 6 Enter the Password. A
confirmation is requested so
there is less chance of
misspelling since it is not visible.

Full Mame: |Mortamer5nerd

Description: |The2nd ProcessEng

Password:

ser Must Change Password at Next Logon
¥ Uger Cannot Change Password

V' Password Never Expires

™ Account Disabled

& s

Groups Profile Dialin

0K

Cancel |
Help |

8. There are four logon variables that can be selected from. To enable one of the
variables, click in the empty checkbox so that a check (v') appears in it. The

END: Setting a Password

Click on the empty
checkbox of the desired

password logon variables. \

To change or add access to
a group for a user, click on

Group to display its dialog .
box.

variables are as follows: (See Figure 10.8.)

¢ User Must Change Password at next logon. If checked, the user will be
required to enter a new Password the next time the user logs on.

¢ User Cannot Change Password. This makes it impossible for the user to
change the password. This is helpful if several people use the same logon.

+ Password Never Expires. If checked, the password always stays the
same. Ifthis is not checked, the user will be required to periodically choose
another password. This is a way of forcing a periodic change of password.

¢ Account Disabled. If checked, the user will not be able to logon until it is
unchecked. This way a users logon can be stopped without wiping out the
connections that the user has in the system. The connections cannot be

reestablished if the user is deleted.

Figure 10.8 New User Dialog Box - Variables

Usemame: IProcessEng 2

Full Mame: |Mortamer5nerd

Description: |The2nd ProcessEng

Password: | *****

LConfirm =
Password: I

™ User Must Change Password at Nest Logon
¥ Uger Cannot Change Password

V' Password Never Expires

™ Account Disabled

o5 fs
Groups Profile Dialin

0K I
Cancel |
_teb |

Help

10-8

KLA-Tencor Confidential

0104396-000 AA
3/05



KLA-Tencor P-15 User’s Guide

System Security - Managing the System Security

Step 2 Double-click one or
more of the current user group.
In this case, one of the
P_XxxXxxXxx groups.

Step 1 Double-click on the
name of the user that is to be
added to the profiler specific

group. (In this case, User2.) This

opens the User Properties
dialog box.

Changing or Adding Access to a User Group

1. Click on the Groups button at the bottom left of the New User dialog box to
display the Group Membership dialog box.

Remove the current user group. This is done by double-clicking one or more of
the current user groups in the Member of field, like one of the P XxxXxxXxx
groups in Figure 10.9. (OR by highlighting the current user group in the Member
of variable box and clicking on Remove. See Figure 10.9.)

Figure 10.9  Group Membership Dialog Box

Group Memberships [ %]
User.  Process Eng 2 [Mortamer Snerd)
Cancel |
Help |
Mot member of:
P_TranSegData _A_I

F_EditScanData
F_EditScanRecipe
F_EditSegData
P_EditSeqRecipe

P_TranSeqRecipe
P_Virtualdrtifacts
Power Lsers
Fenfoate

OR Highlight the current
user group, and click on
—— Remove to delete the
highlighted user group.

Adding a User to a Users Group

It is possible to add user to a profiler specific users group. This is primarily for those
who are in the Windows defined Users group, because they have limited access to the
profiler groups.

Use the following procedure to add a person already having the Users group access to
a user specific users group.

1. From the User Manager, double-click on the name of the user in the users
name list. (See Figure 10.10.)

Figure 10.10 User Manager

i User Manager

= B
User Policies Options Help
Username
€ Administrator
Dummy
€ Guest
€ mantest
€ operator
Frocess Eng 2

]Full Name |Descriptinn

Built-in account for administering the computer/domain

Peggy Fleming
Built-in account for guest access to the computer/domain

Manufacturing Test

Eob Shew

Mike Smith

first shift operator
The process enginear

Groups Description
Members can fully administer the computerfdomain
Members can bypass file security to back up files

Users granted guest access to the computer/domain

|»

& P_AdvCalibration
@ P_Calibration

& P_Configuration

fi# P_Diagnostics

g? P_EditScanData
EditScenRecipe
EditSeqData
EditSeqRecipe
GemSers
StageMapping
Stress

# P_TranScanData =

i3

0
e
FiE
i
itk
e
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2. Click on the Groups button at the bottom left of the User Properties dialog box to
display the Group Membership dialog box. (See Figure 10.11.)

Figure 10.11 User Properties Dialog Box

Lkser Properties [ %]

Usemame:  User 2
Full Mame: |SamD avis Cancel |
Descriptior: | 2ndShiftOperator Help |

Password:

LConfirm
Password:

™ User Must Change Password at Next Logon

Step 2 Click on the GI’OUpS ¥ User Canriot Change Password
button to open the Group V' Password Never Expires
Membership dialog box. T Account Dissbled

\ I= Account Lacked Bt

® )&
Groups Profile Dialin

3. Scroll to find the desired user group in the Not member of variable box. (See the
user groups defined in Profiler Defined Groups on page 10-2.) Double-click on
the group to move it into the Member of field.

OR, highlight the desired group in the Not Member of field and click on the
<-Add button. The selected group moves to the Member of field. (See
Figure 10.12.)

Figure 10.12 Group Membership Dialog Box

Group Memberships [ %]

User.  User 2 [Sammy D avis] OK |
Cancel |
Help |
Member of: Mot member of:
OR, highlight the user group ER Users Step 3 Double-click the
and click on Add to place the | : : new user group. Here
user group in the Member of P_EditSeqDat P_EditScanRecipe is
field. FEdGedfeche g selected.
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4. After adding all the necessary groups, click on OK to finalize the choices. (See
Figure 10.13.)

Figure 10.13 Group Memberships Dialog Box

Group Memberships [ %]
Step 4 When the
User.  User 2 [Sammy D avis] Ll < group has been
Cancel added, click OK.

Help |

tember of Mot member of:

The chosen group is [E2@ P Diagnostics ]
P_EditScanD ata
transferred t9 the e
Member of side. P_EditSeqRecipe
P_GemSecs LI
5. The User Properties dialog box appears. Click OK to close and save the changes.
Figure 10.14 User Properties
Usemame:  User 2 0K
Full Mame: |SamDavis Cancel
Description: |2ndShiftUperator Help |
Password; [ s Step 5 When all the
Confim  —— desired changes
Password: I ”,
and additions have
™ User Must Change Password at Next Logon
¥ Uger Cannot Change Password b_een Completed’
V' Password Mever Expires click on OK to
I~ Account Disabled complete and save
I~ | Account Lacked But them.
<5 E13
Groups Profile Dialin
Results of Limited Access
When a user group is added to a user, the user access is limited to only those P-15
processes indicated by the user group membership. With limited access, certain
screens and contents are not accessible for change or use. In other cases, the screens
or specific functions in a screen are blocked from user access.
0104396-000 AA KLA-Tencor Confidential 10-11

3/05



System Security - Managing the System Security KLA-Tencor P-15 User’s Guide

When a screen has limited access to its functionality, the inaccessible functions are
grayed out. In the illustration in Figure 10.15, the Applied Force, Video Lamp Balance,
and Drop Timer calibrations are active but all other calibration functions are grayed
out to indicate that they are inaccessible to the operator under the current security
limitations.

Figure 10.15 Calibrations Screen with Functions Grayed Out

Notice that in the Calibration
icon does not have access
denied.

However, in the
Calibrations screen, the
operator might only have
access to certain
calibrations. Inaccessible
functions are grayed out.
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